
aefJt^pv=pçÑíï~êÉ

cbcilt =SKO
cáåáíÉ=bäÉãÉåí=pìÄëìêÑ~ÅÉ=cäçï
C=qê~åëéçêí=páãìä~íáçå=póëíÉã

rëÉê=j~åì~ä

aefJt^pv=dãÄe

o

cbcilt=SKO=ö=N



`çéóêáÖÜí=åçíáÅÉW
kç=é~êí=çÑ=íÜáë=ã~åì~ä=ã~ó=ÄÉ=éÜçíçÅçéáÉÇI=êÉéêçÇìÅÉÇI=çê=íê~åëä~íÉÇ=ïáíÜçìí=ïêáííÉå=éÉêãáëëáçå=çÑ=íÜÉ=
ÇÉîÉäçéÉê=~åÇ=ÇáëíêáÄìíçê=aefJt^pv=dãÄeK
`çéóêáÖÜí=EÅF=OMNP=aefJt^pv=dãÄe=_Éêäáå=J=~ää=êáÖÜíë=êÉëÉêîÉÇK=
aefJt^pvI=cbcilt=~åÇ=tdbl=~êÉ=êÉÖáëíÉêÉÇ=íê~ÇÉã~êâë=çÑ=aefJt^pv=dãÄeK

aefJt^pv=dãÄe===
sçäãÉêëíê~≈É=UI=NOQUV=_ÉêäáåI=dÉêã~åó
mÜçåÉW=HQVJPMJST=VV=VUJMI=c~ñW=HQVJPMJST=VV=VUJVV
bJj~áäW=ã~áä]ÇÜáJï~ëóKÇÉ
fåíÉêåÉíW=ïïïKÑÉÑäçïKÅçãI=ïïïKÇÜáÖêçìéKÅçã
O=ö=rëÉê=j~åì~ä



`çåíÉåíë
`çåíÉåíë
NK=fåíêçÇìÅíáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K V

NKN= tÉäÅçãÉ=íç=cbciltK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KV NKQ= pÅçéÉ=~åÇ=píêìÅíìêÉK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NM

NKO= qÜÉ=cbcilt=m~Åâ~ÖÉ =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KV
NKP= cbcilt=açÅìãÉåí~íáçå K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNM
NKR= kçí~íáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NN
OK=tÜ~íÛë=kÉï\ K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K NP

OKN= cÉmbpq =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNP OKNM= a~í~Ä~ëÉë=~åÇ=j~é=cáäÉë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NR

OKO= kÉï=mêçÄäÉã=`ä~ëëW=dêçìåÇï~íÉê=^ÖÉ =K=K=K=K=K=K=KNP
OKP= pìÄÇçã~áå=~åÇ=píçê~ÖÉ=_ìÇÖÉí=K=K=K=K=K=K=K=K=K=K=K=KNP
OKQ= qÉãéçê~ä=bäÉãÉåí=aÉ~Åíáî~íáçåK=K=K=K=K=K=K=K=K=K=K=K=KNQ
OKR= qÉãéçê~êó=_çìåÇ~êó=`çåÇáíáçå=aÉ~Åíáî~íáçå=K=KNQ
OKS= o~åÇçãJt~äâ=m~êíáÅäÉ=qê~ÅâáåÖ K=K=K=K=K=K=K=K=K=K=K=K=KNQ
OKT= kÉï=pçäîÉêë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQ
OKU= jçÇìä~íáçå=cìåÅíáçåë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQ
OKV= pÅÉåÉ=iáÄê~êóK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNR
OKNN= fåíÉê~ÅíáîÉ=Na=iáåÉ~ê=fåíÉêéçä~íáçå K=K=K=K=K=K=K=K=K=K= NR
OKNO= jÉ~ëìêÉ=qççä K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NR
OKNP= ^ÇÇáíáçå~ä=cìåÅíáçå~äáíó K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NR
OKNPKN= oÉëìäíë=bî~äì~íáçå=~åÇ=sáëì~äáò~íáçå=K=K=K=K=K=K=K=K=K= NR
OKNPKO= j~é=a~í~=e~åÇäáåÖ K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NS
OKNPKP= tçêâÑäçï=~åÇ=drf=fãéêçîÉãÉåíë =K=K=K=K=K=K=K=K=K=K= NS
OKNPKQ= cìêíÜÉê=fãéêçîÉãÉåíë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NS
PK=qÜÉ=rëÉê=fåíÉêÑ~ÅÉK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K NT

PKN= mÜáäçëçéÜó =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNT PKQKN= qóéÉë=çÑ=sáÉï=táåÇçïë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NU

PKO= dê~éÜáÅë=aêáîÉê K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNT
PKP= `ìëíçãáòáåÖ=íÜÉ=fåíÉêÑ~ÅÉ K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNU
PKQ= sáÉï=táåÇçïëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNU
PKQKO= k~îáÖ~íáçå K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NV
PKR= qìíçêá~ä =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NV
QK=tçêâáåÖ=ïáíÜ=j~éë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K ON

QKN= j~éëÔtÜ~í=cçê\=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KON QKQ= e~åÇäáåÖ=j~éë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= OR

QKNKN= o~ëíÉê=j~éëLj~éë=`çåí~áåáåÖ=a~í~ =K=K=K=K=K=K=K=K=KON
QKNKO= jáÅêçëçÑí=bñÅÉä=tçêâëÜÉÉíë=~åÇ=^ÅÅÉëë=q~ÄäÉëK=KON
QKNKP= dÉçÇ~í~Ä~ëÉë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KOO
QKNKPKN= a~í~Ä~ëÉ=`çååÉÅíáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KOO
QKNKQ= OaLPa=j~éë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KOP
QKO= `ççêÇáå~íÉ=póëíÉãëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KOQ
QKP= dÉçêÉÑÉêÉåÅáåÖ=j~éë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KOR
QKR= j~é=a~í~K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= OS
QKS= j~é=bñéçêí=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= OT
QKT= qìíçêá~ä =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= OT
QKTKN= j~é=i~óÉêë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= OV
QKTKO= j~é=a~í~K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= OV
cbcilt=SKO=ö=P



Q=ö=rëÉê=j~åì~ä

`çåíÉåíë
RK=pìéÉêãÉëÜ=aÉëáÖåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= PN

RKN= tÜ~í=áë=~=pìéÉêãÉëÜ\ K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPN RKQ= bñéçêí=çÑ=pìéÉêãÉëÜ=cÉ~íìêÉë =K=K=K=K=K=K=K=K=K=K=K=K=K=PP

RKNKN= pìéÉêãÉëÜ=mçäóÖçåë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPN
RKNKO= pìéÉêãÉëÜ=iáåÉë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPN
RKNKP= pìéÉêãÉëÜ=mçáåíë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPN
RKO= bÇáíáåÖ=pìéÉêãÉëÜ=cÉ~íìêÉëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPO
RKP= `çåîÉêíáåÖ=j~é=íç=pìéÉêãÉëÜ=cÉ~íìêÉë =K=K=K=K=K=KPP
RKR= qìíçêá~ä =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=PP
RKRKN= qççäë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=PP
RKRKO= mçäóÖçåëI=iáåÉë=~åÇ=mçáåíë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=PP
RKRKP= qÜÉ=máå=`ççêÇáå~íÉë=qççäÄ~ê =K=K=K=K=K=K=K=K=K=K=K=K=K=K=PQ
RKRKQ= pìéÉêãÉëÜ=fãéçêí=îá~=j~éëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=PR
SK=cáåáíÉJbäÉãÉåí=jÉëÜ=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= PT

SKN= pé~íá~ä=aáëÅêÉíáò~íáçå K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPT SKU= Pa=aáëÅêÉíáò~íáçå=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=QM

SKO= jÉëÜ=dÉåÉê~íáçå=mêçÅÉëë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPT
SKP= jÉëÜ=dÉåÉê~íáçå=^äÖçêáíÜãëK=K=K=K=K=K=K=K=K=K=K=K=K=K=KPU
SKPKN= ^Çî~åÅáåÖ=cêçåí=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPU
SKPKO= dêáÇ_ìáäÇÉê=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPU
SKPKP= qêá~åÖäÉK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPU
SKPKQ= qê~åëéçêí=j~ééáåÖ K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPU
SKQ= jÉëÜ=fãéçêí=Ñêçã=j~éë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPV
SKR= jÉëÜ=bÇáíáåÖ K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPV
SKS= jÉëÜJmêçéÉêíó=`ÜÉÅâ =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPV
SKT= jÉëÜJbäÉãÉåí=aÉ~Åíáî~íáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KPV
SKV= dÉçíê~åëÑçêã~íáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=QM
SKNM= qìíçêá~ä =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=QN
SKNMKN= qççäë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=QN
SKNMKO= jÉëÜ=dÉåÉê~íáçå K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=QN
SKNMKOKN= qêá~åÖìä~íáçå K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=QN
SKNMKOKO= nì~Ç=jÉëÜáåÖ K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=QP
SKNMKP= bÇáíáåÖ=íÜÉ=jÉëÜ=dÉçãÉíêó K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=QP
SKNMKPKN= qêá~åÖìä~ê=jÉëÜÉë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=QP
SKNMKPKO= nì~Ç=jÉëÜÉëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=QR
SKNMKQ= bñíÉåÇáåÖ=~=jçÇÉä=íç=PaK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=QS
TK=mêçÄäÉã=pÉííáåÖë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= QT

TKN= mêçÄäÉã=`ä~ëë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KQT TKNKS= ^åáëçíêçéó=çÑ=eóÇê~ìäáÅ=`çåÇìÅíáîáíó K=K=K=K=K=K=K=K=RP

TKNKN= mÜóëáÅ~ä=mêçÅÉëëÉë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KQT
TKNKO= aáãÉåëáçå=~åÇ=mêçàÉÅíáçåë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KQU
TKNKP= qÉãéçê~ä=pÉííáåÖë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KQV
TKNKQ= bêêçê=qçäÉê~åÅÉ=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KQV
TKNKR= cêÉÉ=pìêÑ~ÅÉK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KRM
TKNKRKN= Oa=jçÇÉä=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KRM
TKNKRKO= Pa=jçÇÉä=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KRM
TKNKRKP= eÉ~Ç=iáãáíë=Ñçê=råÅçåÑáåÉÇ=`çåÇáíáçåë K=K=K=K=K=K=KRO
TKNKSKN= Oa=jçÇÉä =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=RP
TKNKSKO= Pa=jçÇÉä =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=RP
TKO= bèì~íáçåJpóëíÉã=pçäîÉêë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=RQ
TKP= qìíçêá~ä =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=RQ
TKPKN= `çåÑáåÉÇLråÅçåÑáåÉÇ=jçÇÉäë =K=K=K=K=K=K=K=K=K=K=K=K=K=RQ
TKPKO= råë~íìê~íÉÇ=jçÇÉäë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=RR
TKPKP= qê~åëéçêí=jçÇÉäë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=RS
TKPKQ= píÉ~Çó=L=qê~åëáÉåí=jçÇÉäë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=RT
UK=tçêâáåÖ=ïáíÜ=pÉäÉÅíáçåë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= RV

UKN= fåíêçÇìÅíáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KRV UKO= pÉäÉÅíáçå=qççäë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=RV



`çåíÉåíë
UKP= píçêáåÖ=pÉäÉÅíáçåë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KSN
UKQ= qìíçêá~ä K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KSN
UKQKN= qççäë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KSN
UKQKO= dÉåÉê~ä=oÉã~êâë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KSN
UKQKP= j~åì~ä=pÉäÉÅíáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KSO
UKQKPKN= pÉäÉÅíáçåë=áå=Oa =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KSO
UKQKPKO= pÉäÉÅíáçåë=áå=Pa =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KSP
UKQKQ= j~éJÄ~ëÉÇ=pÉäÉÅíáçåë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= SP
UKQKR= bñéêÉëëáçåJÄ~ëÉÇ=pÉäÉÅíáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= SQ
UKQKS= píçêáåÖ=pÉäÉÅíáçåë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= SQ
UKQKT= `çåîÉêíáåÖ=pÉäÉÅíáçå=qóéÉë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= SR
UKQKU= bñéçêíáåÖ=~åÇ=oÉáãéçêíáåÖ=pÉäÉÅíáçåë=K=K=K=K=K=K=K= SR
UKQKV= rëáåÖ=pÉäÉÅíáçåë=~ë=k~îáÖ~íáçå=oÉÑÉêÉåÅÉ K=K=K=K=K= SR
VK=m~ê~ãÉíÉê=sáëì~äáò~íáçå=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K ST

VKN= fåíêçÇìÅíáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KST VKU= píÉêÉçëÅçéáÅ=sáëì~äáò~íáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= TM

VKO= sáÉï=táåÇçïëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KST
VKP= jçÇÉä=dÉçãÉíêó=~åÇ=a~í~=mäçíë=K=K=K=K=K=K=K=K=K=K=K=KST
VKQ= sáëì~äáò~íáçå=léíáçåëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KSU
VKR= `äáééáåÖ=~åÇ=`~êîáåÖ =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KSU
VKS= fåëéÉÅíáçå K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KSV
VKT= pÅÉåÉ=iáÄê~êóK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KSV
VKV= qìíçêá~ä =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= TM
VKVKN= sáÉï=táåÇçïë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= TM
VKVKO= ^ÇÇ=jçÇÉä=dÉçãÉíêó=~åÇ=m~ê~ãÉíÉêë K=K=K=K=K=K=K= TN
VKVKP= sáëì~äáò~íáçå=léíáçåë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= TN
VKVKQ= `äáééáåÖ=~åÇ=`~êîáåÖK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= TO
VKVKR= pÅÉåÉ=iáÄê~êó K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= TP
NMK=m~ê~ãÉíÉê=^ëëáÖåãÉåí K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K TR

NMKN= fåíêçÇìÅíáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KTR NMKTKO= ^ëëáÖåãÉåí =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= UT

NMKO= fåéìí=m~ê~ãÉíÉêë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KTR
NMKOKN= dÉçãÉíêó=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KTS
NMKOKO= mêçÅÉëë=s~êá~ÄäÉë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KTS
NMKOKP= _çìåÇ~êó=`çåÇáíáçåëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KTS
NMKOKQ= j~íÉêá~ä=mêçéÉêíáÉë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KUN
NMKOKR= ^ìñáäá~êó=a~í~=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KUN
NMKOKS= rëÉê=a~í~ =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KUN
NMKOKT= aáëÅêÉíÉ=cÉ~íìêÉë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KUO
NMKP= ^ëëáÖåãÉåí=çÑ=`çåëí~åí=s~äìÉë=K=K=K=K=K=K=K=K=K=K=K=K=KUO
NMKQ= ^ëëáÖåãÉåí=çÑ=qáãÉ=pÉêáÉë=a~í~K=K=K=K=K=K=K=K=K=K=K=K=KUO
NMKQKN= qáãÉ=pÉêáÉë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KUO
NMKQKO= ^ëëáÖåãÉåí K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KUQ
NMKR= ^ëëáÖåãÉåí=çÑ=j~é=a~í~ K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KUQ
NMKRKN= fåíÉê~ÅíáîÉ=a~í~=fåéìí=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KUQ
NMKRKO= ^ìíçã~íáÅ=a~í~=fåéìí=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KUR
NMKRKP= ^ëëáÖåãÉåí=îá~=nìáÅâ=fãéçêíK=K=K=K=K=K=K=K=K=K=K=K=K=K=KUS
NMKS= ^ëëáÖåãÉåí=îá~=bñéêÉëëáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KUS
NMKSKN= ^ëëáÖåãÉåí K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KUT
NMKT= ^ëëáÖåãÉåí=çÑ=iççâìé=q~ÄäÉ=s~äìÉëK=K=K=K=K=K=K=K=K=KUT
NMKTKN= iççâìé=q~ÄäÉë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KUT
NMKU= `çéóáåÖ=çÑ=a~í~=s~äìÉë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= UU
NMKV= ^ëëáÖåãÉåí=çÑ=jìäíáéäÉ=m~ê~ãÉíÉêë =K=K=K=K=K=K=K=K=K= UU
NMKNM= qáãÉJs~êóáåÖ=j~íÉêá~ä=mêçéÉêíáÉë=K=K=K=K=K=K=K=K=K=K=K= UU
NMKNMKN= j~åì~ä=^ëëáÖåãÉåí K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= UV
NMKNMKO= j~åì~ä=^ëëáÖåãÉåí=Ñêçã=qáãÉ=pÉêáÉëK=K=K=K=K=K=K=K= UV
NMKNMKP= ^ëëáÖåãÉåí=çÑ=j~é=a~í~=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= UV
NMKNMKQ= ^ëëáÖåãÉåí=îá~=bñéêÉëëáçå K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= VN
NMKNN= rëÉ=m~ê~ãÉíÉê=bñéêÉëëáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= VN
NMKNO= fåíÉê~ÅíáîÉ=Na=iáåÉ~ê=fåíÉêéçä~íáçå K=K=K=K=K=K=K=K=K=K= VN
NMKNP= råáíë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= VO
NMKNQ= qìíçêá~ä =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= VO
NMKNQKN= qççäë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= VO
NMKNQKO= ^ëëáÖåãÉåí=çÑ=`çåëí~åí=s~äìÉë =K=K=K=K=K=K=K=K=K=K=K=K= VO
NMKNQKP= ^ëëáÖåãÉåí=çÑ=qáãÉ=pÉêáÉë=a~í~ K=K=K=K=K=K=K=K=K=K=K=K= VQ
NMKNQKQ= ^ëëáÖåãÉåí=çÑ=j~é=a~í~=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= VR
NMKNQKQKN= fåíÉê~ÅíáîÉ=a~í~=fåéìí =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= VR
NMKNQKQKO== ^ìíçã~íáÅ=a~í~=fåéìí =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= VR
NMKNQKQKP= ^ëëáÖåãÉåí=îá~=nìáÅâ=fãéçêí K=K=K=K=K=K=K=K=K=K=K=K=K=K= VS
NMKNQKR= ^ëëáÖåãÉåí=îá~=bñéêÉëëáçå K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= VT
NMKNQKS= ^ëëáÖåãÉåí=îá~=`çéó=~åÇ=m~ëíÉ=K=K=K=K=K=K=K=K=K=K=K=K= VT
cbcilt=SKO=ö=R



S=ö=rëÉê=j~åì~ä

`çåíÉåíë
NMKNQKT= ^ëëáÖå=jìäíáéäÉ=m~ê~ãÉíÉêë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KVU
NMKNQKU= qáãÉJs~êóáåÖ=j~íÉêá~ä=mêçéÉêíó=^ëëáÖåãÉåí =K=K=KVU
NMKNQKV= ^ëëáÖåãÉåí=îá~=fåíÉê~ÅíáîÉ=Na=fåíÉêéçä~íáçåK=K=K=KVV
NMKNQKNM== jìäíáä~óÉêJtÉää=^ëëáÖåãÉåí=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NMM
NMKNQKNN= ^ëëáÖåãÉåí=çÑ=_çêÉÜçäÉ=eÉ~í=bñÅÜ~åÖÉêëK=K=K=K=NMN
NMKNQKNO= aáëÅêÉíÉJcÉ~íìêÉ=^ëëáÖåãÉåí =K=K=K=K=K=K=K=K=K=K=K=K=K=NMO
NNK=páãìä~íáçå=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NMR

NNKN== fåíêçÇìÅíáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNMR NNKSKN= qççäë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NMS

NNKO= jçÇÉä=`ÜÉÅâK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNMR
NNKP= oÉëìäíë=lìíéìíK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNMR
NNKQ= oìååáåÖ=íÜÉ=páãìä~íáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNMS
NNKR= `çåîÉêÖÉåÅÉK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNMS
NNKS= qìíçêá~ä K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNMS
NNKSKO= jçÇÉä=`ÜÉÅâ K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NMS
NNKSKP= oÉëìäíë=lìíéìí K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NMT
NNKSKPKN= _ìÇÖÉí=dêçìéëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NMU
NNKSKPKO= lÄëÉêî~íáçå=mçáåíë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NMU
NNKSKQ= oìååáåÖ=íÜÉ=páãìä~íáçå=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NMV
NOK=oÉëìäíë=bî~äì~íáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NNN

NOKN= fåíêçÇìÅíáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNNN NOKT= bñéçêí =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NNR

NOKO= lÄëÉêî~íáçå=mçáåíë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNNN
NOKOKN= pÅ~ííÉê=mäçí=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNNN
NOKP= _ìÇÖÉí=^å~äóëáë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNNO
NOKPKN= dÉåÉê~ä=_ìÇÖÉíáåÖ =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNNO
NOKPKO= pìÄÇçã~áåJ_çìåÇ~êó=_ìÇÖÉí K=K=K=K=K=K=K=K=K=K=K=K=KNNP
NOKPKP= _ìÇÖÉí=dêçìéë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNNP
NOKQ= jìäíáä~óÉê=tÉääëW=cäçï=éÉê=i~óÉê =K=K=K=K=K=K=K=K=K=K=KNNQ
NOKR= `çåíÉåí=^å~äóëáë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNNQ
NOKS= píêÉ~ãäáåÉë=~åÇ=m~íÜäáåÉë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNNQ
NOKSKN= o~åÇçãJt~äâ=m~êíáÅäÉJqê~ÅâáåÖ K=K=K=K=K=K=K=K=K=K=K=KNNR
NOKU= qìíçêá~ä =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NNS
NOKUKN= qççäë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NNS
NOKUKO= lÄëÉêî~íáçå=mçáåíë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NNS
NOKUKP= _ìÇÖÉí=^å~äóëáë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NNT
NOKUKQ= pìÄÇçã~áåJ_çìåÇ~êó=_ìÇÖÉí =K=K=K=K=K=K=K=K=K=K=K=K=NNU
NOKUKR= `çåíÉåí=^å~äóëáë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NNV
NOKUKS= píêÉ~ãäáåÉëI=m~íÜäáåÉëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NNV
NOKUKT= o~åÇçãJt~äâ=m~êíáÅäÉJqê~ÅâáåÖ=EotmqF K=K=K=K=K=NON
NOKUKU= bñéçêí=çÑ=oÉëìäíë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NOO
NPK=^åáã~íáçå=~åÇ=sáÇÉç=bñéçêí K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NOP

NPKN= fåíêçÇìÅíáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNOP NPKQKN= qççäë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NOQ

NPKO= `êÉ~íáåÖ=~=mêÉëÉåí~íáçå K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNOP
NPKP= jçîáÉ=bñéçêíK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNOQ
NPKQ= qìíçêá~ä K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNOQ
NPKQKO= `êÉ~íáåÖ=~=mêÉëÉåí~íáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NOQ
NPKQKP= jçîáÉ=bñéçêí K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NOR
NPKQKQ= bñéçêí=pÉííáåÖëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NOR
NQK=dêçìåÇï~íÉê=^ÖÉ=`~äÅìä~íáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NOT

NQKN= fåíêçÇìÅíáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNOT NQKR= qìíçêá~ä =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NOU

NQKO= dêçìåÇï~íÉê=^ÖÉ=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNOT
NQKP= jÉ~å=iáÑÉíáãÉ=bñéÉÅí~åÅóK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNOT
NQKQ= bñáí=mêçÄ~Äáäáíó =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNOU
NQKRKN= qççäë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NOU
NQKRKO= pÉííáåÖ=ìé=~=dêçìåÇï~íÉê=^ÖÉ=páãìä~íáçå K=K=K=NOU
NQKRKP= oÉëìäíë=bî~äì~íáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NPM



`çåíÉåíë
NQKRKPKN= qê~îÉäJqáãÉ=^å~äóëáë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPM
NQKRKPKO= `~éíìêÉ=wçåÉ=aÉäáåÉ~íáçå=J=bñáí=mêçÄ~Äáäáíó K=K=KNPN
NQKRKPKP= `~éíìêÉJwçåÉ=`çåíÉåíI=pçìêÅÉ=m~êíáíáçåáåÖ=~åÇ=
lêáÖáå=çÑ=t~íÉê =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NPN
NRK=cÉmbpq K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K NPP

NRKN= fåíêçÇìÅíáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPP NRKPKRKO= psaJ^ëëáëí =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NRR

NRKNKN= tÜ~í=fë=mbpq\=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPP
NRKNKO= tÜÉêÉ=íç=dÉí=mbpq\ =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPQ
NRKNKP= tÜ~í=fë=cÉmbpq\ =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPQ
NRKNKQ= tÜÉêÉ=íç=pí~êíKKK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPQ
NRKNKQKN= fÑ=vçì=^êÉ=kÉï=íç=mbpq K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPQ
NRKNKQKO= fÑ=vçì=^êÉ=~å=bñéÉêáÉåÅÉÇ=mbpq=rëÉê=K=K=K=K=K=K=K=KNPQ
NRKNKR= oÉä~íÉÇ=iáíÉê~íìêÉ =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPR
NRKNKS= lîÉê~ää=tçêâÑäçïK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPR
NRKNKT= ^ÅâåçïäÉÇÖÉãÉåíë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPS
NRKO= jÉíÜçÇë=~åÇ=`çåÅÉéíë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPS
NRKOKN= dij^=pÉ~êÅÜ=^äÖçêáíÜã=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPS
NRKOKNKN= aÉêáî~íáîÉ=`~äÅìä~íáçå=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNPV
NRKOKNKO= lÄëÉêî~íáçå=tÉáÖÜíë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQM
NRKOKO= máäçíJmçáåí=jÉíÜçÇ =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQN
NRKOKP= m~ê~ãÉíÉê=kçåìåáèìÉåÉëëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQO
NRKOKQ= mêáçê=håçïäÉÇÖÉ=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQO
NRKOKQKN= mêáçê=fåÑçêã~íáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQO
NRKOKQKO= qáâÜçåçî=oÉÖìä~êáò~íáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQP
NRKOKQKP= oÉÖìä~êáò~íáçå=çÑ=máäçíJmçáåí=m~ê~ãÉíÉêëK=K=K=K=K=KNQQ
NRKOKR= pìÄëé~ÅÉ=oÉÖìä~êáò~íáçå=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQS
NRKOKRKN= qêìåÅ~íÉÇ=páåÖìä~ê=s~äìÉ=aÉÅçãéçëáíáçå =K=K=K=KNQS
NRKOKRKO= psaJ^ëëáëí K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQT
NRKOKRKP= iÉ~ëí=pèì~êÉë=EipnoFK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQT
NRKP= cìåÇ~ãÉåí~ä=pÉíìé K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQT
NRKPKN= cbcilt=~åÇ=cÉmbpq=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQT
NRKPKO= ^Çàìëí~ÄäÉ=m~ê~ãÉíÉêë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQU
NRKPKOKN= aÉÑáåáíáçå=çÑ=m~ê~ãÉíÉêë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNQU
NRKPKOKO= m~ê~ãÉíÉê=dêçìéë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNRM
NRKPKP= lÄëÉêî~íáçåë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNRN
NRKPKPKN= aÉÑáåáíáçå=çÑ=lÄëÉêî~íáçåë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNRN
NRKPKPKO= lÄëÉêî~íáçå=dêçìéë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNRO
NRKPKQ= mêáçê=håçïäÉÇÖÉ=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNRP
NRKPKQKN= mêáçê=fåÑçêã~íáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNRP
NRKPKQKO= qáâÜçåçî=oÉÖìä~êáò~íáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNRP
NRKPKR= pìÄëé~ÅÉ=oÉÖìä~êáò~íáçå=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNRR
NRKPKRKN= páåÖìä~ê=s~äìÉ=aÉÅçãéçëáíáçåK=K=K=K=K=K=K=K=K=K=K=K=KNRR
NRKPKS= m~ê~ääÉäáò~íáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NRR
NRKQ= m~ê~ãÉíÉê=bëíáã~íáçå=Eeáëíçêó=j~íÅÜáåÖL`~äáÄê~J

íáçåF =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NRT
NRKQKN= oÉèìáêÉÇ=pÉííáåÖë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NRT
NRKQKNKN= léíáãáò~íáçå=`çåíêçä K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NRT
NRKQKNKO= líÜÉê=pÉííáåÖë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NRT
NRKQKO= pí~êíáåÖ=mbpq K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NRT
NRKQKOKN= mêÉÑäáÖÜí=`ÜÉÅâë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NRT
NRKQKOKO== oìååáåÖ=mbpqK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NRU
NRKQKP= lìíéìí=ÇìêáåÖ=mbpq=oìå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NRV
NRKQKQ= lìíéìí=~ÑíÉê=mbpq=oìå K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSM
NRKQKR= bñéçêí=íç=cbcilt=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSN
NRKR= mêÉÇáÅíáîÉ=^å~äóëáë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSO
NRKRKN= oÉèìáêÉÇ=pÉííáåÖë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSO
NRKRKNKN= léíáãáò~íáçå=`çåíêçä K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSO
NRKRKNKO= lÄëÉêî~íáçå=~åÇ=qóéÉ=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSO
NRKRKNKP= lÄàÉÅíáîÉ=cìåÅíáçå=iáãáíëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSO
NRKRKNKQ= líÜÉê=pÉííáåÖë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSP
NRKRKO= pí~êíáåÖ=mbpq K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSP
NRKRKP= lìíéìí=ÇìêáåÖ=mêÉÇáÅíáîÉ=^å~äóëáë =K=K=K=K=K=K=K=K=K= NSP
NRKRKQ= bëíáã~íáçå=oÉëìäíë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSP
NRKS= líÜÉê=qççäë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSQ
NRKSKN= pÉåëáíáîáíó=bñéçêí=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSQ
NRKSKNKN= oÉèìáêÉÇ=pÉííáåÖë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSQ
NRKSKNKO= bñéçêí=çÑ=pÉåëáíáîáíáÉë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSQ
NRKSKO= jçÇÉä=pí~Äáäáíó=qÉëíë=Eg^`qbpqF=K=K=K=K=K=K=K=K=K=K=K= NSQ
NRKSKOKN= rëáåÖ=g^`qbpq K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSR
NRKT= `ìëíçãáòÉÇ=mbpq=pÉíìéë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSR
NRKTKN= `êÉ~íáåÖ=íÜÉ=mbpq=pÉíìé =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSS
NRKTKO= `çåîÉåáÉåÅÉ=qççäëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NSS
NRKTKP= cáäÉ=píêìÅíìêÉ=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NST
NRKTKQ= oìååáåÖ=`ìëíçãáòÉÇ=mbpq=pÉíìéë =K=K=K=K=K=K=K=K=K= NSU
NRKTKR= fåíÉÖê~íáåÖ=fcj=mäìÖJáåë=~åÇ=qÜáêÇJm~êíó=`çÇÉ NSV
NRKU= cÉmbpq=qìíçêá~ä =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NTM
NRKUKN= `çåÅÉéíì~ä=jçÇÉä K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NTM
NRKUKO= cáÉäÇ=jÉ~ëìêÉãÉåíë=~åÇ=oÉÑÉêÉåÅÉ=a~í~ =K=K=K=K= NTM
cbcilt=SKO=ö=T



U=ö=rëÉê=j~åì~ä

`çåíÉåíë
NRKUKP= cbcilt=jçÇÉä=mêÉé~ê~íáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=KNTN
NRKUKQ= cÉmbpq=fåáíá~ä=`çåÑáÖìê~íáçåK=K=K=K=K=K=K=K=K=K=K=K=K=K=KNTO
NRKUKR= aÉÑáåáíáçå=çÑ=~=kÉï=cÉmbpq=mêçÄäÉã K=K=K=K=K=K=K=KNTO
NRKUKS= léíáãáò~íáçå=pÉííáåÖë=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNTP
NRKUKT= m~ê~ãÉíÉê=aÉÑáåáíáçå K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNTQ
NRKUKU= lÄëÉêî~íáçåë=aÉÑáåáíáçå K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNTU
NRKUKV= m~ê~ääÉäáò~íáçå=jçÇÉ =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNUM
NRKUKNM= bëíáã~íáçå=jÉíÜçÇ=~åÇ=oÉÖìä~êáò~íáçå=pÉíìé =KNUM
NRKUKNMKN= kç=oÉÖìä~êáò~íáçå=pÉíìéK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NUN
NRKUKNMKO= qáâÜçåçî=oÉÖìä~êáò~íáçå=pÉíìé K=K=K=K=K=K=K=K=K=K=K=K=NUN
NRKUKNMKP= páåÖìä~ê=s~äìÉ=aÉÅçãéçëáíáçå=pÉíJìéK=K=K=K=K=K=K=NUO
NRKUKNMKQ= páåÖìä~ê=s~äìÉ=aÉÅçãéçëáíáçå=~åÇ=qáâÜçåçî=oÉÖìJ

ä~êáò~íáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NUO
NRKUKNN= oìååáåÖ=mbpqK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NUP
NRKUKNO= mçëíéêçÅÉëëáåÖ=mbpq=oÉëìäíë K=K=K=K=K=K=K=K=K=K=K=K=K=K=NUQ
NSK=mäìÖJáåë=~åÇ=fåíÉêÑ~ÅÉ=j~å~ÖÉê=fcjK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K= NVP

NSKN= fåíêçÇìÅíáçå =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNVP NSKRKO= mêçÖê~ããáåÖ=mäìÖJáåë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=NVR

NSKO= mäìÖJáåë=Ñçê=rëÉêëK=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNVP
NSKP= qÉÅÜåçäçÖó K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNVQ
NSKQ= fcj=Ñçê=mêçÖê~ããÉêë =K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNVQ
NSKR= qìíçêá~ä K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNVQ
NSKRKN= rëáåÖ=mäìÖJáåë K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=K=KNVQ
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NKN tÉäÅçãÉ=íç=cbcilt

Thank you for choosing FEFLOW! You have
selected one of the most comprehensive, well-tested
and reliable programs for the simulation of flow,
groundwater age, mass- and heat-transport processes in
porous media. 

This manual explains FEFLOW’s extensive model-
ing capabilities so that the easy-to-use intuitive graphi-
cal user interface can be used to its full potential. 

Please take your time to familiarize yourself with
the software to ensure maximum productivity and effi-
ciency in your projects. 

NKO qÜÉ=cbcilt=m~Åâ~ÖÉ

The FEFLOW user interface supports the entire
workflow from preprocessing via the simulation run to
postprocessing. In addition, there are a number of sup-
porting applications for specific purposes:
cÉmbpq
A convenient graphical user interface for using

PEST by John Doherty with your FEFLOW models for
parameter estimation, uncertainty analysis and much
more. FePEST runs with a FEFLOW license.

cbcilt=sáÉïÉê
Free visualization and postprocessing tool for

FEFLOW files. 

`çãã~åÇJiáåÉ=jçÇÉ
In command-line mode, FEFLOW runs without any

graphical user interface. This is especially useful for
batch runs or integration into other simulation environ-
ments.

tdbl
WGEO is a geo-imaging software. Its most impor-

tant fields of application in connection with FEFLOW
modeling are georeferencing of raster maps and coordi-
nate transformation.

cbmilq
As FEFLOW itself does not provide printing capa-

bilities, FEPLOT can be used to create plot layouts and
N
fåíêçÇìÅíáçå
cbcilt=SKO=ö=V
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NK=fåíêçÇìÅíáçå
print maps composed of vector maps, graphical ele-
ments, and text.

cbJijO
This tool provides functionality for curve fitting,

e.g., for obtaining the parameters for parametric rela-
tionships in unsaturated flow or for sorption isotherms. 

NKP cbcilt=açÅìãÉåí~íáçå

The FEFLOW documentation provides an introduc-
tion to the practical application of the software as well
as a detailed description of the underlying concepts and
methods. While you obtained the Installation Guide in
print, the User Manual is available in pdf format on the
installation disk or on our web site. 

The comprehensive book “FEFLOW – Finite Ele-
ment Modeling of Flow, Mass and Heat Transport in
Porous and Fractured Media” written by H.J. G. Dier-
sch represents a theoretical textbook and covers a wide
range of physical and computational issues in the field
of porous/fractured-media modeling. The book is gen-
eral and will be useful for both students and practitio-
ners in engineering and geosciences as well as in other
fields where porous-media flow dynamics and compu-
tational methods are of specific concern.

The book starts with a more general theory for all
relevant flow and transport phenomena on the basis of
the continuum approach, systematically develops the
basic framework for important classes of problems
(e.g., multiphase/multispecies nonisothermal flow and
transport phenomena, discrete features, aquifer-aver-
aged equations, geothermal processes), introduces
finite-element techniques for solving the basic balance
equations, in detail discusses advanced numerical algo-
rithms for the resulting nonlinear and linear problems
and completes with a number of benchmarks, applica-
tions and exercises to illustrate the different types of
problems and ways to tackle them successfully (e.g.,
flow and seepage problems, unsaturated-saturated flow,
advective-diffusion transport, saltwater intrusion, geo-
thermal and thermohaline flow). 

The book is available for sale online and is included
with every FEFLOW 6.2 license. 

This User Manual and the step-by-step Tutorial con-
tained in the DVD booklet complement the documenta-
tion on the more practical side. 

A full reference of the user interface elements along
with a detailed description of the handling is available
in the help system of the graphical interface.

Screen casts for the exercises described in the tuto-
rial sections as well as for the demonstration exercise
are available online at www.feflow.com.

NKQ pÅçéÉ=~åÇ=píêìÅíìêÉ

This User Manual is intended as a practical guide to
groundwater modeling with FEFLOW. It aims to
explain the essential work steps of model setup, simu-
lation and postprocessing, and to present alternative
options and settings with their specific advantages and
disadvantages for specific applications. Thus the User
Manual can serve both as an introduction for FEFLOW
’newbies’, and as a reference for more experienced
users. Its position within the complete set of documen-
tation is between the theoretical basis in the FEFLOW
book and the detailed description of the user-interface
elements and work flows in the help system.

The manual follows a typical modeling workflow—
starting from basic maps and finishing with postpro-
cessing and extending FEFLOW’s capabilities. Each
chapter starts with an introduction to the topic, presents



NKR=kçí~íáçå
the relevant FEFLOW tools, describes the concepts and
workflows, and ends with a tutorial. 

NKR kçí~íáçå

Most of the tutorials are based on prepared files,
thus they require installation of the FEFLOW demo
data package. <FEFLOW demo> in a file path refers to
the folder of the demo data installation. The default
installation location may differ between operating sys-
tems. On Microsoft Windows, the typical installation
locations are: 

• Windows Vista, 7 and 8:
C:\Users\Public\Documents\WASY FEFLOW 6.2
\demo
cbcilt=SKO=ö=NN
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O tÜ~íÛë=kÉï\

FEFLOW 6.2 features a substantially extended
range of functionality. 

This chapter presents the highlights of the new ver-
sion in an overview of the most important new features
and improvements. 

OKN cÉmbpq

FePEST that is now included with every FEFLOW
license is a graphical user interface for using PEST by
John Doherty with FEFLOW for, e.g., model calibra-
tion, sensitivity and uncertainty analysis as well as pre-
dictive analysis. Its advantages include graphical
support during the setup process and immediate graphi-
cal feedback on the simulation progress.

Chapter 15 provides an extensive introduction to
FePEST, the available functionality and supported
PEST methods. 

Page 133
OKO kÉï= mêçÄäÉã= `ä~ëëW
dêçìåÇï~íÉê=^ÖÉ

Groundwater Age is available as a new kind of
problem class – similar to mass or heat transport. For
age simulations, the parameters groundwater age, life-
time expectancy and exit probability can be calculated
and provide the means to analyze flow dynamics and
mixing processes, estimate risk vulnerability or evalu-
ate outlet capture zones and the origin of water.

Page 127

OKP pìÄÇçã~áå= ~åÇ= píçêJ
~ÖÉ=_ìÇÖÉí

Storage Capture/Release is a new component in the
Rate-Budget and Period-Budget panels for flow and
transport. With this, storage change and solution error
(Imbalance) can be clearly separated in transient mod-
els. 

Flow across a model-internal subdomain boundary
can be calculated exactly in new Subdomain Bound-
ary Rate and Subdomain Boundary Period panels for
flow and transport. Combined with the options of the
O
tÜ~íÛë=kÉï=áå=cbcilt=SKO\
New features and improvements
cbcilt=SKO=ö=NP
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OK=tÜ~íÛë=kÉï=áå=cbcilt=SKO\
already existing Rate-Budget and Period-Budget pan-
els, complete and exact water balances for arbitrary
subdomains within a model can be easily obtained.

Page 112 and Page 113

OKQ qÉãéçê~ä=bäÉãÉåí=aÉ~ÅJ
íáî~íáçå

With the new parameter In-/active Elements, mesh
elements can be de- and reactivated. Elements can be
made inactive for an entire simulation or only during
specific periods during a simulation.

With this new feature, time-varying model geome-
try as encountered in open-pit or long-term simulations
with morphological changes can be simulated as well
as permanently impermeable structures. 

 Page 39

OKR qÉãéçê~êó= _çìåÇ~êó
`çåÇáíáçå=aÉ~Åíáî~íáçå

Time series describing transient boundary condi-
tions or boundary constraints can now contain gaps
during which a boundary condition or constraint will
be completely deactivated.

This new feature allows to turn any kind of bound-
ary condition off and on during a simulation without
the need for inefficient constraints or additional plug-
ins.

Page 82
OKS o~åÇçãJt~äâ= m~êíáÅäÉ
qê~ÅâáåÖ

FEFLOW 6.2 provides extended options for stream-
line and pathline analysis: Random-Walk Particle
Tracks incorporate diffusion and dispersion, bringing
field-line analysis a large step closer to the capabilities
of a full advection-dispersion solution. As this option
does not require the setup of a transport problem, pre-
processing effort and computational cost remain com-
parably low. 

Page 115

OKT kÉï=pçäîÉêë

PARDISO (developed by O. Schenk and K. Gärt-
ner) is a parallelized direct solver. As a direct solver, it
provides a noniterative exact solution of the equation
system, at an often affordable computational cost
thanks to parallelization. PARDISO is the new default
direct equation system solver. 

FEFLOW 6.2 provides a new version of the alge-
braic multigrid solver, SAMG 2.7. Additionally, the
FEFLOW-specific settings for SAMG have been
adapted to better match the typical FEFLOW models.
With this, FEFLOW reaches a new level of solution
performance, robustness and stability. 

Page 54

OKU jçÇìä~íáçå=cìåÅíáçåë

In transient models, boundary conditions can be
modified by applying a time series as a modulation
function. With this new feature a large number of
boundary conditions can very efficiently be turned off



OKV=pÅÉåÉ=iáÄê~êó
at specific time stages if the modulation function con-
tains gaps, or boundary-condition values can be modi-
fied, e.g., for calibration purposes or to incorporate
seasonal changes, etc.

Page 80

OKV pÅÉåÉ=iáÄê~êó

Settings for Slice, 3D, Supermesh and Cross-sec-
tion views can be stored in the new Scene Library
panel and organized in a user-defined folder structure.

With this new option, even large numbers of view
settings (including animation settings) can be easily
stored without the overhead of always recreating the
respective view windows when loading the model,
thereby reducing the required memory demand signifi-
cantly.

Page 69

OKNM a~í~Ä~ëÉë= ~åÇ= j~é
cáäÉë

Tabular data from Microsoft Excel workbooks and
Microsoft Access databases as well as geometries and
tabular data in ESRI Geodatabases, PostgreSQL and
Oracle databases can now be used for map display, data
import and export, without the need for re-formatting.
With additional joining and selection options, project
data, including geographical data, can now be easily
stored without redundancies and in one single place.

Page 22
OKNN fåíÉê~ÅíáîÉ= Na= iáåÉ~ê
fåíÉêéçä~íáçå

1D linear interpolation along lines can be performed
interactively without the need for maps containing
boundary-condition or boundary-constraint values and
line geometry. The input of constant values, time-series
IDs or usage of user-defined expressions is supported.

Page 91

OKNO jÉ~ëìêÉ=qççä

The FEFLOW 6.2 interface provides a new tool to
measure distances and areas in Supermesh and Slice
views and distances in 3D views.

Page 39

OKNP ^ÇÇáíáçå~ä=cìåÅíáçå~äáíó

OKNPKN oÉëìäíë=bî~äì~íáçå=~åÇ=sáëì~äJ
áò~íáçå=

FEFLOW 6.2 provides an extended set of tools and
features for improved results evaluation and visualiza-
tion. 

• 3D spheres and cylinders available as starting
locations for field-line analysis

• Péclet Number available in Auxiliary Data
• Predefined user distributions for error norms for

flow, mass, age and heat
• Export of georeferenced snapshots from Slice

views
• Export of process-variable results for multiple or

all stored time steps in *.dac files
cbcilt=SKO=ö=NR
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OK=tÜ~íÛë=kÉï=áå=cbcilt=SKO\
• Field lines: Consideration of retardation due to
Henry-type sorption

OKNPKO j~é=a~í~=e~åÇäáåÖ

• User-defined folder structure in Maps panel with
maps of arbitrary type in each folder

• Search option for folder and map names in Maps
panel

• Quick Parameter Import option for previously
exported maps from FEFLOW without the need
for parameter links

• Import/export of relative map locations and all
map settings from/to map reference files (*.fmr)

• Import/export of map layers from/into *.fml file 
• Import/export of layer styles from/into *.fms file
• Automatic loading of exported maps to Maps

panel
• List of maps in View Components panel reflects

Maps panel structure

OKNPKP tçêâÑäçï= ~åÇ= drf= fãéêçîÉJ
ãÉåíë

• Auxiliary Spatial Units panel(s)
• Conversion of stored selections into various

geometry types
• Copy/paste functionality for chart plots
• Expression Editor with units
• Inspection panel: Separate sections for parameters

and map attributes, search/filter options available
• Export option for Discrete Features and Reimport

via Quick Import
• Multi-selection option in Maps, Data and View

Components panel for visualization and data
export
• Import/export of multiple location sets and selec-
tions

OKNPKQ cìêíÜÉê=fãéêçîÉãÉåíë

• Isolines with in-line labels in 3D views (p. 71)
• Labelling of line and polygon maps
• Optional display of solver residuals and solver

CPU usage in Log panel
• Handling of Discrete Features: Scaling of con-

ductivity values depending on the saturation
within the feature
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P qÜÉ=rëÉê=fåíÉêÑ~ÅÉ

PKN mÜáäçëçéÜó

The user interface of FEFLOW 6.2 is designed to
provide as many tools as possible without the need to
open nested dialogs or menus. While allowing an effi-
cient workflow for experienced FEFLOW modelers,
the interface might look complex to first-time users. 

Therefore only the interface components that are
relevant at the current stage of model setup or for the
current model class are shown. The five main interface
components—menus, toolbars, views, panels and

Figure 3.1 Context menu in the View Components panel.
charts—all adapt automatically to the current context. 
To provide often-needed functionality as quickly as

possible, many controls are also accessible via context
menus that are available for most user-interface ele-
ments, for example, parameters in the Data panel or
legends in a view window.

PKO dê~éÜáÅë=aêáîÉê

The FEFLOW user interface makes use of OpenGL
(Open Graphics Library) for visualization. OpenGL is
a well-proven standard that gives access to the capabil-
ities of the graphics hardware for accelerated display.
To efficiently use OpenGL, a graphics driver provided
by the graphics-card or chipset manufacturer should be
installed. The standard drivers included with an operat-
ing system might not support OpenGL to a sufficient
extent. Especially on laptop computers, drivers pro-
vided at purchase have been found to contain OpenGL
bugs in several cases. We recommend to download the
most recent drivers from the graphics-card or chipset
manufacturer’s web site before using FEFLOW or
when problems in the graphical display are observed.
P
qÜÉ=rëÉê=fåíÉêÑ~ÅÉ
How to use the basic user interface components
cbcilt=SKO=ö=NT
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PKP `ìëíçãáòáåÖ= íÜÉ= fåíÉêJ
Ñ~ÅÉ

The interface is completely customizable, i.e., the
location and visibility of all components except the
main menu can be chosen arbitrarily. Components can
be docked to a certain main-window location, or they
can be floating as separate windows.

To switch between docked and floating status, dou-
ble-click the header of a panel or move a component to
another location by dragging it while pressing the left
mouse button. To avoid docking, the <Ctrl> key can be
pressed before and while moving a panel or chart win-
dow.

Panels and charts can also be tabbed so that two or
more of these elements are placed above each other.
Clicking on one of the tabs brings the corresponding
panel or chart to the front.

Floating toolbars, panels and charts can be moved
outside the main application window. This is especially
helpful to enlarge view windows on one screen while
arranging toolbars and panels on another screen. 

View windows can also be set floating with <Ctrl>
+ <F11> and then moved outside the main window
(e.g., to a second screen). Full-screen mode is available
for all view windows via <F11>.

Toolbars, panels and charts can be turned on and off

Figure 3.2 Context menu.
by using the context menu on ’empty’ parts of the user
interface, i.e., parts where no other context menu
comes up (Figure 3.2). Panels and charts can also be
closed by clicking on the closing icon in the upper right
corner of the element.

While exploring the new interface you may come to
a situation where most panels and toolbars are hidden,
and the remaining ones are not where you want them to
be. In such a case, just switch on Reset Toolbar and
Dock-Window Layout in the View menu, and
FEFLOW will come up with the default layout when
starting it the next time. 

PKQ sáÉï=táåÇçïë

View windows contain different views of the model,
possibly along with maps and other visualization fea-
tures. Limited only by the available memory, any num-
ber of windows can be displayed simultaneously to
show different model components (listed in the View
Components panel for the active view). Each view has
its own settings and components handling. 

PKQKN qóéÉë=çÑ=sáÉï=táåÇçïë

FEFLOW has six types of view windows: 
• Supermesh view
• Slice view
• 3D view
• Cross-Section view
• Slice Data-Trace view
• Data-Trace view
New view windows can be opened via the Window

menu. For opening Cross-Section and Slice Data-
Trace views, a 2D surface line has to be selected in the
Spatial Units panel. Opening a Data-Trace view
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requires creating and selecting a 3D line first.

PKQKO k~îáÖ~íáçå

Navigation in view windows is most straightfor-
ward by using the left and right mouse buttons and the
mouse wheel. By default, the left mouse button is used
to pan in Slice views and to rotate in 3D views. Besides
invoking the context menu on a view, the right mouse
button also allows zooming when a navigation tool is
active. In Slice views, the mouse wheel has zooming
functionality, while in 3D views it is used for rotation.
<Shift> on the keyboard in combination with the
mouse wheel changes the directional exaggeration (in y
direction in Slice views and z direction in 3D views). 

Keyboard shortcuts allow to quickly return to the
full view (<Home>), to reset the rotation (<Ctrl>-
<Home>), and to reset the scaling (<Shift>-<Home>).

Additional tools in the View toolbar can also be
used to return to full view, to return to a preferred view
defined via Positioning in the View menu, and to undo/
redo view changes. 

PKR qìíçêá~ä

When FEFLOW is started it opens with an empty
project by default. To create a new model, we click on

New which opens the New FEM Problem dialog.
Here, we need to define the initial work area for mesh
design. This can either be done via a manual input of
the initial domain bounds or with the use of maps that
are loaded in a subsequent step. For a quick start, for
example to set up a simple test model in local coordi-
nates, select Manual input of the initial domain
bounds and accept the default domain bounds with a
click on Finish. The following components are
now visible in the workspace:
• the active view window—the Supermesh view
• the main menu on top
• a number of panels and toolbars
By default, not all panels and toolbars are displayed.

To get familiar with the graphical user interface we
now add a further panel to our workspace. 

Go to View > Panels in the main menu and click
on the entry Plug-ins Panel. The panel now appears at
the bottom right corner of the FEFLOW window. 

Change the panel position by dragging it to a differ-
ent location while holding the left mouse button. Leave
the panel as a separate floating window or dock it at a
certain location. 

Add another panel using a different method. Right-
click on an empty part of the user interface, e.g., in the
grey part above the Inspection panel. A context
menu with the entries Toolbars, Panels, Charts
opens up. Go to Panels and click on Map Proper-

Figure 3.3 The FEFLOW standard layout.
cbcilt=SKO=ö=NV
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PK=qÜÉ=rëÉê=fåíÉêÑ~ÅÉ
ties Panel. The panel now appears in our workspace as
a separate floating item. Dock the panel with a double-
click on its header. The Spatial Units and the

Properties panel are tabbed so that only one is visi-
ble at a time. Click on the tab Properties to bring this
panel to the front. Remove the two panels by clicking
on the closing icon in the upper right corner of the
respective panel. 

Only toolbars relevant to the currently active view
can be shown. Aside from this restriction, toolbar visi-
bility and position are user-controlled. As an exercise,
click on the left border of the Mesh-Editor toolbar
and drag it to a different location, e.g., into the Super-
mesh view. 

To restore the default settings for the graphical user
interface go to View and select Reset Toolbar and
Dock-Window Layout. When FEFLOW is started the
next time, toolbars and panels will be arranged accord-

Figure 3.4 A floating panel and toolbar in the workspace.
ing to the default layout.
To move the Supermesh view outside of the main

window, open its context menu with a click on the right
mouse button and select Floating Window. The
view window can now be moved to an arbitrary posi-
tion on the screen. 

To see the Supermesh view in full-screen mode, hit
<F11>. The full-screen mode is turned off by hitting
<F11> once again.

Figure 3.5 The supermesh view as floating window.
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QKN j~éëÔtÜ~í=cçê\

Maps are an integral part of all but very simple
modeling projects. Their most obvious role is to pro-
vide a basis for convenient orientation in the model
area. FEFLOW, however, makes much wider use of
maps in the modeling workflow. Map geometries can
be used to influence the mesh generation process, they
can serve to geometrically define the target nodes, ele-
ments, edges or faces for parameter assignment, and
attributed maps can even provide the input data them-
selves. 

QKNKN o~ëíÉê= j~éëLj~éë= `çåí~áåJ
áåÖ=a~í~

We have to distinguish between raster maps and
maps which contain data. Data can be provided in the
form of tables or as vector maps if they contain geome-
try information.

Pixel-based raster maps in formats such as tiff, jpeg,
png, or bmp can only provide visual information. Vec-
tor maps contain discrete geometries (points, lines, and
polygons). Formats supported by FEFLOW include
ESRI Shape Files, AutoCAD Exchange Files, DBase
Tables, and several ASCII (text) file formats. In addi-
tion to geometrical information these file formats also
encompass attribute data, i.e., numerical and/or textual
information related to certain geometrical features.
While some formats like shp support an unlimited
number of user-defined attributes, others like dxf only
allow drawing attributes such as color or line style, and
very simple formats such as trp (ASCII triplet format—
XYF) only support one single attribute value.

QKNKO jáÅêçëçÑí= bñÅÉä= tçêâëÜÉÉíë
~åÇ=^ÅÅÉëë=q~ÄäÉë

Tabular data from Microsoft Excel worksheets and
Microsoft Access databases can be imported into
FEFLOW as maps. Export of parameter values and
chart data into Excel and Access is supported as well.
Supported import and export formats include *.xls,
*.xlsx, *.mdb and *.accdb. 

Each Excel worksheet needs to be imported as a
separate map. For workbooks containing multiple
worksheets, the worksheet to be imported is selected
Q
tçêâáåÖ=ïáíÜ=j~éë
Loading and managing different kinds of maps
cbcilt=SKO=ö=ON
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via an import dialog (see Figure 4.1).
The import of tables from MS Access databases

works similarly. After selecting a database, each table
needs to be imported as a separate map via a selection
dialog.

Exported data can either be added as new work-
sheets or tables to an existing Excel workbook or
Access database or they can replace an existing work-
sheet or table.

QKNKP dÉçÇ~í~Ä~ëÉë

Besides the possibility to load separate maps of var-
ious file formats, FEFLOW also provides the option to
connect to different types of geographical databases for
data import via the Maps panel and export via the Data
and View Components panels. 

The following database systems are supported:
• PostGIS 
• Oracle 
• ESRI Geodatabase 

Figure 4.1 Selecting worksheets for import from
a MS Excel workbook.
Connecting to ESRI Geodatabases is only possible
with the 32-bit version of FEFLOW and with an ade-
quate ESRI license.

QKNKPKN a~í~Ä~ëÉ=`çååÉÅíáçå

The connection to a Geodatabase is managed
through a FEFLOW Database Connection File
(*.fedb). The connection file contains all settings for
the connection to a specific geographic database, i.e,
information on the host, port name of the database, user
name and password.

An existing connection file can be opened via
Add Map(s)... in the context menu of the Maps

panel or by clicking on the search icon in the panel.
Creating a new connection file or editing an existing
one is possible via the file-selection dialog evoked via

Add Map or the search option in the Maps
panel. Make sure that the displayed file types in the
file-selection dialog include the format *.fedb. 

As an example, the dialog for creating a connection

Figure 4.2 Adding a database connection.
OO=ö=rëÉê=j~åì~ä
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to a PostGIS database is shown in Figure 4.3.

Depending on the database type, different options
are available when creating a new connection file. For
all details on the available settings, please refer to the
FEFLOW help system.

After the connection to a database, the procedure
differs depending on the type of database.

mçëídfp=~åÇ=lê~ÅäÉ
For PostGIS and Oracle databases, the Open Post-

GIS Table and Open Oracle Table dialogs are opened,
respectively. The upper part of the dialog provides a
summary of the Connection Properties while the lower
part gives access to the data: Existing tables can be
opened or user-defined SQL queries can be used to
derive database data. To obtain geometries from the
database when using SQL queries, a geometry column
needs to be specified in addition. Clicking on Verify in
the dialog checks the SQL syntax and displays the
available columns so that the one containing the geom-
etry information can be selected.

Figure 4.3 Creating a *.fedb file for PostGIS.
 

bpof=dÉçÇ~í~Ä~ëÉë
For ESRI Geodatabases, the standard OpenARC-

GIS Table or Feature Class dialog is brought up after
opening a FEFLOW Database Connection File. Here,
it is possible to select a feature class from the database. 

QKNKQ OaLPa=j~éë

ESRI Shape Files, AutoCAD Exchange Files and
tabular files (dbf, dat) may contain three-dimensional
map information. FEFLOW supports 3D map display
in 3D view windows (Figure 4.5).

Figure 4.4 Open PostGIS Table dialog.
cbcilt=SKO=ö=OP
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Dealing with spatial data requires the definition of a
unique coordinate system as a reference. FEFLOW can
use data in any metric cartesian system, i.e., any system
with orthogonal x and y axes and coordinates in meters.
The most popular of these systems is the UTM coordi-
nate system.

To achieve better precision in the calculations,
FEFLOW always uses a local and a global coordinate
system at the same time. The axes in both systems have
the same orientation, only the origin of the local system
has an offset in global coordinates.

Locations in the local system can be expressed in
cartesian or polar coordinates. The coordinate system
used in a particular view window can be defined in the
View menu. The offset of global and local coordinate
system is defined automatically via map extents or
manually when starting a new model, but can be edited
later on in the Coordinate-System Origin dialog which
is accessed with a click on the Edit Origin button in the
Origin toolbar. In practical cases, it is usually sufficient

Figure 4.5 3D map in 3D view window.
to deal with the global coordinate system. 
In 2D cross-sectional and axisymmetric models the

y coordinate refers to the elevation. In these cases an
offset between local and global coordinates in y should
be avoided so that there is no doubt about the elevation
reference. Internally, FEFLOW uses the local y coordi-
nate as the reference for elevation-dependent parame-
ters, e.g., when converting hydraulic head to pressure
head and vice versa. 



QKP=dÉçêÉÑÉêÉåÅáåÖ=j~éë
Figure 4.6 Global and local coordinates (2D/3D).
QKP dÉçêÉÑÉêÉåÅáåÖ=j~éë

The WGEO software provided with FEFLOW can
add a geographical reference to raster images such as
scanned maps in tiff, jpeg, png or bmp format for use as
maps in FEFLOW. WGEO can also perform coordinate
transformation for raster and vector maps applying a 7-
parameter Helmert transformation routine. 

In Plus mode (separate licensing required), WGEO
also provides functionality for georeferencing of ESRI
Shape Files (shp) and AutoCAD Exchange Files (dxf).
Additional coordinate transformation routines are also
available on demand. 

Please refer to the WGEO manual and its help sys-
tem for a detailed description of the respective work
flows. 

QKQ e~åÇäáåÖ=j~éë

The Maps panel is used to load and manage raster
and vector maps as well as database connections.
Available formats are tif, jpg and png, bmp for raster
maps, and shp, lin, ply, pnt, trp, ano, dxf, smh, dbf, dat,
pow, xml, *.xls, *.xlsx, *.mdb, *.accdb. To open a con-
nection to a geographical database, an *.fedb file needs
to be loaded. In case of tabular data, the columns con-
taining coordinate values have to be chosen at the time
of import, unless they correspond to some defaults like
X, Y and Z. The available supermesh (polygons, lines
and points) of the current model is also displayed as
map data in the panel. 

By default, maps are sorted according to their for-
mat in the Maps panel. For more convenience espe-
cially in large projects, the tree structure can be
customized according to the user’s needs: The order of
folders and maps within a folder can be changed by
cbcilt=SKO=ö=OR
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drag and drop and maps can be moved to different fold-
ers. Existing folders can be renamed by pressing <F2>
or via their context menu and new folders can be cre-
ated via the context menu of the Maps panel or by
clicking on the search icon at the top of the panel.

 The search bar at the top of the Maps panel allows
to filter map and folder names by a full-text search.

The relative map locations and all map settings can
be exported to *.mre (FEFLOW map reference) files
and thus easily be transferred between different
FEFLOW models. Export is available for folders and
maps, while the import option is limited to folders.

j~é=i~óÉêë
While raster maps already contain information

about the display color for each pixel, this is typically
not the case for features in vector maps. The display
information for these kinds of maps is contained in so-
called layers. When loading a map, FEFLOW creates a
layer named Default with just one single style (color,
line style, etc.) applied to all features in the map. The
properties of the default layer can be edited, and addi-
tional layers can be added by using the functions in the
context menu of the layer and the map. All layers of a
specific map can be exported into an *.fml (FEFLOW
map layer) file via the map’s context menu. The map
layer file can then be used to import all layers to the
some or a different map in the same or a different
FEFLOW model.

j~é=mêçéÉêíáÉë
The properties of a map layer can be edited in the

Map Properties panel which is opened via the context
menu of the layer. Basic settings such as opacity, light-
ing options and 3D drawing options can be applied to
all features of the map. The map can be classified based
on one of the attribute fields of the map either by
applying a different style to each unique attribute
value, or by partitioning the overall range of values of a
numeric attribute into a number of classes. Predefined
color palettes are readily available to be applied to the
classes or unique values.

Color and other styles can also be edited manually
for any individual class or for a selection of multiple
classes.

Via the context menu of a map layer, all styles can
be exported into an *.fms (FEFLOW map style) file
and imported again for a specific map layer.

QKR j~é=a~í~=

Vector maps or databases can be applied as a basis
for data assignment or data regionalization, deriving
the basic data directly from the map file. For details on

Figure 4.7 Map Properties panel.
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the assignment of map data, please refer to chapter 10
of this User Manual. 

j~é=q~ÄäÉ
The attribute data of vector maps or database files

can be shown via Show Map Table... in the context
menu of a map. The Map Table dialog will display the
different records and attribute data contained in the
map in tabular format.

j~é=a~í~=pÉäÉÅíáçåLj~é=gçáåáåÖ
Besides using the entire data range provided in a

map, it is possible to use only selected map data. To
limit the data range of a map, SQL selection statements
on attribute data can be used via Join/Select Map(s)
Data... in the context menu of a map.

The option Join/Select Map(s) Data... also provides
the possibility to join additional data tables to a map,
using a common identifier in both tables. 

For tables imported from a geographical database,
the context menu of the table header in the Join Maps
dialog can be used to display the defined relationships
with other tables of the database. Selecting a defined
relationship automatically imports the corresponding
table and relation. 

QKS j~é=bñéçêí

All the model properties and results can be exported
to different kinds of map files, retaining the geographi-
cal reference of the model. 

Export of parameters is invoked via the context
menu of the parameter in the Data panel, or via the
context menu of the parameter in the View Compo-
nents panel. Both export for the entire model domain
and for the selected geometries or the values in the cur-
rent slice/layer only are supported. In a results (*.dac)
file, process-variable results can be exported for the
current time step or for all or a selection of time steps. 

Visualization options such as isolines or fringes can
be exported to a map file via the context menu of the
visualization style in the View Components panel. 

Exported maps can automatically be loaded to the
Exported Maps section within the Maps panel of the
current FEFLOW model. 

nìáÅâ=m~ê~ãÉíÉê=fãéçêí
The Quick Import option can be used to assign data

of a previously exported map to several parameters at
once without the need for defining parameter links via
the Parameter Association dialog first. The import can
be limited to specific model parameters and/or to the
current slice/layer or the current selection. To match
the input data to the mesh elements or nodes, different
selections methods are available. A detailed description
of this import option and a tutorial are provided in
chapter 10. 

QKT qìíçêá~ä

In the following exercises we want to get familiar
with the handling of maps in the FEFLOW workspace.
The most important tool in this context is the Maps
panel which is used to load and manage maps. 

As a first exercise, we load a number of maps of dif-
ferent formats that could be used to set up a supermesh.

Start with an empty FEFLOW project. In the New
FEM Problem dialog choose the second option and
click on Finish. In the import + export folder,
select the file SimulationArea.jpg that is used as a
background map for orientation. The map now appears
as Geo-JPEG in the Maps panel. Double-click on
cbcilt=SKO=ö=OT
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this entry to add the map to the active view. 
Next, load some further maps that contain informa-

tion on the model site. Click on the search icon in
the Maps panel and choose Add Map(s)....
Select the files

•  demo_wells.pnt
•  model_area.shp
•  rivers.shp
•  sewage_treatment.shp
•  waste_disposal.shp
 We can either load the maps one by one or import

them all at once by pressing the <Ctrl> key while we
select the maps.

Depending on the respective file formats, the maps
now appear in different tree branches in the Maps
panel, together with a Default (layer) entry that
FEFLOW creates automatically. Add all maps to the
active view with a double-click on their Default entry.

Maps that have been added to the active view also
appear in the View Components panel. Here, maps
can be switched on and off temporarily via the check
boxes. Their drawing order follows the tree structure of

Figure 4.8 Maps panel.
the Maps panel but it can be changed by dragging
maps with the mouse cursor to another position within
the folder or by dragging entire folders to a different
position within the tree. If not all of the loaded maps
are visible in the Supermesh view change their order in
the View Components panel to bring maps covered
by others to the surface.

We change the sorting within the Maps panel by
creating new folders and moving several maps to a dif-
ferent folder location.

Click on the search icon at the top of the
Maps panel and select Create Folder. Enter
Contamination sources as a new name and hit

<Enter>. The new folder now appears as the first entry
after the Supermesh maps. Select both the
sewage_treatment and waste_disposal maps while
keeping the <Ctrl> key pressed and move the maps to
the new folder via drag and drop. Next, click on ESRI
Shape Files, press <F2> and rename the folder to

Model geometry. Move the map demo_wells to
this renamed folder and then delete the now empty
folder ACII Point Files by clicking on it and hitting

Figure 4.9 Maps displayed in the active view.
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<Del>. Confirm the deletion with Yes.
To store all settings of the Maps panel in a map-

reference file, click on the search icon and select
Export Map Reference(s).... Enter maps as

name for the *.mre file and confirm with <Enter>. Now
delete all loaded maps via Remove All Maps in the
context menu of the panel. After confirming with Yes,
the maps are removed from the Supermesh view and
the Maps and View Components panels.

The maps and all settings can now easily be
imported again via the previously exported map-refer-
ence file. Select Import Map Reference(s)... from
the context menu of the Maps panel and load the
file maps.mre. The maps and our user-defined folder
structure are now automatically reimported. Double-
click on each of the default entries again to display the
vector maps in the active view.

QKTKN j~é=i~óÉêë

The map model_area defines the outer boundary of
the model area. To change the style of the Default layer
of this map make a right-click on Default in the

Maps panel and select Edit Properties from the
context menu. In the upper part of the Map Proper-
ties panel that now opens click on <All Values> and go
to Polygon Attributes. Change the fill color of the
polygon and also the outline style. Confirm the new
settings with the Apply Changes button and close
the panel. 

For the next map sewage_treatment we create a
new layer besides the already existing default layer.
Open the context menu of this map with a right-click
and select Create Layer. A new entry Layer 1 is
now added to the tree of this map. Open the Map
Properties panel for this layer as previously described
and click again on <All Values>. Change the fill color
and the outline style of the polygon and also the opac-
ity and confirm the settings with a click on Apply
Changes before closing the panel. 

Double-click on Layer 1 in the Maps panel to
add this layer to the active view. You can switch
between different layers of a map using the check
boxes in front of these layers in the View Compo-
nents panel. The last one activated is always the upper-
most layer. Figure Figure 4.9 gives an example for a
certain style of the imported maps.

The remaining maps that we have loaded contain
spatial information on rivers and wells, i.e., line and
point structures. To enhance the appearance of the riv-
ers in the active view we change width and color of the
line, again using the Map Properties panel for the
Default layer of the map rivers.

For the map demo_wells the style settings of the
markers and for the labels can be edited separately. 

QKTKO j~é=a~í~

Instead of showing both rivers contained in the map
rivers, we only want to plot the eastern one. To do so,
we use a SQL selection statement on the attribute field
NAME of the map to create a data selection that is lim-
ited to the river in the east.

Open the context menu of the map rivers with a
right-click on the map and select Show Map
Table... to display the attribute data of the map in tabu-
lar format (see Figure 4.10). For the attribute field
NAME two different data sets exist, River West and
River East. Close the Map Table dialog and now
choose Join/Select Map(s) Data... to open the Join
Maps dialog. In the input field of Select record where
enter NAME=”River East” as SQL selection statement
cbcilt=SKO=ö=OV
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to select the map data for the eastern river only. Make
sure to enter the name with a capital R and E as the
SQL syntax is case sensitive.

 To ensure that the syntax is correct click on
Preview. The map table now only shows one

record for the River East and reflects a reduced data
selection according to the SQL statement. Leave the
Map Table dialog with Close and the Join Maps
dialog with OK. The active view now also reflects
the reduced map data set by only displaying the eastern
river.

Figure 4.10 Map Table dialog for the map rivers.

Figure 4.11 Map Rivers after Select Map(s)
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The so-called Supermesh in FEFLOW forms the
framework for the generation of a finite-element mesh.
It contains all the basic geometrical information the
mesh generation algorithm needs. 

While in the very simplest case the Supermesh only
defines the outline of the model area, i.e., consists of
one single polygon, the concept offers many more pos-
sibilities: Supermeshes can be composed of an arbi-
trary number of polygons, lines and points. Their
respective features and purposes are described in the
following sections. 

RKNKN pìéÉêãÉëÜ=mçäóÖçåë

A subdivision of the model area into a number of
separate polygons can be useful for a number of rea-
sons:

• Finite-Element edges will honor the polygon
boundaries, allowing for example an exact zoning
of parameters and setting of boundary conditions
in exact locations later.
• The required density of the finite-element mesh
can be specified for each polygon.

• The polygons can be used for parameter assign-
ment and results evaluation later. 

RKNKO pìéÉêãÉëÜ=iáåÉë

Lines in the Supermesh are applied to represent lin-
ear structures in the finite-element mesh to be created.
Their advantages include:

• Finite-element edges will honor the line, provid-
ing for example the basis for later applying the
boundary condition for a river exactly along the
river axis. 

• The mesh may be automatically refined during
mesh generation along the line.

• The lines can be used for parameter assignment
and results evaluation later.

RKNKP pìéÉêãÉëÜ=mçáåíë

Points in the Supermesh are typically placed in the
locations of production or injection wells or in observa-
tion locations. They make sure that a finite-element
node is set at exactly this location during mesh genera-
R
pìéÉêãÉëÜ=aÉëáÖå
Setting up the framework for mesh generation
cbcilt=SKO=ö=PN
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tion, they allow a local mesh refinement around the
point, and they can be used for parameter assignment,
e.g., to set the boundary condition for a pumping well.

RKO bÇáíáåÖ= pìéÉêãÉëÜ= cÉ~J
íìêÉë

Sets of polygons have to fulfil some requirements: 
• No overlapping polygons are allowed.
• No polygons can be entirely contained by another

polygon. 
The user-interface tools ensure that these require-

ments are met at any time. Internal holes in the super-
mesh are possible. They are indicated by another color
for the internal boundary (Figure 5.2).

Figure 5.1 Example for a Supermesh detail.
The Mesh-Editor toolbar provides the tools to digi-
tize and edit Supermesh polygons, lines, and points. 

In Move Node mode, both the originally digitized
nodes and smaller nodes in between can be moved.
Moving the small nodes results in curved polygon
edges (parabolic or circular shape) that are typically
applied to curved structures such as borehole edges or
pipe walls in small-scale models.

When digitizing a polygon next to an existing one,
the editor will automatically follow the existing poly-
gon boundary to close the new polygon (Figure 5.3). 

Figure 5.2 Inner Supermesh border.

Figure 5.3 Follow existing boundaries.
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Instead of digitizing Supermesh features on screen,
they can be imported from background maps. This is
done via the Convert to Supermesh entry in the context
menu on the name of the map file in the Maps panel. 

All features of the map (or all selected features
when applying an SQL selection query on the map) are
converted to supermesh features using this approach.
Polygons that would overlap with already existing
polygons are not converted.

RKQ bñéçêí= çÑ= pìéÉêãÉëÜ
cÉ~íìêÉë

Once a finite-element mesh has been generated, all
Supermesh features (points, lines, polygons) are dis-
played in the Maps panel. The export of Supermesh
features as maps is available via the context menu of
the Supermesh entry or of the respective Supermesh
features in the Maps panel. 

RKR qìíçêá~ä

RKRKN qççäë

All of the tools that are used in this exercise are
located in the Mesh-Editor toolbar.

Figure 5.4 Mesh-Editor toolbar.
RKRKO mçäóÖçåëI=iáåÉë=~åÇ=mçáåíë

To get some hands-on training in supermesh design
we design a first supermesh that consists of a single
polygon. 

Open an empty FEFLOW project with a click on
New and specify the initial mesh extent to define

the initial area for mesh design. In the New FEM Prob-
lem dialog choose Manual input of the initial
domain bounds and accept the default extent with

Finish. The domain bounds have now been set to
100 m x 100 m. 

Now, click on Add Polygons in the Mesh-
Editor toolbar in the upper left of the window. Set
polygon nodes with a left-click in the Supermesh view
window and finish by clicking on the first node of the
polygon again. The finished polygon appears shaded in
grey.

Now, add a second polygon that adjoins the first
one. Pay attention to how the mouse cursor symbol
changes depending on its position in the Supermesh
view: The cross-hairs cursor indicating that polygon
nodes can be set only appears outside the existing poly-
gon. This makes sure that only non-overlapping poly-
gons are created. Clicking inside the polygon
FEFLOW does not create a new node. Place the first
node of the new polygon on the edge of the existing
polygon, continue with some more nodes and set a last
node on the polygon edge again. To finish the polygon,
use the autoclose function by double-clicking on the
last node. FEFLOW now automatically closes the poly-
gon along the existing polygon edge.
cbcilt=SKO=ö=PP
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 Also, add some line and point features to the super-
mesh, using the Add Lines and Add Points
tool. Finish a line with a double-click on the last node. 

The polygons that we have created can be merged
with the Join Polygons option. First, both poly-
gons need to be selected. Activate the Select in
Rectangular Region tool in the Mesh-Editor
toolbar and click into both polygons while holding
<Ctrl>. The selected polygons are now highlighted in
turquoise. Now the Join Polygons button in the

Mesh-Editor toolbar is activated. Click this but-
ton to merge the two polygons.

Polygons, lines and points that have been misplaced
can also be deleted. Activate one of the selection tools
available in the drop-down list that opens with a click
on the small arrow next to Select in Rectangular
Region. Click on the merged polygon (if it is not still
selected). Then simply press the <Del> key to remove
the polygon. You may try the same with one or several
of the lines or points.

Figure 5.5 A finished polygon in the Supermesh view.
RKRKP qÜÉ=máå=`ççêÇáå~íÉë=qççäÄ~ê

Polygon nodes can also be positioned exactly. In the
next step, we design a square polygon with the dimen-
sions of 100 m x 100 m. First, select all remaining
polygons, lines and points and press <Del> to delete
them. Next, click Add Polygons and press <F2>.
The Pin Coordinates toolbar appears. Insert

0,0 to set the first node and press <Enter>. In the
same way, enter the coordinates of the remaining three
nodes of the polygon. To finish the polygon, enter the
coordinates of the first node again or simply click on it. 

 If one or several nodes are misplaced while a line
or a polygon is drawn, the last node(s) can be deleted
by clicking on a previous node of the same line or poly-
gon.

Figure 5.6 Polygons selected for joining.
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In the next step we do not design a supermesh man-
ually on screen but import the supermesh features from
a map. Start an empty FEFLOW project and in the New
FEM Problem dialog, select the second option to
define the initial work area via imported maps. Click
on Finish and in the file selection box select the
files 

• demo_wells.shp
• model_area.shp
• sewage_treatment.shp
• waste_disposal.shp.

These maps are now displayed under ESRI Shape
Files in the Maps panel. Double-click on the entry

Figure 5.7 Using the Pin Coordinates toolbar.
Default of each map to make all of them visible in the
Supermesh view. Figure 5.8 shows the loaded maps in
the Supermesh view. 

First we want to create a polygon that describes the
total model area. We import this polygon from the map
model_area. Open the context menu of this map with a
right-click and select Convert to > Supermesh
Polygons. When we click on the Add Polygons
button in the Mesh-Editor toolbar, the imported
polygon becomes visible.

In addition to this polygon we want to include two
well locations as points in our supermesh. The work-
flow to import these points is completely analogous to
the polygon import. The map demo_wells contains the
well locations. Right-click on this map to open its con-
text menu and select Convert to > Supermesh
Points. The two well locations are now visible as red
points in the Supermesh view.

As a last step we want to include the two contami-

Figure 5.8 Maps displayed in the Supermesh view.
cbcilt=SKO=ö=PR
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nation sites in the supermesh. These cannot be
imported from a map via the Convert to option as
this would lead to overlapping polygons. Instead, we
will split the existing polygon and cut out the contami-
nation sources. Start with the eastern source of contam-
ination. Click on Split Polygons and select the map
waste_disposal from the dropdown list in the

Mesh-Editor toolbar. To digitize the contamina-
tion source accurately we can use a tool that snaps to
the fixed points of this map. To activate the snapping
click on Snap to Points right next to the dropdown
list. 

Polygon splitting must start and end at an already
existing polygon border. As the contamination sources
are located completely inside the model area two cuts
are necessary. Start on an arbitrary point on the model
boundary and go halfway around the contamination
source. To complete the first cut, return to the model
boundary on the other side (see figure 5.9). Complete
the polygon with a second cut along the missing parts
of the contamination source polygon.

Figure 5.9 Polygon splitting along contamination site.
Complete the supermesh by creating the polygon
for the second contamination source in the same way,
this time selecting sewage_treatment from the drop-
down list in the Mesh-Editor toolbar. 

An exemplary finished supermesh setup is shown in
figure 5.10.

Figure 5.10 Completed supermesh.
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This section describes the generation of finite-ele-
ment meshes. During the simulation, results are com-
puted on each active node of the finite-element mesh
and interpolated within the finite elements. The denser
the mesh the better the numerical accuracy, and the
higher the computational effort. Numerical difficulties
can arise during the simulation if the mesh contains too
many highly distorted elements. Thus some attention
should be given to the proper design of the finite-ele-
ment mesh. For transport simulations, the Péclet crite-
rion can be useful for determining the required mesh
density. The Péclet Number is available as elemental
distribution in Auxiliary Data in the Spatial Units
panel. To assist in creating a well-shaped mesh,
FEFLOW offers various tools, including local refine-
ment and derefinement of the mesh and (selective)
mesh smoothing. Local refinement during mesh gener-
ation will typically lead to a better mesh quality than
later subdivision of elements.
 

SKO jÉëÜ= dÉåÉê~íáçå= mêçJ
ÅÉëë

FEFLOW supports either triangular or quadrangular
finite-element meshes. A separate toolbar is available
to support the mesh generation process. The generation
is generally based on the input of an approximate num-
ber of finite elements to be generated. The desired
mesh density of each supermesh polygon can be edited
separately.

Different algorithms for the mesh generation are

Figure 6.1 Examples for bad and good mesh geometry.
S
cáåáíÉJbäÉãÉåí=jÉëÜ
Obtaining a suitable spatial discretization of the model domain
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provided, all of them with their specific options and
properties. Some algorithms can consider also lines and
points in the supermesh and allow a local mesh refine-
ment at polygon edges, lines and points. 

Mesh generation is typically a trial-and-error pro-
cess. The user hereby iteratively optimizes element
numbers, generator property settings and—if neces-
sary—the supermesh until a satisfactory mesh is
obtained.

Significant effort can be involved in mesh genera-
tion, especially in cases with a large number of geomet-
rical constraints (many polygons, lines and points). In
typical cases, however, the effort required for generat-
ing a good finite-element mesh saves time at later
stages of the modeling process due to reduced risk of
instabilities. 

SKP jÉëÜ= dÉåÉê~íáçå= ^äÖçJ
êáíÜãë

There are many different strategies for the discreti-
zation of complex domains into triangles or quad ele-
ments. As each has its specific advantages and
disadvantages, FEFLOW supports three different algo-
rithms for triangulation and one for quad meshing. 

SKPKN ^Çî~åÅáåÖ=cêçåí

Advancing Front is a relatively simple triangular
meshing algorithm that does not support any lines or
points in the supermesh. If present, they are simply
ignored in the generation process. Its main advantages
are its speed and its ability to produce very regularly
shaped elements. 
SKPKO dêáÇ_ìáäÇÉê

GridBuilder—developed by Rob McLaren at the
University of Waterloo, Canada—is a flexible triangu-
lation algorithm. GridBuilder supports polygons, lines
and points in the supermesh as well as mesh refinement
at points, lines, or supermesh polygon edges.

SKPKP qêá~åÖäÉ

Triangle is a triangulation code developed by Jona-
than Shewchuk at UC Berkeley, USA. It is extremely
fast, supports very complex combinations of polygons,
lines and points in the supermesh, allows a minimum
angle to be specified for all finite elements to be cre-
ated, and provides the means for local mesh refinement
with a maximum element size at lines or points of the
supermesh. 

FEFLOW provides a convenient interface to Trian-
gle, which can be freely downloaded from the devel-
oper’s website. Please refer to the FEFLOW help
system for a detailed description of the process to
enable Triangle in FEFLOW. Free use of Triangle is
based on conditions defined in a usage agreement
available in the FEFLOW help system and from the
Triangle website. 

SKPKQ qê~åëéçêí=j~ééáåÖ

Transport Mapping is the algorithm used in
FEFLOW for generating meshes of quadrilateral ele-
ments. This option requires that the quad meshing
option in the Mesh menu is selected and that all super-
mesh polygons have exactly four nodes. 

Lines and points in the supermesh are ignored when
generating quadrilateral meshes. 
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The finite-element mesh geometry cannot only be
generated from scratch, but it can also be imported
from maps via Import Mesh... in the File menu. This is
especially useful if the area of an existing model has to
be extended and the user does not wish to start over
with a completely new model. 

It is possible to import an arbitrary number of maps
and to combine them to a new 2D finite-element mesh.
All maps have to contain either triangular or quadrilat-
eral elements, a mixed geometry is not possible. Fur-
thermore, polygons in the imported maps must not
overlap, and nodes at common boundaries have to be
identical in number and location.

SKR jÉëÜ=bÇáíáåÖ

Some specific modifications of the finite-element
mesh are possible at any time after mesh generation,
even after model parameterization:

• Mesh refinement by element subdivision
• Mesh derefinement (after previous refinement)
• Splitting of quad elements into triangles
• Smoothing of the mesh at selected node locations

or of the entire mesh
• Flipping element edges
• Moving nodes within the area of the surrounding

elements
All the mesh-editing functionality is contained in

the Mesh-Geometry toolbar. 

SKS jÉëÜJmêçéÉêíó=`ÜÉÅâ

FEFLOW provides some basic tools to check the
properties of a finite-element mesh, which are accessi-
ble via Auxiliary Data in the Data panel. The follow-
ing parameter distributions can be shown in the
currently active view:

• Max. interior angle of triangles 
• Delaunay criterion violations
For 3D models, two additional distributions are

available:
• Slice distance
• Layer thickness.
For transport models, FEFLOW provides an addi-

tional distribution which is calculated and updated at
each time step during the simulation:

• Péclet Number.
Distances and areas in Slice and Supermesh views

and distances in 3D views can be measured using the
Measure tool. If the Supermesh is the active view, the
Measure tool is located in the Mesh-Editor toolbar.
For active Slice views, the tool is accessible via the
Inspection toolbar.

SKT jÉëÜJbäÉãÉåí=aÉ~Åíáî~J
íáçå

By default all mesh elements are active and results
are computed at each mesh node. Using the In-/active
Elements parameter in the Geometry section of the
Data panel, elements can be deactivated for the entire
simulation period or only for specific time steps during
a simulation run. In case that all elements surrounding
a mesh node are inactive, FEFLOW does not compute
results at these specific node locations. 

With this option, time-varying geometries as well as
impermeable structures can easily be simulated.

In 3D models, the parameter In/outflow on top/bot-
tom is applied to the first set of active elements if ele-
ments within the top layer are set to inactive. This
cbcilt=SKO=ö=PV
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ensures that assigned recharge or evapotranspiration
values are passed on to deeper locations of the model
domain correctly.

SKU Pa=aáëÅêÉíáò~íáçå

For 3D models, FEFLOW applies a layer-based
approach. The triangular or quadrangular mesh is
extended to the third dimension by extruding the 2D
mesh, resulting in prismatic 3D elements. In FEFLOW
terminology, all (typically) horizontally adjacent 3D
elements comprise one layer, while a slice is either the
interface between two (typically) vertically adjacent
layers or the top or bottom of the model domain. All
mesh nodes are located on slices.

The extension of a 2D model to a 3D model is facil-
itated by the 3D Layer Configuration dialog that is
accessed via the Edit menu. Initially defined layers are
plane. Real elevations are assigned like a process vari-
able for each node as discussed in chapter 10. 

All the layers in 3D models have to be continuous
over the entire model domain. Thus model layers repre-
senting lenses or pinching-out stratigraphic layers have
to be continued to the model boundary. Typically, they
are then assigned a small thickness and the properties
of the layer immediately above or below. 

3D model setup is in most cases based on a vertical
extension of a horizontal mesh. For applications such
as modeling of dams where a high level of detail is
needed vertically, but less along the horizontal axis, the
mesh can be generated in vertical projection and
extended horizontally. In the latter case, the y axis in
FEFLOW points in the direction opposite to gravity,
similar to a 2D cross-sectional model.

The 3D Layer Configuration dialog also provides
tools to add or remove layers from existing models, and
to change layer thicknesses globally. The Validate
option allows to verify slice elevations with respect to a
certain minimum slice distance. Model properties of
new layers can be conveniently inherited from already
existing layers.

SKV dÉçíê~åëÑçêã~íáçå

FEFLOW expects all attached maps and the model
itself to share the same coordinate system. Maps using
differing coordinate systems can be transformed in

Figure 6.2 Horizontal and vertical layering approaches.
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advance using the external software WGEO, which is
part of the FEFLOW software package.

In case that a geotransformation of the model itself
is necessary, the Geographic Transformation option in
the Mesh-Geometry toolbar can be used.

SKNM qìíçêá~ä

SKNMKN qççäë

All of the tools used in these exercises are located in
the Mesh-Generator toolbar 

and in the Mesh-Geometry toolbar. 

Some mesh-editing options also require the tools of
the Selection toolbar. 

The first drop-down list in the toolbar gives access
to the available selection tools. The third drop-down
list allows to switch between different target geome-
tries (nodes, elements, edges, faces) for selections.

Figure 6.3 Mesh-Generator toolbar.

Figure 6.4 Mesh-Geometry toolbar.

Figure 6.5 Selection toolbar.
SKNMKO jÉëÜ=dÉåÉê~íáçå

SKNMKOKN qêá~åÖìä~íáçå

To get some hands-on experience in how the avail-
able mesh-generator algorithms work we apply the
three different mesh generators on the same supermesh
and study the resulting finite-element meshes.

First, click on Open to load the supermesh file
mesh.smh from the supermsh folder. This supermesh
consists of two polygons, one line and three point fea-
tures. 

Start with the Advancing Front algorithm which
can be selected from the generator list of the

Mesh-Generator toolbar.
Enter a Total Number of 2000 elements in the

input field and click on Generate Mesh to start the
mesh-generation process. A new window, the Slice

Figure 6.6 Supermesh.
cbcilt=SKO=ö=QN
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view, opens with the resulting finite-element mesh. 
As figure 6.7 shows, Advancing Front ignores the

line and point features which are included in the super-
mesh.

Now, use the same supermesh to generate a finite-
element mesh with the GridBuilder algorithm. Click in
the Supermesh view to make the Mesh-Genera-
tor toolbar visible again and select GridBuilder. With-
out any further changes simply click on Generate
Mesh.

The resulting finite-element mesh looks similar to
the one created with the Advancing Front algorithm,
except that polygon edges, lines and points are now
honored by the mesh.

As a next step, we will refine the mesh around the
point and line features. First, activate the Supermesh
view with a click. The refinement settings are located
in the Generator Properties dialog in the

Mesh-Generator toolbar.

Open the dialog and activate a refinement for all
three geometrical features. For polygon edges, choose
a refinement level of 5, for lines a level of 8, and for
points a gradation of 10. Make sure that the option
Apply to SELECTED polygon edges or line segments

Figure 6.7 Advancing Front and GridBuilder.
is activated before you leave the dialog. 
To select the elements to be refined go back to the

Supermesh view and click on Refinement Selec-
tion. Click on all segments of the line and of the edge
that separates the two polygons. The selected edges are
shown in green. Then click on Generate Mesh
again. The resulting finite-element mesh with local
refinement is shown in figure 6.7.

 Next, we will apply the Triangle algorithm to gen-
erate a finite-element mesh. 

Choose Triangle from the generator list in the
Mesh-Generator toolbar. Open the Generator

Properties dialog and activate refinement for polygon
edges, line and point elements with the following set-
tings: 

Refinement around SELECTED polygon edges
• Polygons: gradation: 5, target element size: 1.0 m
• Lines:       gradation: 3, target element size: 0.5 m
• Points:      gradation: 3, target element size: 0.5 m
• Leave the dialog and use the Refinement

Selection tool to select the edge between the two
polygons in the Supermesh view. Clicking on

Generate Mesh should now produce a finite-
element mesh that looks similar to the one on the
left in figure 6.8.

pÉé~ê~íÉ=bÇáíáåÖ=çÑ=mçäóÖçåë
For every supermesh polygon the mesh density can

be defined separately while the total number of ele-
ments remains constant. Go to the Supermesh view
and activate the tool Edit Meshing Density in the

Mesh-Generator toolbar. FEFLOW now automat-
ically selects a polygon for which a meshing-density
factor can be specified. Start with the proposed poly-
gon and enter a factor of 10. After hitting <Enter>
the number in the input field turns red, indicating that
qÜÉ= qêá~åÖäÉ= ãÉëÜ
ÖÉåÉê~íçê= ÉåÖáåÉ= áë
åçí= éêçîáÇÉÇ= ïáíÜ

cbcilt>= cçê= ÇÉí~áäë= ~Äçìí
Üçï= íç= çÄí~áå= íÜÉ= qêá~åÖäÉ
ãÉëÜ= ÖÉåÉê~íçêI= ëÉÉ= íÜÉ
cbcilt=ÜÉäé=ëóëíÉãK
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the meshing density for this polygon has been modi-
fied. Proceed with the second polygon. Select it with a
single click and enter a density factor of 2 in the
input field. Hit <Enter> again and start the mesh gener-
ation with a click on Generate Mesh. The right
mesh in figure 6.8 shows the resulting finite-element
mesh. To reset the meshing density factors to the
default value of 1, click on Reset Meshing Density.

SKNMKOKO nì~Ç=jÉëÜáåÖ

A finite-element mesh with quadrilateral elements
can be generated using the Transport Mapping algo-
rithm. 

We load a new file which is similar to the one used
for the triangulation exercises, except this supermesh
consists of only one polygon that has exactly four
nodes. Click on Open and load the file quad-
mesh.smh. Transport Mapping requires supermesh
polygons with exactly four nodes. Lines and points are
ignored in the mesh-generation process. 

To enable the quad meshing option go to Mesh
and activate Quadrilateral Mode. Select Transport

Figure 6.8 Meshes generated with the Triangle algorithm. 
Mapping in the Mesh-Generator toolbar, enter a
Total Number of 2000 elements and click on

Generate Mesh to start the meshing process.
The resulting finite-element mesh is shown in figure

6.9. 

SKNMKP bÇáíáåÖ=íÜÉ=jÉëÜ=dÉçãÉíêó

SKNMKPKN qêá~åÖìä~ê=jÉëÜÉë

For this exercise load the file triangle.fem. 
The geometry of the finite-element mesh can be

edited after the mesh-generation process has been fin-
ished. All the necessary tools are located in the

Mesh-Geometry toolbar. 
 It is possible to refine the mesh globally (entire

mesh) or locally (only selected parts). A derefinement
option for previously refined parts of the mesh is also
available. 

If we want to apply local mesh refinement we have
to select a target area first. Make sure that the Slice
view is the active view. All necessary selection tools

Figure 6.9 Quad mesh. 
cbcilt=SKO=ö=QP
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can be found in the Selection toolbar. To create an
element-based selection choose Select Elements
from the drop-down list of target geometries. Then,
activate Select in Rectangular Region tool from
the drop-down list of selection tools to draw a rectangle
around the line feature. 

Now click on Refine Elements in the
Mesh-Geometry toolbar. Each selected element is

subdivided into four elements. The result is shown in
figure 6.10.

The derefinement tool is used similarly; however,
only those parts that were previously refined can be
derefined. 

Elements can also be deleted from the finite-ele-
ment mesh. Select a couple of elements and click on

Delete Elements to cut out these elements. On the
right hand side of figure 6.10 a (purely illustrative)
example for a mesh with deleted elements is shown.

To deactivate elements during the simulation we use
the parameter In-/active Elements in the Geometry
section of the Data panel. Double click on In-/
active Elements to set this parameter active and use the
tool Select in Rectangular Region to create an ele-
ment selection. Make sure that the input field of the

Figure 6.10 Refinement and deleted elements.
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Editor toolbar shows the setting inactive and click
on Assign to set the selected elements to inactive.
The result is shown in figure 6.11. 

Mesh smoothing can produce more regularly
shaped elements and reduce the number of obtuse-
angled triangles. To use the Smooth Mesh tool in
the Mesh-Geometry toolbar, the nodes which are
allowed to be moved during the smoothing process
have to be selected first. Activate Select Nodes in
the Selection toolbar and draw again a rectangle
around the line feature. Click on the Smooth Mesh
tool that is now active and clear the selection with a
click on Clear Selection. Figure 6.12 shows the
selected mesh location before and after the smoothing.

Figure 6.11 Active and inactive mesh elements.
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To check for obtuse angles and triangles violating
the Delaunay criterion, we use the tools provided in
Auxiliary Data in the Data panel. First, double-
click on Max. interior angle of triangles to show
obtuse-angled triangles in the active view. Pay atten-
tion to how the angle distribution changes when we
click on Undo in the Standard toolbar to
return to the unsmoothed mesh. Next, double-click on
Delaunay criterion violations and then click on

Redo in the Standard toolbar to return to the
smoothed mesh again. Both distributions indicate that
the mesh smoothing has significantly improved the
mesh quality.

Use the Move Node tool in the Mesh-
Geometry toolbar and drag a mesh node to change its
position within the mesh. Also, use Flip Edge and
click on an element edge to change the subdivision of
two adjacent triangles. Edge flipping will freeze the
mesh so that derefinement of previously refined areas
will no longer be possible.

Figure 6.12 Mesh before and after smoothing.
SKNMKPKO nì~Ç=jÉëÜÉë

Click on Open to load the file quadmesh.fem
for this exercise. 

Except for the derefinement and the flip edge tool
all editing options are also available for quad meshes. 

As an additional option, quad meshes can be trans-
formed into triangular meshes. Four different triangu-
larization methods are available of which we will use
one. Select the method Four Triangles around
Center from the drop-down list in the Mesh-
Geometry toolbar to subdivide every quad element into
four triangular elements. The resulting finite-element
mesh is shown in figure 6.13. 

Figure 6.13 Refined quadmesh. 
cbcilt=SKO=ö=QR
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After the model has been discretized in 2D we now
extend it to a 3D model. Click on Open and load
the file triangle.fem for this exercise.

To perform the extension to a 3D model, go to the
Edit menu and open the 3D Layer Configuration

dialog. The table on the left displays the number of
slices and layers, and also the elevation of each slice. 

The 3D model shall consist of 3 slices and 2 layers
and the top slice shall be located at an elevation of 5 m.

To set the elevation of the top slice, enter 5 in
the Elevation input field and hit <Enter>. Increase the
number of slices to 3 and hit <Enter>.

The table now shows 3 slices with elevations of 5
m, 4 m and 3 m (see Figure 6.14). 

Click on OK to apply the settings and to leave
the dialog.

A new view window, the 3D view, now automati-
cally opens, displaying the model in 3D. The in-slice
spatial discretization in plan view remains the same but

Figure 6.14 3D Layer Configurator. 
the previously 2D finite elements have now been
extended to 3D prismatic elements.

Figure 6.15 The model in 3D view.
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TKNKN mÜóëáÅ~ä=mêçÅÉëëÉë

FEFLOW allows the simulation of flow, groundwa-
ter age, mass- and heat-transport processes in either
saturated, or in variably saturated media. The basic set-
tings defining the simulated processes are done in the
Problem Settings dialog that is accessed via the Edit
menu.

p~íìê~íÉÇ=L=råë~íìê~íÉÇ
Saturated groundwater flow is described by the

equation of continuity with a Darcy flux law. Different
options for handling a phreatic surface are described in
chapter 7.1.5. 

For unsaturated/variably saturated flow, FEFLOW
solves Richards’ equation that assumes a stagnant air
phase that is at atmospheric pressure everywhere. Sub-
stantial computational effort can result from the typi-
cally nonlinear relationships between capillary pressure
and saturation and between saturation and hydraulic
conductivity. 
FEFLOW provides two different options to define
these relationships:

• Spline Models
• Empirical Models. 
 Spline Models are used to derive the parametric

relationships from tabular data using one of several dif-
ferent spline interpolation techniques. 

Alternatively, the following six Empirical Models
are available:

• Van Genuchten
• Modified Van Genuchten
• Brooks & Corey
• Haverkamp
• Exponential
• Linear.
As the FEFLOW implementation of Richards’

equation also includes the proper terms for saturated
flow, it is generally applicable to variably saturated
conditions.
T
mêçÄäÉã=pÉííáåÖë
Defining the modeling approach
cbcilt=SKO=ö=QT
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A transport simulation is always performed in con-

junction with a flow simulation. FEFLOW provides
capabilities for single-species and multispecies solute-
transport simulation, groundwater-age simulation with
the possible species age, lifetime expectancy and exit
probability as well as heat-transport simulation. A
combined mass-and-heat (“thermohaline”) transport
problem can be simulated, also together with ground-
water age.

A detailed discussion of the application and avail-
able settings for groundwater-age simulations, can be
found in chapter 14.

píÉ~Çó=pí~íÉ=L=qê~åëáÉåí
Transient simulations proceed from an initial condi-

tion and cover a specified time period. In contrast, a

Figure 7.1 Problem Settings dialog.
steady-state solution can be obtained directly and rep-
resents the state of a system having been subject to
fixed boundary conditions and material properties for
an infinitely long time. It is possible to combine a
steady-state flow with a transient transport simulation.
In such a case, the flow system is solved once at the
beginning with all storage terms set to zero to obtain a
steady-state solution as the basis for the transient trans-
port calculation.   

TKNKO aáãÉåëáçå=~åÇ=mêçàÉÅíáçåë

FEFLOW supports 2D and 3D models. Finite ele-
ments of a lower dimension (1D in 2D models, 1D/2D
in 3D models), so-called discrete features can be
added, representing for example fractures or boreholes. 

Oa=jçÇÉäë
A newly generated finite-element mesh always rep-

resents a 2D model. Two-dimensional models can be of
horizontal, vertical, or axisymmetric projection.

A typical application for horizontal 2D models are
regional water-management models without significant
vertical flow components. Vertical models are used, for
example, for the simulation of unsaturated flow and
saltwater intrusion. Axisymmetric models have a radial
symmetry such as the cone of a pumping or injection
well. Essential for the suitability of an axisymmetric
model are material properties and outer boundary con-
ditions that are homogeneous along the circumference
of the well cone or mound. 
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3D models can be created by expanding the mesh in

the third direction into layers via the 3D Layer Config-
uration dialog which is accessed via the Edit menu or
via <Ctrl>+<L>. As all layers have an identical 2D dis-
cretization, the 3D mesh consists of prismatic or cuboid
elements and each layer extends over the entire model
domain. 

In 3D models, the direction of gravity can be set to
match any of the major coordinate directions (see chap-
ter 6.8). 

TKNKP qÉãéçê~ä=pÉííáåÖë

Corresponding to the discretization in space a dis-
cretization in time has to be specified for transient sim-
ulations.

FEFLOW supports three different options: 
• Constant time steps
• Varying time steps

Figure 7.2 2D model projections.
• Automatic time-step control
As constant time steps have the disadvantage that

the most dynamic moment expected during the simula-
tion controls the time-step length for the entire simula-
tion, the definition of varying time steps offers some
more flexibility. However, this option requires the
specification of the length of each single time step in
advance. Thus in most cases FEFLOW simulations use
an automatic time-step control scheme, where an
appropriate length of the time step is determined based
on the change in the primary variables (head, mass con-
centration, groundwater age, temperature) between the
time steps.

cáêëí=sÉêëìë=pÉÅçåÇ=lêÇÉê=^ÅÅìê~Åó
The automatic time-stepping procedure in

FEFLOW is based on a predictor-corrector scheme. 
The second-order accurate, semi-implicit Forward

Adams-Bashforth/backward trapezoid rule (AB/TR) is
the default for standard flow and combined flow and
transport simulations. While the second-order approach
applied for the prediction in this method in many cases
provides a more accurate estimation of the predicted
result for the next time step and thus a faster solution, it
also may more easily lead to instabilities under highly
nonlinear conditions in unsaturated or density-depen-
dent models. Thus for unsaturated model types the
first-order accurate, fully implicit Forward Euler/back-
ward Euler (FE/BE) method is used by default and
should be applied for density-dependent flow simula-
tions manually.

TKNKQ bêêçê=qçäÉê~åÅÉ=

The dimensionless error tolerance is used for two
purposes in FEFLOW: 
cbcilt=SKO=ö=QV
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• The determination of convergence in iterative pro-
cesses based on the change of results between iter-
ations, e.g., the ’outer’ iteration within a time step
or in a steady-state solution to take care of nonlin-
earities in the basic equations.

•  The determination of an appropriate time-step
length in automatic time-stepping procedures
based on the deviation of calculated from pre-
dicted solutions. 

The absolute error (e.g., head difference) is normal-
ized by the maximum value of the corresponding pri-
mary variable in initial or boundary conditions
(maximum hydraulic head, maximum concentration,
etc.). 

TKNKR cêÉÉ=pìêÑ~ÅÉ

By default, a newly created FEFLOW model
reflects a confined aquifer. Saturated simulations of
unconfined conditions require specific treatment of the
phreatic groundwater table.

TKNKRKN Oa=jçÇÉä

In unconfined two-dimensional models with a hori-
zontal projection the saturated thickness is iteratively
adapted to the resulting hydraulic head. For this pur-
pose, material-property input includes the aquifer top
and bottom elevations.

When the hydraulic head exceeds the aquifer top
elevation, the model calculations presume confined
conditions in the respective area, i.e., the saturated
thickness is limited to the difference between top and
bottom elevation. Aquifers with partly confined condi-
tions are thus easily simulated.
Two-dimensional vertical cross-sectional and axi-
symmetric models are always assumed to be com-
pletely confined. Modeling of unconfined conditions in
these cases strictly requires a simulation in unsaturated/
variably saturated mode, hereby applying Richards’
equation.

TKNKRKO Pa=jçÇÉä=

In three-dimensional models with gravity in the
direction of the negative z axis (default ’top view’
models) two different strategies can be applied in
FEFLOW for handling the phreatic surface besides
simulating in unsaturated mode. It is important to note
that these methods were originally designed for
regional water-management models. They are clearly
limited (with very few exceptions) to cases with a sin-
gle phreatic surface. Simulations where partial desatu-
ration of the model is expected below saturated parts,
e.g., due to drainage in a lower aquifer, have to be sim-
ulated in unsaturated/variably saturated mode. In con-
trast to an often-heard opinion, despite the nonlinearity
of Richards’ equation unsaturated models can be as
computationally efficient or even more efficient than
saturated models with phreatic-surface handling if
appropriate simplifications are applied to the unsatu-
rated material properties. 

As both options for phreatic-surface handling have
their specific advantages and disadvantages, the meth-
ods applied in FEFLOW will be explained in detail: 

cêÉÉ=C=jçî~ÄäÉ
This mode takes care of the phreatic surface by ver-

tically moving the calculation mesh in a way that the
top of the model is exactly at the water-table elevation
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at any time. For this purpose, layer elevations are
changed at each time step (transient simulation) or for
each iteration (steady-state simulation). The movement
is done by using the so-called BASD technique which
places layer interfaces (slices) at elevations of slices in
the original stratigraphy whenever possible.

Material (elemental) properties are mapped from
the original stratigraphy to the actual stratigraphy,
whereas nodal properties such as boundary conditions
and slice-based observation points are moved with the
slices. 

The most important advantage of this method is its
ability to exclude all partially saturated or unsaturated
parts of the initial stratigraphy from the model so that
only saturated parts are simulated at all times. The
main disadvantage is a consequence of the layer move-
ment: In cases where the actual water table cuts
through slices of the initial stratigraphy, model ele-
ments may occur that are located in multiple layers
(and material zones) of the original stratigraphy. In
these cases, a volume-weighted averaging for the mate-
rial properties is applied, giving rise to material proper-
ties that differ from the original input. When
interpolating between aquifer and aquitard properties,
this approximation might not be acceptable (Figure

Figure 7.3 Schematical views of mesh movement and
parameter interpolation in free&movable mode.
7.4).

As a rule of thumb, the free&movable method is
particularly suitable for cases where the water table
varies within one model layer. It is less applicable to
models where steeply dipping phreatic surfaces are
expected. 

mÜêÉ~íáÅ
In phreatic mode, the model stratigraphy is fixed

and, as a consequence, elements may become dry or
partially saturated. In contrast to unsaturated mode, the
calculation of the unsaturated zone is highly simplified
and (with rarely occurring exceptions) only one phre-
atic surface is possible. 

For each partially saturated element, the partial sat-
uration is calculated by dividing the saturated thickness
of the element by the total thickness of the element.
Conductivity values in all directions are then linearly
reduced by multiplying them with the partial saturation
of the element. 

For entirely dry elements (hydraulic head below the
element bottom), a residual water depth is applied for

Figure 7.4 Unintended conductivity interpolation in
free&movable mode in a schematized layered aquifer
(cross-section view).
cbcilt=SKO=ö=RN
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the calculation of the partial saturation and reduced
conductivity. This residual water depth can be defined
on the Free Surface page in Problem Class.

Groundwater recharge is applied on the top of the
model in phreatic mode and therefore has to pass the
partially saturated/dry elements before reaching the
water table.

The phreatic mode avoids all slice movement and
related parameter interpolation and is therefore applica-
ble to water tables with steep gradients that extend over
multiple layers. On the other hand, dry elements with
low conductivity values can lead to strong contrasts in
the model, making the solution more difficult. The
default low residual water depth might cause difficul-
ties for the infiltration of recharge into dry soil, espe-
cially in cases with time-varying groundwater
recharge. 

In phreatic mode, the unconfined storage term is
always only applied to the slice set to ’phreatic’, i.e.,
usually to the top slice. The values for drain-/fillable
porosity, however, are correctly derived from the layer
where the water table is located at a given time. While
this simplification has no negative consequences for
typical regional models with significant horizontal
flow components, it makes the phreatic mode less suit-
able for problems in which vertical flow is important,
such as simulations of drainage of a soil column from
the bottom. 

Source and sink parameters assigned within phre-
atic layers can be scaled by the local pseudosaturation
if the option Scale sources/sinks by pseudosaturation
is set active. This will result in reduced source/sink val-
ues wherever the hydraulic head falls below the ele-
ment top elevation (elements are not fully saturated).
By default, the scaling of source/sink values is enabled
to maintain compatibility with older FEFLOW ver-
sions not providing the two options.

cêÉÉ=pìêÑ~ÅÉ=pÉííáåÖë
To allow combining of different methods of phre-

atic-surface handling, the method is set for each slice
separately. 

Typically, the first slice is set to either phreatic or
free, while all the slices below are set to dependent
except for the bottom slice which is always set to fixed.
Dependent slices are defined by the first slice above
that is non-dependent, e.g., dependent slices below a
free slice can move if necessary. 

Layers whose top slice is set to confined are treated
as fully saturated, no matter whether the hydraulic head
is above or below the layer. In models using the
free&movable approach, fixed is especially useful to
avoid slice movement (and possible material-property
interpolation) in layers that are known to be saturated
during the entire simulation. 

TKNKRKP eÉ~Ç=iáãáíë=Ñçê=råÅçåÑáåÉÇ=`çåJ
Çáíáçåë=

In models with a phreatic surface, two particular
cases may occur: 

• All layers can be dry in a certain location. 
• The water level can exceed the top of the model. 
FEFLOW provides two options for dealing with a

dry model bottom: 
• Unconstrained head (default):

Hydraulic-head values lower than the model bot-
tom are tolerated. The saturated thickness is con-
sidered equal to the residual water depth at these
locations. 
få= ãçÇÉäë= ïáíÜ
íÜáÅâ=Çêó= ä~óÉêë= íÜÉ
êÉëáÇì~ä= ï~íÉê

ÇÉéíÜ= ëÜçìäÇ= ÄÉ= áåÅêÉ~ëÉÇ
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• Constrained head:
FEFLOW will prevent hydraulic-head values
below the model bottom. For this purpose, first
kind boundary conditions are internally applied at
all bottom nodes that would otherwise fall dry,
with a fixed head that equals the bottom elevation
plus the residual water depth as defined on the
Free Surface page.

For the top of the model domain, similar options are
available: 

• Unconstrained head (default):
Hydraulic-head values exceeding the model top
elevation are tolerated, and the parts above the top
are treated as part of the first layer, i.e., calculation
is done with the properties of the first layer (3D
models). For 3D models using the phreatic mode
for the free surface, alternatively the aquifer can
be treated as confined as soon as it gets fully satu-
rated. In 2D horizontal unconfined models, the
model is treated as confined if the water level
exceeds the top elevation, which is a material
property in this model type and therefore can be
set higher if this behavior is not desired.

• Constrained head: 
FEFLOW will prevent water levels higher than
the model surface. If hydraulic-head values higher
than the top elevation would occur, FEFLOW sets
fixed-head boundary conditions with a value of
the top elevation at these locations.

Optionally, the setting Prevent inflow can be
enabled for the top head limit. With this setting, the
fixed-head boundary conditions act as seepage faces,
i.e., FEFLOW applies an additional constraint condi-
tion that only allows outflow. This causes an iterative
setting of the head limits per time step. Only up to 30
iterations are performed. If there are still changes in the
location of these additional head boundary conditions
after 30 iterations, FEFLOW proceeds to the next time
step.

If the Prevent inflow option is disabled (default),
the checking for nodes with a water level higher than
the top is only done once per time step. The Prevent
inflow option is more accurate, but requires more com-
putational effort as up to 30 iterations per time step
might be performed.

TKNKS ^åáëçíêçéó= çÑ= eóÇê~ìäáÅ= `çåJ
ÇìÅíáîáíó
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In a 2D model, the anisotropy of the hydraulic con-
ductivity is defined through a set of material properties
and not via the Problem Settings dialog. Conductivity
[max] (Transmissivity [max] for confined models)
defines the maximum conductivity. The direction of the
maximum hydraulic conductivity is defined as Anisot-
ropy angle (defining the angle between the x-axis and
the max hydraulic conductivity). The ratio between the
maximum and minimum hydraulic conductivity is
finally defined as Anisotropy of conductivity.

TKNKSKO Pa=jçÇÉä

In a 3D model, the Anisotropy Settings page of the
Problem Settings dialog offers different approaches for
the definition of anisotropy of hydraulic conductivity.

The following settings are available: 
• Axis-Parallel Anisotropy (default):

The three different conductivities (K_xx, K_yy,

íÜ
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ã
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K_zz) are directed along the x, y and z axes of the
model.

• General Anisotropy with Computed Angles:
 The principle directions for the main conductivi-
ties K_1m, K_2m, K_3m coincide with the layer
inclination. The inclination is determined sepa-
rately for each element.

• General Anisotropy with User-Defined Angles:
The principle directions for the three main con-
ductivities and the three Euler angles needed for
the rotation of the coordinate axes are defined as
material properties for each element.

TKO bèì~íáçåJpóëíÉã=pçäîÉêë

FEFLOW offers multiple iterative and two direct
equation solvers. As the computational demand of the
built-in, Crout-based method direct solver increases
with the third power of the number of mesh nodes, the
applicability of this solver has a practical limit of about
100,000 nodes. Storage and computational demand of
the parallel sparse direct solver PARDISO are directly
linked to the numbering of the finite-element mesh
(and consequently the bandwidth of the global finite
element matrix) and the number of degrees of freedom.
As a consequence, PARDISO is particularly well-
suited to solve matrices originating from 2D models
even up to some millions of nodes (depending on hard-
ware availability). For 3D problems with more than 1
million nodes, the use of PARDISO can still be consid-
ered but storage demand and solving time are problem
and hardware dependent. Below the practical limit of
1,000,000 nodes, it is recommended to use PARDISO
because the solution error then theoretically is at the
level of machine precision.

By default, FEFLOW uses iterative solvers because
they are suited for problems of arbitrary size. In
advanced selection mode, separate iterative solver
types can be selected for the symmetric (flow) and
unsymmetric (transport) equation systems. The default
options are a preconditioned conjugate-gradient (PCG)
solver for flow and a BICGSTABP-type solver for
transport. Alternatively, for either type of equation sys-
tems an algebraic multigrid solver can be chosen
(SAMG). The main advantages of SAMG are its paral-
lelization on multicore or multiprocessor systems, and
its more efficient solution algorithm, in particular for
steady-state simulations and simulations with large
ranges of element sizes in the mesh. As the algebraic
multigrid technique is not always the most efficient
one, the SAMG solver automatically selects between a
CG-type or AMG-type solution strategy according to
the current conditions.

TKP qìíçêá~ä

In this exercise we load a number of models with
different problem types to get familiar with the avail-
able problem settings.

TKPKN `çåÑáåÉÇLråÅçåÑáåÉÇ=jçÇÉäë

We start with a very basic 2D flow model. Start
FEFLOW and click Open to load the file quad-
mesh.fem. To check the basic settings of the model,
open the Problem Settings dialog via the Edit
menu. 

On the Problem Class page we can see that the stan-
dard (saturated) groundwater-flow equation is used for
the flow simulation and that confined conditions are
assumed. Switch from a Horizontal projection to

Vertical, planar and click Apply. The option
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Unconfined conditions is now disabled as Vertical,
planar models are always assumed to be confined.
Additionally, the Gravity Direction page is displayed
under Problem Class. 

Switch back to a Horizontal projection and
choose Unconfined conditions. Once we confirm
the changes with Apply, the Free Surface page is
added in Problem Class. In the Data panel, the
material-properties list automatically adapts to the
changed settings. Transmissivity is replaced by the
parameter Conductivity [max], and Top and Bottom
elevation now need to be defined. 

Additionally, for unconfined (phreatic) models head
limits for unconfined conditions can be set to define
the model behavior when the water table touches the
top surface, or the model falls dry at the bottom.

Leave the Problem Settings dialog with
Cancel and close the model without saving the

changes.
We proceed by studying a 3D flow model. Click
Open and load the file free3d.fem. Again, open

the Problem Settings dialog vie the Edit menu. The
Problem Class page shows that a saturated model type
is set. 

In contrast to 2D models the projection is fixed for
3D models, but the gravity direction can be changed
from the default negative z-axis to a different direction. 

On the Free Surface page, a Fully confined
system or the setting Unconfined aquifer(s) can be
chosen where two different options are available for the
latter. Currently, a Free & Movable approach is cho-
sen. When we change the status of slice 1 to Phreatic,
we can also define whether the top slice will be treated
as confined or unconfined when the water level reaches
the top surface.

Leave the dialog with Cancel, activate the 3D
view and click Start in the Simulation toolbar
to start the simulation. We can see the mesh moving in
such a way that the top of the model is always at the
water level elevation. 

When the simulation has stopped, leave the simula-
tor with a click on Stop. Reload the same file via

File > Recent FEM Problem files. 
Go back to Edit > Problem Settings and switch

to Fully= confined system on the Free Surface
page. Click Apply and leave the dialog with

OK. Start the simulation run for the changed con-
ditions with a click on Start. The mesh geometry is
now fixed and the resulting hydraulic head distribution
differs from the free & movable model run.

Terminate the simulation with a click on Stop
and close the model without saving the changes.

TKPKO råë~íìê~íÉÇ=jçÇÉäë

We continue with a 2D unsaturated flow model.
Click on Open and load the file
dam_seepage.fem. 

Start with the Problem Settings dialog located in
the Edit menu. The Problem Class page shows that
flow is simulated via Richards’ equation and that the
state is set to Steady.

The page list on the left-hand side now contains a
new entry for Unsaturated Flow. Here, the basic set-
tings for unsaturated models such as the form of the
Richards’ flow equation, iteration schemes and hyster-
esis settings can be changed. Do not do any changes
here and switch to the Problem Class page again. As
we can see, only Vertical, planar and Vertical,
axisymmetric projections are available for 2D unsatu-
rated models. Leave the dialog with Cancel. 

In unsaturated models additional parameters are
cbcilt=SKO=ö=RR
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available in the Data panel. Saturation and Mois-
ture content are added to the list of Process Variables
and the Material Properties list now contains unsatu-
rated-flow parameters. Double-click on Unsaturated-
flow model type. The Slice view now shows that a Van
Genuchten modified model has been chosen to
describe the capillary pressure vs. saturation and satu-
ration vs. hydraulic conductivity relationships.

TKPKP qê~åëéçêí=jçÇÉäë

To get familiar with the settings for transport simu-
lations load the model simulation.fem.

Open the Problem Settings dialog via the Edit
menu and start on the Problem Class page. Saturated
conditions are assumed and transport of Mass is
included. The state for both flow and transport is set to

Transient. 
In mass-transport simulations, the Problem Settings

dialog contains two additional pages: In General set-
tings on the Transport Settings page, we can choose
between the Convective and the Divergence
form of the transport equation and change the settings
for the calculation of fluid viscosity and density. Addi-
tionally, the Reference concentration for the mass-
transport calculation, and the Reference temperature
for heat-transport problems are specified here. 

Figure 7.5 Unsaturated-flow model type.
Switch to the Chemical Species page. Here, addi-
tional species that are associated with the fluid or the
solid phase can be defined if the model requires more
than one species. To add or remove species from the
list, the Add species or Delete current species
tools can be used.

Proceed to the Numerical Parameters page. On this
page, the settings for the Error tolerance and for the
computation of mass matrices are located. Addition-
ally, different upwinding techniques, e.g., Full
upwinding or Shock capturing can be selected to
stabilize the transport calculation. As we can see, for
the current model the default option No upwinding
(Galerkin-FEM) is set. Click Cancel to leave the
dialog without any changes.

Notice how the Data panel has changed com-
pared to a flow simulation: The Process Variables,
Boundary Conditions and Material Properties trees
now each contain an additional branch for mass trans-
port (see Figure 7.6).
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In models with multiple chemical species, a sepa-
rate branch is created for each species so that initial
concentrations, boundary conditions and material prop-
erties can be defined separately for each species.

Start the simulation with a click on Start in the
Simulation toolbar. The Rate-Budget and the

Period-Budget panels now have two tabs, one for
Fluid and one for Mass. To monitor the mass budget
during the simulation, click on the tab Mass in both
panels and set the check mark in front of Active. If
a model contains multiple species, the panels contain a
separate tab for each species.

The Content panel also contains additional
entries for transport. To evaluate the amount of dis-
solved mass in the model, start the content calculation
by checking Dissolved Species Mass. In a multi-

Figure 7.6 Data panel with mass-transport parameters.
species model, the Content panel contains a sepa-
rate tab for each species.

Terminate the simulation with a click on Stop. 

TKPKQ píÉ~Çó=L=qê~åëáÉåí=jçÇÉäë

To study the available settings for simulations in
steady and transient state, load the file
enclosed_valley_3.fem. 

Access the Problem Settings dialog via the Edit
menu and go to the Problem Class page. Flow is simu-
lated via the Standard (saturated) groundwater-
flow equation and the state is set to Steady. 

Leave the dialog with Cancel and start the sim-
ulation with a click on Start in the Simulation
toolbar. After a brief computation the steady-state solu-
tion is reached. In addition to the Hydraulic-Head
chart the Error-Norm History is shown which plots the
remaining dimensionless error for every iteration (see
Figure 7.7). 

Terminate the simulation with a click on Stop
and reload the same file via File > Recent FEM
Problem files without saving the changes. Open the
Problem Settings dialog again, select Transient on

Figure 7.7 Error-Norm History.
cbcilt=SKO=ö=RT
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the Problem Class page and click Apply to con-
firm the changes. To specify the time discretization for
the transient simulation, go to the Simulation-Time
Control page that now appears in the list on the left-
hand side. The available time-stepping options are
Constant time steps, Varying time steps and Auto-
matic time-step control. By default, an Automatic
time-step control based on a Predictor-corrector
scheme with a Second-order accurate (FA/BT) inte-
gration scheme is assumed. For the automatic time
stepping, an Initial time-step length and a Final simu-
lation time need to be specified. Change the Final sim-
ulation time to 3650 days and click OK to
apply the changes and to leave the dialog.

Start the transient simulation by clicking Start.
The current simulation time is displayed in the

Simulation toolbar and, optionally, also at the
bottom of each view window. All process variables
such as hydraulic head can be monitored during the
simulation. Instead of the Error-Norm chart that is dis-
played for steady-state simulations, the Time-Steps
chart appears and shows the elapsed simulation time
versus the time-step length (see Figure 7.8). 

Figure 7.8 Time-Step History.
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Selections of nodes, elements, edges and faces are
among the fundamental concepts in FEFLOW. They
are the basis for parameter input, visualization and
postprocessing. 

Selections can be stored with the model for repeated
use—for example, to apply flow and mass-transport
boundary conditions at the same nodes, or to start path-
lines from nodes with well boundary conditions.

Figure 8.1 Nodal and elemental selections (Slice view).
UKO pÉäÉÅíáçå=qççäë

Selections can be created by applying one, or a
combination, of the available manual or map-based
selection tools. The selection tools work on a node, ele-
ment, edge or face basis, depending on the nature of the
parameter that is currently active in the Data panel or
on the target geometry that is set in the Selection tool-
bar. 

Figure 8.2 Edge and face selections (Slice view).
U
tçêâáåÖ=ïáíÜ=pÉäÉÅíáçåë
Use selections efficiently for parameter assignment and results evaluation
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The manual selection tools are:
• Select Individual Mesh Items
• Select Complete Layer/Slice (3D view)
• Select in Rectangular Region (Slice view)
• Select Using a Lasso (Slice view)
• Select in Polygonal Region (Slice view)
• Select by Map Point
• Select by Map Line
• Select by Map Polygon
• Select Nodes along a Border (Slice view)
• Select Arbitrary Node Path
Map-based selection requires that the desired map is

active in the Maps panel. An active map is indicated by
a map name in bold letters. Selection based on both 2D
and 3D maps is supported. 

Figure 8.3 Nodal selection based on a map polygon (Slice
view).
Interactive selection for a map includes selection
based on points, lines, and polygons. The availability
of certain selection modes depends on the map type:
While for polygon maps polygon, line (edge) and point
(node) selection is possible, for point files only point
selection is available. In the Slice view, clicking on a
map element triggers the selection of all nodes, ele-
ments, edges or faces within the snap distance as
defined in the Snap-Distance toolbar (Figure 8.3). For
selections based on 3D map geometries in the 3D view
the snap distance is ignored but the chosen map set-
tings in the Problem Settings dialog determine how a
selection is created.

A selection can also be performed for all map ele-
ments without user interaction.

For nodes and elements a further selection option
exists: FEFLOW’s Expression Editor can be used to
create a selection based on a user-defined expression.
The expression can contain process variables, bound-
ary conditions, material properties, mesh data such as
node/element numbers or coordinates and also tempo-
ral data like time series. 

Figure 8.4 Selection modes: start selection, new, add,
remove, toggle, intersect (upper left to lower right).
qç=~îçáÇ=íÜ~í=ìåáåJ
íÉåíáçå~ääó= éêÉîáJ
çìë= ëÉäÉÅíáçåë= ~êÉ

âÉéí=~ë=é~êí=çÑ=~=åÉï=ëÉäÉÅJ
íáçåI= áí= áë= êÉÅçããÉåÇÉÇ= íç
ÅäÉ~ê= ëÉäÉÅíáçåë= ~ÑíÉê= ìëáåÖ
íÜÉãK



UKP=píçêáåÖ=pÉäÉÅíáçåë
By default, applying a selection tool to a group of
nodes or elements toggles the selection state of these
nodes, elements, edges or faces, i.e., previously
unselected mesh items become selected, and already
selected ones are deselected. Alternative selection
modes are available via the Selection toolbar: Create a
new selection every time, always add to the current
selection, remove from the selection, or intersect with
the current selection (Figure 8.4).

UKP píçêáåÖ=pÉäÉÅíáçåë

Using the context menu of either the active view or
a Spatial Units panel, selections can be stored with the
model for later use in parameter assignment, visualiza-
tion or postprocessing.

Stored selections appear in the Spatial Units panel
and can be renamed via their respective context menu
or set as the current selection. Moreover, the nodes/ele-
ments/edges or faces of the stored selection can be
added to, removed from, or intersected with the current
selection. 

Any stored selection can be applied as navigation
reference in the active view to redefine the settings for
full view and the center of rotation according to the
selection.

Stored node selections can also be used as domain
of interest for the Rate- and Period-Budget panels.
Additionally, the budget history can be displayed as a
time series in the Rate-Budget and Period-Budget
charts.

Stored element selections are available as budget or
transfer-budget domain for the Rate- and Period-Bud-
get and Subdomain Boundary Rate and Subdomain
Boundary Period Budget panels, as well as content or
flux-integration domain for the Content panel and the
Flow-Rate and Flow-Volume panels. 
The current or any stored selection can be converted

into a selection of a different geometry type via the
context menu of the selection in the Spatial Units
panel. If a Slice view is the active view, the user can
choose between converting a selection into a new
selection on the current slice/layer (option 2D) or into a
3D selection.

One or multiple selections (keeping the <Ctrl> key
pressed while selecting) which can be of different
geometry types can be exported as Location Set Col-
lection via their context menu in the Spatial Units
panel. A re-import option for the Location Set Collec-
tion is also accessible via the context menu of the Spa-
tial Units panel. This allows for a convenient transfer
of stored selections between different model scenarios.

UKQ qìíçêá~ä
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Whether nodes, elements, edges or faces are
selected depends on the target geometry chosen in the

Selection toolbar.
In the following exercises all selections are created

for nodes. Selections on an elemental basis or edge/

Figure 8.5 Selection toolbar.

Figure 8.6 Snap-Distance toolbar.
cbcilt=SKO=ö=SN
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face selections can be created following the same prin-
ciple, though. 

UKQKP j~åì~ä=pÉäÉÅíáçå

 As a first exercise, we create a number of selections
manually. First, click on Open and load the model
selections.fem. Two views are displayed, a Slice view
(2D) and a 3D view window. 

UKQKPKN pÉäÉÅíáçåë=áå=Oa

Click in the Slice view to make it the active view
and then browse to slice 1 in the slice list of the

Spatial Units panel. 
Choose the tool Select Individual Mesh Items

from the Selection toolbar, choose Select
Nodes as target geometry and click on an arbitrary
number of nodes on slice 1. The selected nodes are
highlighted in yellow. Delete this selection again with a
click on Clear Selection.

Figure 8.7 Node selection in Slice view.
 Instead of selecting individual nodes, we can use
Select All to create a selection that contains all

nodes if a 3D view is active, or all nodes on the current
slice in an active Slice view. 

After a click on Clear Selection, choose the
tool Select in Rectangular Region and draw a rect-
angle to create a new selection. Draw a second rectan-
gle that partially overlaps the first one. As we can see,
the selection is toggled: The already selected nodes are
removed and newly selected nodes are added to the
selection. This default selection mode can be changed
by clicking Toggle in Selection which exposes all
available modes. Click on Undo Last Selection
Step to reverse the selection created with the second
rectangle. Now, activate the Set New Selection
mode and draw a rectangle similar to the one we just
removed. The result is quite different: The nodes in the
first rectangle are now deselected and a new selection
is set instead. Once again, click Undo Last Selec-
tion Step and try the other modes available for setting
selections. 

A tool that is only available for node selections in
the Slice view is Select Nodes along a Border.
Clear the current selection and switch back to the

Toggle in Selection mode. Click and hold the left
mouse button on the western most node of the southern
border. Move the cursor further along and release it at

Figure 8.8 Toggled Selection.
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the last node of that border. The selected nodes are now
highlighted in yellow.

To also select the corresponding nodes on the slices
below, we use the Copy Selection to Slices/Layers
tool in the Selection toolbar. Choose all slices as
the target slices. Confirm with OK. In the 3D view
we can see that the nodes of the southern border have
been selected on all slices.

UKQKPKO pÉäÉÅíáçåë=áå=Pa

Six selection tools are available in a 3D view:

Select All 

Select Individual Mesh Items

Select Complete Layer/Slice

Select by Map Point

Select by Map Line

Select by Map Polygon

For node selections an additional seventh tool for
the assignment of 1D arbitrary Discrete Features is
available: 

Select Arbitrary Node Path
We now create a selection that contains all nodes of

the top slice. Make sure that the 3D view is the active
view window. Choose the Select Complete Layer/

Figure 8.9 Selected nodes at southern border.
Slice tool from the drop-down menu of the
Selection toolbar. Placing the mouse cursor over

any node in the top slice highlights all its nodes. Create
the selection with a single click. The selected nodes are
displayed as yellow disks.

UKQKQ j~éJÄ~ëÉÇ=pÉäÉÅíáçåë

A further option to create selections is to use maps.
The points, lines and polygons contained in the Super-
mesh are available in the Maps panel and selections
can be set based on these features. 

For this exercise, we use the same FEFLOW model
as in the previous exercises. This model contains a
number of maps and also its Supermesh. Selections
based on 2D maps are only possible in the Slice view,
so we first have to make sure that this is the active
view. 

In the first exercise we select the nodes of the well
locations contained in the map demo_wells. These
locations have also been included in the Supermesh
and correspond to the refined areas in the southern part
of the model area. Browse to slice 4 in the Spatial
Units panel, then switch to the Maps panel and acti-
vate demo_wells (not the Default entry) with a double-
click. Enter 1 m in the Snap-Distance tool-
bar, activate the tool Select by Map Point and click
on Select by All Map Geometries to create the
selection. The selected nodes are now highlighted in
yellow. Before we proceed, clear the selection with a
click on Clear Selection. 

In the next step, we create a selection for the poly-
gon that is defined in the map sewage_treatment, the
refined area on the left side of the model. Activate this
map in the Maps panel with a double-click, click on

Select by Map Polygon and then click Select
cbcilt=SKO=ö=SP
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by All Map Geometries again. Alternatively, it is possi-
ble to select this polygon by clicking on it in the Slice
view while Select by Map Polygon is the active
selection tool. Again, finish with a click on Clear
Selection.

The Supermesh can be used to create selections in
the same way. Activate Supermesh > Polygons in the

Maps panel. When the mouse cursor is moved over
a polygon it is highlighted. Set the selection with a sin-
gle click. 

UKQKR bñéêÉëëáçåJÄ~ëÉÇ=pÉäÉÅíáçå

The Expression Editor can be used to create selec-
tions based on a user-defined expression. 

Click on Clear Selection to make sure that no
selection is active and switch to the 3D view. 

To open the Expression Editor, click on the tool
Select by Expression. We want to create a node

selection that contains all nodes with a hydraulic-head
value of less than 65 m. 

First, click into the working window and delete the
true statement. The table on the right-hand side of the
editor contains all input parameters in FEFLOW and
also some temporal data and mesh properties than can
be used within an expression. Open Process Variables
> Fluid Flow in the table and double-click on Head.
Hydraulic head is now added to our expression. To fin-
ish the expression that will be evaluated for the selec-
tion, click on the less-than operator symbol and
then type 65 without a unit. The current user unit
for each parameter is displayed in the table on the
right-hand side or in the tooltip of the parameter in the
work area. User units can be changed via the context
menu of a parameter in the Expression Editor. The
final expression should look like the one shown in fig-
ure 8.10.

To create the selection based on the defined expres-
sion click on Apply. Leave the dialog again with

Close or by activating a different tool.

UKQKS píçêáåÖ=pÉäÉÅíáçåë

Selections can be stored for later use in parameter
assignment, visualization or postprocessing actions. 

To store the current selection, invoke the context
menu by right-clicking in the active view or on an
empty part in the Spatial Units panel. Choose the
option Store Current Selection in the context menu
and either enter a new name or accept the suggested
default name for the node selection and confirm with
<Enter>. The stored selection appears in the Node
Selections branch in the Spatial Units panel. 

Clear the selection with Clear Selection. To set
the selection active again, double-click on it in the

Spatial Units panel.

Figure 8.10 Expression Editor for node selection.
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Make sure that the Slice view is the active view and
use the Slice entries in the Spatial Units panel to
switch to slice 1. Activate the stored node selection
Navigation Selection with a double click. We now con-
vert this node selection into an element selection: Right
click on Navigation Selection and select Convert to
> Element Selection 2D. FEFLOW now automatically
selects all elements adjacent to the nodes of the stored
selection. The result is shown in figure 8.11.

UKQKU bñéçêíáåÖ= ~åÇ= oÉáãéçêíáåÖ
pÉäÉÅíáçåë

Selections can be exported and reimported, e.g., for
use in alternative model scenarios. 

Click on Navigation Selection in Node Selections
in the Spatial Units panel, press the <Ctrl> key and
click on the name of the node selection which we have
stored in chapter 8.4.6. Next, right click on one of the
highlighted selections, select Export Location Set
Collection from the context menu and specify a name

Figure 8.11 Node selection converted into element selection.
for the file to be exported. Confirm with Save.
Before reimporting the exported selections, we

delete the currently stored node selections. Again,
select both selections simultaneously using the <Ctrl>
key and then press the <Del> key twice to remove both
selections from the Spatial Units panel at once.
Now, right click either on Node Selections or in an
empty part of the Spatial Units panel, select

Import Location Set > Location Set Collection and
choose the file that we have just exported. The previ-
ously exported selections now reappear under Node
Selections in the Spatial Units panel.

UKQKV rëáåÖ= pÉäÉÅíáçåë= ~ë= k~îáÖ~J
íáçå=oÉÑÉêÉåÅÉ

Make sure that the 3D view is the active view and
double-click on the stored node selection Navigation
Selection in the Spatial Units panel to set it active.
Next, open the context menu of the selection with a
right click and select Set as Navigation Reference
in Active View. The settings for full view and the center
of rotation are now adapted according to this selection.
cbcilt=SKO=ö=SR
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Visualization of the model parameters is not only
essential during model parameterization but for check-
ing the assigned model properties, for evaluating the
model results, and for the presentation of model prop-
erties and simulation results. 

VKO sáÉï=táåÇçïë

All visualization options refer to a specific view
window (see chapter 3.4). Depending on the type of the
view window, different options for visualization are
available. Each view window manages its own list of
visualized parameters and visualization styles and set-
tings. The panels controlling visualization always
reflect the active view window. 

VKP jçÇÉä= dÉçãÉíêó= ~åÇ
a~í~=mäçíë

In the Spatial Units panel, the visualization target
geometry is chosen. For example, in a 3D view, a
parameter may be plotted on the outer boundary of the
model domain, but also on a single slice or the bound-
ary of a parameter zone. 

For Slice views, the target geometry is a layer or
slice, depending on whether nodal or elemental param-
eters are shown. The Spatial Units panel (or the <Pg
Up> and <Pg Down> keys) can be used to switch
between different layers/slices. Cross-sectional, Slice
Data- and Data-Trace views are not affected by the
Spatial Units panel. In case the active view is a 3D
view, the geometry of any spatial unit can be added to
the view by a double-click on the unit, or via the con-
text menu. 

To provide more convenience for working with
models with a large number of layers/slices and spatial
units such as stored selections, it is possible to open
more than one Spatial Units panel at a time via the
context menu of the panel. This allows to use one panel
for switching between different slices/layers while
stored selections or surface and domain locations can
easily be accessed via a second panel. 

A parameter or parameter group (e.g., the group of
all flow boundary conditions) is added to the view by
double-click on the parameter in the Data panel, or by
using the context menu of one or several selected
V
m~ê~ãÉíÉê=sáëì~äáò~íáçå
Plotting input parameters and results
cbcilt=SKO=ö=ST
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parameters. The parameter will be plotted on the geom-
etry that is active in the Spatial Units panel. Parameters
can be plotted on more than one geometry at the same
time, e.g., on the bottom slice and the vertical hull. 

VKQ sáëì~äáò~íáçå=léíáçåë

All geometry (3D view) and parameter information
currently available in the active view are listed in a tree
in the View Components panel. As the tree always
reflects the active view, it automatically changes when
switching between the view windows. By changing the
check box in front of the leaf and branch items in the
tree, visibility of the corresponding view components
can be toggled. 

For parameters, different visualization styles may
be available, one of which is active by default. For
example, hydraulic head can be shown as continuous
plot, fringes, isolines, or isosurfaces in a 3D view. 

The parameters and visualization styles have prop-
erties that can be edited in a Properties panel. The
panel is opened by double-clicking on the parameter or
style in the View Components panel, or by using the
context menu of the parameter or style. The contents of
the Properties panel depend on the parameter or style,
and are described in detail in the FEFLOW help sys-
tem. 

Whenever a new parameter is added to a view, by
default the previously shown parameter is removed.
While this is a convenient behavior for quickly editing
different parameters one at a time, in many cases it is
preferable to visualize multiple parameters simultane-
ously. For this purpose, parameters can be locked via
their context menu in the View Components panel.
Locked parameters are not removed when adding a
new component. 
VKR `äáééáåÖ=~åÇ=`~êîáåÖ

Up to six planes can be arbitrarily defined and com-
bined in each 3D view window to expose data other-
wise hidden within the model domain. Each of the six
planes of the active view can be accessed via the
Planes panel. For each plane, the panel provides con-
trols to activate the respective plane and to specify
whether the plane is to be considered as part of a cutout
combination or as a simple clipping plane. A simple
clipping plane clips all parts of the object located on its
back side. When using a cutout combination, only
those object parts are clipped that are on the back side
of all clipping planes of the cutout combination. 

Simple clipping planes can be applied in addition to
a cutout combination.

The location of each clipping plane can be changed
in the Plane definition dialog that is opened by click-
ing on the respective model view icon in the Planes
panel. While modifying the plane equation, the plane is
shown in the active view window. 

Whether a visualization item is clipped or not is
controlled via its context menu in the View Compo-
nents panel.
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The active parameters in the current view and the
attributes of maps shown in the view can be inspected,
using the Inspection tool which is invoked via the
Inspection toolbar. The properties of the target location
are shown as constant values or curves for transient
properties in the Inspection panel. 

Parameters and map attributes can be displayed in
the same list or the panel can be split into two separate
parts, the upper one listing the parameters and the
lower one displaying the map attributes. 

The panel content can be filtered by a full-text
search which is accessible via the search bar on top of
the panel or in the split-panel sections. 

Figure 9.1 Cross-section visualization in 3D.
VKT pÅÉåÉ=iáÄê~êó

View settings for Supermesh, Slice, 3D and Cross-
section views can be stored in a Scene Library. For
models with a large number of views, this bears the
benefit of reducing the required memory or CPU load
significantly compared to keeping all views open all
the time. With the provided export and import func-
tions a large number of identical views can easily be
created in different model scenarios. 

View settings can be stored as scenes via the context
menu of a view or with <Ctrl>-<Shift>-<S>. The
stored scenes appear as tiles in the Scene Library panel
and can be renamed by pressing <F2>. Placing the
mouse cursor on a stored scene shows a large preview
of the scene as a tooltip.

Scenes can easily be restored in existing or new
view windows via their context menu. Double-clicking
on a scene icon applies the scene to an existing view of
the same type or opens a new view window in case that
no other view of the same type already exists.

Scenes can be organized in a user-defined folder
structure and also be filtered using the check boxes for
Slice View, 3D View and Others in the Scene Library
panel or via a full-text search. The entire Scene
Library, selected scene(s) or folders can be exported
into an *.xml file via the context menu of a specific
entry in the Scene Library panel. 

Additional Scene Library settings are accessible via
the menu Tools and Global Settings > Tool Properties.
cbcilt=SKO=ö=SV
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FEFLOW 6.2 supports 3D stereoscopic display of
model geometries and data. Especially for 3D models
with complex geometries, stereoscopic visualization of
the model helps to highlight 3D structures due to the
enhanced depth perception. Prerequisite for stereo-
scopic visualization are computer displays, TVs or pro-
jectors that support 3D stereoscopic display and
adequate glasses. 

The export of stereoscopic images in JPS or PNS
format and animations in AVIS format is supported.
FEFLOW is compatible with common 3D interface
standards (shutter and polarizer technology).

Different view settings for stereoscopic visualiza-
tion and snapshot or movie export are available.
FEFLOW supports the following visualization modi:

Figure 9.2 Checking boundary conditions with the
Inspection tool.
• Row-interleaved
• Active 3D (Quad-buffered)
• Horizontal Side-by-Side
• Vertical Side-by-Side
These settings can be accessed via Extended View

Settings in the context menu of a 3D view window or
in the export dialogs for movie or snapshot export. The
choice of a modus depends on the capabilities of the
available 3D hardware.

VKV qìíçêá~ä

The visualization options described in the following
exercises are available during model setup, simulation
run and also in postprocessing. 

VKVKN sáÉï=táåÇçïë

Start FEFLOW, click on= Open and load the file
visualization.fem. A 3D and a Slice view are dis-
played. For the 3D view, Conductivity K_xx is the
active parameter. Hydraulic head is the active parame-
ter in the Slice view.

 Pay attention to the changes when we switch
between different views: Click in the Slice view to set
it as the active window. Hydraulic head then becomes
the active parameter in the View Components and
in the Data panel and Conductivity K_xx is
removed from the View Components panel. Addi-
tionally, the Spatial Units panel now shows that we
are currently working on slice 1.
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Click in the 3D view to set it as the active view.
Double-click on Hydraulic head in the Data panel
to plot this parameter. Note that the previously dis-
played parameter disappears from both the active view
and the View Components panel when a new
parameter is plotted.

It is also possible to display different parameters at
the same time: Open the context menu of the entry
Hydraulic head in the View Components panel and
select Lock Data View. The lock icon now
appears in front of Hydraulic head. In the Data
panel double-click on In/outflow on top/bottom to add
this parameter to the active view. Both parameters are
now displayed at the same time.

In the 3D view not only parameters but also addi-
tional geometry can be added to the active view. Go to
the Spatial Units panel and double-click on the
entries Slice 1 and Slice 4. These slices are now added
to the active view. A new item for each slice appears in
the Faces and Edges branches of the Geometry tree in
the View Components panel. To plot only slices 1
and 4 and not the entire domain uncheck the entries
Faces > Domain and Edges > Domain and also
Hydraulic head > Continuous > Domain and In/out-
flow on top/bottom in the View Components panel.
We now want to plot a different parameter on each of
the two slices. Start with slice 1. In the Spatial
Units panel click on Slice 1 to set it as target geometry
for the plot. Then, double-click on Hydraulic head in
the Data panel. Now click on Slice 4 in the

Spatial Units panel and double-click Drain-/fill-
able porosity. Not only parameters but also maps can
be plotted to selected geometries. In the Spatial
Units panel, set Slice 1 as target geometry. Uncheck
Hydraulic head in the View Components panel and
double-click on topography_rectified in the Maps
panel. The map is now visible on slice 1 in the 3D
view. The resulting plot in the 3D view is shown in fig-
ure 9.3.

VKVKP sáëì~äáò~íáçå=léíáçåë

We now select different visualization styles for the
parameter Hydraulic head. Set the Slice view as active
view. In the View Components panel, three styles
are available for this parameter: Continuous, Fringes
and Isolines. Display the different styles by checking
the check box in front of the respective entry.

The properties of each style can be edited in the
respective Properties panel. Open the context menu
of Hydraulic head > Isolines in the View Compo-
nents panel with a right-click and select Properties.
Several editing options are available: In the Iso tab, the
isolines settings can be changed. Use a Prescribed

Figure 9.3 Plotting on selected geometries in 3D.
cbcilt=SKO=ö=TN
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interval for isolines, deactivate the Automatic
option and enter 0.25 as constant isoline interval.
Switch to a Fixed color source for the labels on the
tab Color and click Apply to confirm the changes. 

To hide the legend of a particular parameter style
open the context menu of the style entry in the View
Components panel and uncheck Legend Display. 

To edit the number format of the displayed parame-
ter legend select Number Format in the context
menu of Hydraulic head in the View Components
panel. Here, switch to Fixed floating-point and change
the number of significant digits to 2. Clicking

OK confirms the changes and the legend is now
displayed with the new settings.

The data range of the parameter plot and also the

Figure 9.4 Hydraulic head values displayed as continu-
ous, fringes and isolines plot.
color scheme are edited in the Properties panel of
the parameter. To open the panel right-click on
Hydraulic head in the View Components panel and
select Properties. Uncheck the box in front of

Auto-update range and set a new minimum value
of 34 m and a maximum value of 42 m for the
data range. The changes are confirmed with a click on

Apply. Uncheck Hydraulic head > Fringes in the
View Components panel. At the grey parts of the

model the hydraulic-head values exceed the defined
minimum and maximum values for the hydraulic-head
display. To plot these zones of the model with the same
color as the minium and maximum values, check the
option Tolerate Outliers in the Properties panel
and click on Apply. Both the parameter plot and
the legend in the active view reflect the now tolerated
outliers.

To change the color style of the parameter plot
right-click in the colored sidebar and switch to one of
the available presets, e.g., the FEFLOW Classic style.
The changes are immediately applied and displayed in
the active view.

VKVKQ `äáééáåÖ=~åÇ=`~êîáåÖ

Go to Window > New > 3D View to open a new
window. In the Navigation panel click on the Pro-
jection tab on the right-hand side of the panel and
move the Scaling slider bar upwards to stretch the
model and to add some vertical exaggeration for better
visibility of the different layers. 

 In the Planes panel six different planes avail-
able for clipping and carving are displayed. Activate
the plane in the second box by setting the check mark
in front of Active. All parts located on the yellow
(front) side of the plane are now clipped away. To
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change the position of the plane open the Plane defini-
tion dialog by clicking into its view in the Planes
panel. Use the slider bars to change the offset or the
normal vector. Confirm the settings with Apply
and leave the dialog with Close.

Now activate plane number 4 and select the option
Carving for both planes. Now, only the features on

the yellow sides of both planes are cut away. 
Visualization examples with carved models are

shown in Figures 9.5 and 9.6.

Figure 9.5 Carving planes and carved model domain in
3D view.
VKVKR pÅÉåÉ=iáÄê~êó

We use the Scene Library panel to store the set-
tings of some of the views that we have just created.
Right-click into the current 3D view and select

Create Scene from Window. The stored scene now
appears as a tile in the Scene Library. To show a large
preview of the scene, place the mouse cursor on the
icon. A large preview, the name of the scene and the
creation date and time are now displayed.

To rename the scene, click on its icon and press
<F2>. For better identification of the scene, we also
add a comment in addition to the name. Right-click
onto the scene’s icon and select Edit Scene Proper-
ties. Add a comment to the scene and confirm with

OK.
We now create a new folder in the Scene Library.

Right-click into an empty part of the panel and select
Create Folder. To rename the folder, click on it and

Figure 9.6 3D visualization example.
cbcilt=SKO=ö=TP
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press <F2>. In order to view the folder structure within
the Scene Library, select Show Folders from the
context menu of the panel. 

To store a scene in this specific folder, double-click
on it before creating a scene. Next, switch to the Slice
view and use the context menu of the view to create a
scene of this view as well. The scene now appears in
the subfolder and not in the main level of the Scene
Library. 

To move the stored scene to the main level, click on
the scene and move it to the entry Scene Library while
keeping the <Shift> key pressed. Dragging and drop-
ping a scene to a different location in the library with-
out pressing the <Shift> key creates a copy of the scene
instead of moving it.

Close the currently open Slice view. To create a new
view from the stored slice-view scene, double-click on
its icon in the Scene Library or use Create View
from Scene in the scene context menu.

Figure 9.7 Scene Library panel.
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The task of assigning model parameters is in many
cases repeatedly performed during model setup and
application. After the initial parameterization, model
properties may have to be changed during calibration,
or parameters need to reflect different scenarios. Thus
the work flows for parameter assignment are crucial for
the efficient handling of a groundwater model. 

Typical assignment procedures are based on the
activation of a property to be assigned and the selection
of the target nodes or elements. The tools for selecting
nodes or elements are described in detail in chapter 8. 

There are some exceptions from this standard work-
flow: When working with map data, FEFLOW pro-
vides the means to automatically activate a parameter
and/or select the target geometry based on information
in the map or linked to the map.

NMKO fåéìí=m~ê~ãÉíÉêë

FEFLOW distinguishes between seven groups of
parameters, all of them visible on the first level of the
tree view in the Data panel (Figure 10.1): 
• Geometry
• Process Variables
• Boundary Conditions
• Material Properties
• Auxiliary Data
• User Data
• Discrete Features

Figure 10.1 Data panel.
NM
m~ê~ãÉíÉê=^ëëáÖåãÉåí
Input of initial and boundary conditions, material properties, user data and discrete features 
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The Geometry section of the Data panel contains
the option to set mesh elements active or inactive for a
simulation and the node elevation values in 3D models.
While process variables (including initial conditions
and with the exception of elemental Darcy fluxes) and
boundary conditions are defined on the mesh nodes,
material properties representing the characteristics of
the medium are assigned on an elemental basis. Auxil-
iary data cannot be edited or assigned but can be used
to check some properties of the finite-element mesh or
to visualize stream functions in 2D models. User data
are additional nodal or elemental distributions that can
also be based on user-defined expressions. Assignment
and usage are discussed in section 10.5.2. Discrete fea-
tures can be added along element edges or faces to rep-
resent high-conductivity features or they can connect
two arbitrary nodes. 

NMKOKN dÉçãÉíêó

With the elemental parameter In-/active Elements
mesh elements can be activated or deactivated during
the entire simulation or only at specific time stages. By
default, all mesh elements are active after mesh genera-
tion. More information on the handling of inactive ele-
ments can be found in chapter 6.7.

In 3D models, the elevation is included in the geom-
etry section as a nodal parameter. In models with a
fixed mesh, the elevation does not change during the
simulation. In models representing a phreatic surface
with the free & movable approach (see 7.1.5), the
actual nodal elevation changes during the course of the
simulation. The parameter Reference Elevation pre-
serves the original node elevations.
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Process variables include the primary variables
hydraulic head, mass concentration, mean age, mean
lifetime expectancy, exit probability and temperature
(as applicable). When setting up the model, they
describe the initial conditions. During and after the
simulation these process variables reflect the then-cur-
rent conditions.

Other process variables contain values derived from
the original primary variables. For example, pressure is
not stored separately in FEFLOW, but calculated from
hydraulic head and elevation ‘on the fly’. When these
secondary parameters are used as input variables, the
input is converted into the original primary variable
based on current conditions. 

The third type of process variables are auxiliary
variables supporting results evaluation and visualiza-
tion, such as Darcy flux, rate and period budget and
streamlines or pathlines. They cannot be used as input
parameters. 

NMKOKP _çìåÇ~êó=`çåÇáíáçåë

By default, all model boundaries in FEFLOW are
impervious. To allow flows into or out of the model,
boundary conditions have to be defined. FEFLOW sup-
ports four basic types of boundary conditions for flow,
mass, groundwater age and heat transport which can be
defined as constant over time or time-varying values.
For flow and heat transport,   additional fifth boundary
condition types are available: 

• Dirichlet-type BCs: 
Hydraulic-head BC / Mass-concentration BC /
Temperature BC
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• Neumann-type BCs:
Fluid-flux BC / Fluid-flux BC (Gradient) /
Mass-flux BC / Heat-flux BC

• Cauchy-type BCs:
Fluid-transfer BC / Mass-transfer BC / Heat-
transfer BC

• Nodal source/sink type BCs:
Well BC / Mass nodal sink/source BC / Heat
nodal sink/source BC

• Multilayer Well (flow)
• Borehole Heat Exchanger (heat transport)
For groundwater age, only the first boundary condi-

tion type is displayed by default and additional types
have to be added via the respective context menu in the
Data panel. 

Except for Borehole Heat Exchangers, the sign con-
vention for boundary conditions in FEFLOW defines
flows out of the model as positive (e.g., well abstrac-
tion), while inflows are negative (Figure 10.2). Nota-
bly, this convention differs from other parts of
FEFLOW, such as the Rate- and Period-Budget or the
Subdomain Boundary Rate and Subdomain Bound-
ary Period Budget panels or the definition of con-
straints, where inflows are considered as positive,
outflows as negative (Figure 10.4).
aáêáÅÜäÉíJíóéÉ=_`ë
This boundary condition type - often also referred to

as Dirichlet or 1st kind boundary condition - specifies a
time-constant or time-varying value for the primary
variable at a node, i.e. hydraulic head for flow, concen-
tration for mass transport, groundwater age and life-
time expectancy, probability of exit and temperature
for heat transport. The inflow or outflow to/from the
model domain at the node can be calculated from the
simulation result.

In certain model types, such as unsaturated or den-
sity-dependent simulations, it is possible to derive the
primary variable hydraulic head from input such as:

• Pressure
• Saltwater Head
• Saturation
• Moisture Content
While converting input from a different quantity in

these cases, and providing the possibility to visualize
the boundary conditions in terms of another quantity,
the actual boundary condition stored and used during
the simulation is always a Hydraulic-head BC. 

Figure 10.2 Algebraic signs for boundary conditions.
cbcilt=SKO=ö=TT
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The flux-type boundary condition describes an in-

or outflow of water/mass/energy at element edges (2D)
or element faces (3D). Though nodally defined, the
condition must be applied for at least two adjacent
nodes (2D) or all nodes of a vertical or horizontal ele-
ment face (3D) to be effective. The given value in flow
simulations is a Darcy flux perpendicular to the bound-
ary. An optional alternative formulation for unsaturated
models allows the definition of a hydraulic-head gradi-
ent instead of the Darcy flux.

The successful application of Mass-flux BCs and
Heat-flux BCs is linked to the application of the con-
vective or divergence form of the transport equation
(7.3.3). The FEFLOW Book and the help system
should be consulted for details.

Figure 10.3 Flux and transfer boundary conditions in 3D
model.
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Fluid-transfer BCs can be used to describe rivers,

lakes, and known hydraulic heads in a distance from
the model boundary (sometimes called ’general head’
boundaries). The condition is used to apply transfer
properties between a reference value for the primary
variable (hydraulic head, concentration, or tempera-
ture) and groundwater. Thus the value of the boundary
condition is a reference hydraulic head (e.g., river
water level), reference concentration, or reference tem-
perature. The hydraulic conductance (e.g., properties of
a clogging layer), mass-transport conductance or ther-
mal conductance are defined as material properties on
elements adjacent to the boundary condition. Similar to
the Neumann-type BC the transfer boundary condition
must be specified along a line (2D) or for an entire ele-
ment face (3D—Figure 10.3). 

kçÇ~ä=ëçìêÅÉLëáåâJíóéÉ=_`ë
Well BCs and their counterparts for mass and heat

transport simulation are nodally applied and represent a
time-constant or time-varying local injection or
abstraction of water, mass or energy at a single node or
at a group of nodes. 

If it is intended to simulate a well screened in differ-
ent layers it is recommended to use the multilayer-well
boundary condition.

The successful application of Mass nodal sink/
source BC and Heat nodal sink/source BC is linked to
the application of the convective or divergence form of
the transport equation (7.3.3). The FEFLOW Book and
the help system should be consulted for details.
TU=ö=rëÉê=j~åì~ä
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In 3D models, multilayer-well boundary conditions

can be used to simulate water injection/abstraction via
a well screen. The screen can extend over one or multi-
ple model layers. 

The well radius and screen top and bottom together
with the well capacity are used as input parameters for
this boundary condition. Internally, the total injection/
abstraction rate is assigned at the bottom-most node of
the well and a highly conductive 1D discrete feature is
placed along the well screen. Flow within the well
along the screened interval is simulated via the Hagen-
Poiseuille (cubic) law. The appropriate parameters of
the discrete feature are derived from the specified well
geometry.

The properties of a multilayer well are defined in
the Multilayer Well Editor dialog. The dialog is
invoked by activating the boundary condition in the
Data panel and double-clicking on Multilayer Well in
the Editor toolbar.

The partitioning of the injection/abstraction rate to
the different model slices/layers that are part of the well
screen depends on the surrounding material properties
and hydraulic-head distribution and therefore is a result
of the simulation. It is calculated from the model
results and can be visualized as a property of the multi-
layer well during and after the simulation run. 
_çêÉÜçäÉ=eÉ~í=bñÅÜ~åÖÉêë
Borehole heat exchangers are used to simulate

closed-loop geothermal installations. A refrigerant cir-
culates within closed pipes and heat exchange with the
surrounding aquifer system is solely driven by thermal
conductivity. 

Borehole heat exchangers are represented as
embedded 1D elements and linked to the FEFLOW
nodes along join edges in a 3D model. 

To define the inflow boundary of a heat exchanger,
a time-constant or time-varying flow rate of the circu-
lating refrigerant and the inflow temperature are
required. While the flow rate is always directly speci-
fied, FEFLOW provides the following four options for
the definition of the inflow temperature, each of them
possibly also being time-varying:

• Inlet Temperature
• Heat-input Rate
• Temperature Difference
• Power
Additionally, the properties of the refrigerant and

the components of the borehole heat exchanger need to
be specified in a so-called Borehole Heat Exchanger
Data Set that can be used for a number of BHEs.

FEFLOW supports four different heat-exchanger
geometries:

• Double U-shape
• Single U-shape
• Coaxial shape with annular inlet
• Coaxial shape with centered inlet
The processes within heat exchangers can be mod-

eled via an analytical, quasi-stationary approach in
which a local thermal equilibrium between all heat-
exchanger components is assumed or via a numerical,
fully-transient approach. The latter provides higher
accuracy for short-term (time ranges of few hours) pre-
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dictions especially for conditions with quickly chang-
ing inflow temperatures. For long-term predictions
with less frequent and only moderately changing
inflow temperatures, the quasi-stationary method pro-
vides reasonably accurate results at much lower com-
putational cost.

Borehole heat exchangers are defined in the Bore-
hole Heat Exchanger Editor which is invoked by acti-
vating Borehole Heat Exchanger in the Data panel
and double-clicking on the same entry in the Editor
toolbar.

For the simulation of arrays of borehole heat
exchangers, FEFLOW provides the possibility to con-
nect BHEs serially or parallely. 

_çìåÇ~êó=`çåëíê~áåíë
In FEFLOW, all boundary conditions can be physi-

cally constrained. For example, a fixed hydraulic-head
condition at a certain node can be limited by a maxi-
mum or minimum flow. Technically, these constraints
are realized by temporarily changing the respective
boundary condition. If the flow at a fixed head bound-
ary condition would exceed the maximum flow set as a
constraint condition, the corresponding boundary con-
dition is internally transformed into a well boundary
condition with the value of the maximum flow, and the
time step is repeated. Because this test is performed for
all affected nodes at every time step, considerable com-
putational effort can be associated with the use of
boundary constraints.

Constraints are typically complimentary to the
respective boundary condition, i.e., head-type bound-
ary conditions are constrained by minimum/maximum
flow, while flux-type conditions are constrained by
minimum/maximum head. Exceptions from this rule
include additional constraints for transfer boundary
conditions (to limit the infiltration at disconnected riv-
ers) and for all transport boundary conditions (to limit
their application to a certain range of hydraulic head). 

Boundary constraints are not shown in the Data
panel by default. They can be added to the tree by using
the context menu of the corresponding boundary condi-
tion.

 

jçÇìä~íáçå=cìåÅíáçåë
In transient models, boundary conditions can be

modified by applying a time series (see section 10.4 for
more information on time series) as a modulation func-
tion. The modification is realized by multiplying the
time-series values of the modulation function with the
boundary condition value at each time step during the
simulation. 

This functionality can be used, e.g., to modify
boundary condition values for calibration purposes or
to distribute a total value onto a number of nodes and
also to turn boundary conditions off temporarily if
modulation functions contain gaps: Time-series gaps
are defined as ‘NAN’ (not a number) values and the

Figure 10.4 Algebraic signs for boundary constraints and
budget.



NMKO=fåéìí=m~ê~ãÉíÉêë
multiplication of NAN values with boundary condition
values again leads to the result ‘NAN’ which deacti-
vates the boundary condition. The same modulation
function can be applied to an arbitrary number of
boundary conditions with different values or time
series at the same time. This reduces the effort for turn-
ing a large number of boundary conditions off at the
same time significantly compared to defining gaps for
each boundary condition separately.

As for boundary constraints, modulation functions
are not displayed in the Data panel by default but have
to be added to the list of available parameters using the
context menu of the respective boundary condition(s).

NMKOKQ j~íÉêá~ä=mêçéÉêíáÉë

The material properties describe the relevant char-
acteristics of the porous medium for the considered
flow and transport processes to be simulated. They are
defined on an elemental basis. 

For the flow simulation, material properties encom-
pass quantities such as hydraulic conductivity in differ-
ent directions according to the selected anisotropy
model, drain-/fillable porosity (specific yield) and spe-
cific storage (compressibility), and transfer rates (e.g.,
to represent river-bed conductance). Parameters such
as source/sink or in/outflow on top/bottom (often used
for groundwater recharge) are mathematically close to
boundary conditions; however, their typically distrib-
uted spatial reference justifies their placement in mate-
rial properties.

NMKOKR ^ìñáäá~êó=a~í~

In Auxiliary data, nodal and elemental distributions
are available that provide information on different
properties of the finite-element mesh. For 2D models,
the flow field can also be visualized using stream func-
tions. Auxiliary data cannot be edited by the user, but
the distributions are automatically updated according
to changes in the mesh geometry.

In 2D models, the two elemental distributions Max.
interior angle of triangles and Delaunay criterion vio-
lations exist which can be used to check the mesh qual-
ity. In 3D models, the additional distributions Slice
distance and Layer thickness are provided which can
also be used as parameters in the Expression Editor.
For 2D models, a nodal distribution for the Vorticity
stream function is available. In transport models, the
elemental distribution et Number is available which
can be used to check whether the spatial discretization
is sufficiently fine for a specific transport problem. As
the calculation of the et Number is based on velocities,
parameter values are only available during a simula-
tion.

NMKOKS rëÉê=a~í~

Arbitrary nodal or elemental distributions of user
data can be created via the Data-panel context menu.
They can be assigned and visualized like the ’regular’
FEFLOW parameters, but the distributions are cur-
rently limited to time constant data. 

User data can provide input for the FEFLOW
Expression Editor (e.g., for defining kinetic reactions
in multispecies transport), they can be used for storing
the data needed by FEFLOW plug-ins (see 16), or for
comparing the model results to certain reference condi-
tions.

User data can also be expression-based parameter
distributions. In this case, the values of a distribution
are calculated on the fly based on the user-defined
cbcilt=SKO=ö=UN
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expression. Expression-based distributions can be used,
for example, to dynamically plot the water table draw-
down at different simulation times. 

FEFLOW offers a set of predefined distributions to
display the error norms (normalized predictor-corrector
errors) for flow, mass, groundwater age and heat. In
transport models with multiple chemical or age species,
a separate distribution for each species is available. 

NMKOKT aáëÅêÉíÉ=cÉ~íìêÉë

Discrete features can be added to models to repre-
sent highly conductive one- or two-dimensional fea-
tures, such as tunnels, pipes, drains, faults or fractures. 

They are finite-elements of a lower dimension than
the basic finite-element mesh, i.e., onedimensional dis-
crete features can be added in both 2D and 3D models,
while two-dimensional discrete features are only avail-
able in 3D models. 

Discrete features are assigned along element edges
(1D) or faces (2D) or they can connect two arbitrary
nodes within the mesh. In the latter case, interaction
between the arbitrary discrete feature and the finite-ele-
ment mesh is only possible at connected mesh nodes.

Discrete features can be added via the context menu
in the Data panel at locations where an edge or face
selection is active or where an arbitrary node path has
been defined. 

For each discrete feature, geometry and flow and
possibly also mass-, age- and heat-transport properties
need to be defined. For the simulation within discrete
features, the user can choose between three different
flow laws: 

• Darcy
• Hagen-Poiseuille
• Manning-Strickler
By default, the entire feature is turned off if the
pressure of all nodes belonging to a discrete feature
drops below zero. In case that at least one, but not all
discrete-feature nodes are located in an area with nega-
tive pressure, the conductivity of the discrete feature is
scaled by a smoothing function.

NMKP ^ëëáÖåãÉåí=çÑ=`çåëí~åí
s~äìÉë

The most basic approach for data assignment is the
input of time-constant parameter values at the currently
selected mesh items (see 8). Precondition for the
assignment is that a single target parameter has been
activated in the Data panel by a double-click or via the
context menu. An active parameter is indicated by bold
letters. 

The assignment of a constant value for the parame-
ter to the target selection is executed by typing the
value into the input box in the Editor toolbar and click-
ing the green check mark button immediately to the
right of the input box (or hitting <Enter> on the key-
board). If the units of the current input value differ
from the current parameter units, the unit can be typed
in with the parameter. Units recognized by FEFLOW
are accepted and automatically converted.

NMKQ ^ëëáÖåãÉåí= çÑ= qáãÉ
pÉêáÉë=a~í~

NMKQKN qáãÉ=pÉêáÉë

The input of time-varying boundary-condition data
is based on time series. Once defined, a time series can
be used for multiple boundary conditions. Time series
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can also be used for the assignment of time-varying
material properties, boundary constraints or modula-
tion functions.

Time series can be imported from files (*.pow for-
mat) or directly be defined and edited in the Time-
Series dialog that is opened via the Edit menu. A third
option is to paste tabular data copied from, e.g., Micro-
soft Excel/Access or simple text editor files, directly
into a time series in the editor from the clipboard. 

A time series consists of a unique ID and an arbi-
trary number of (time, value) data pairs. Optionally, a
name can be specified for each time series. The time
intervals do not have to be equal. When defining time
series, it should be considered that automatic time-step-
ping procedures make sure to meet each time value
with a time step, so that short-interval time series may
lead to higher numbers of calculation time steps. Inter-
polation between the data pairs can be defined as linear,
constant (step function) or Akima/Akima2. 

Time series can be applied to the model cyclically,
i.e., a time series defined for part of the simulation time

Figure 10.5 Time-series editor.
is applied repeatedly until the end of the simulation, or
they can be used in linear mode. If the time series only
covers a part of the simulation time in linear mode, the
first value is used from the simulation start to the
beginning of the time-series definition, and the last
value in the series is applied until the end of the simula-
tion. 

Time series can also contain gaps to turn a boundary
condition off during specific time intervals or to limit
the application of a boundary condition to a certain
time period. Gaps at the beginning and end of a time
series can be used to make sure that the time-series val-
ues are not applied before the first and after the last
defined time-series step as described above for the lin-
ear time mode. As time-varying material properties
need to be defined for the entire simulation time,
FEFLOW does not allow to use time series which con-
tain gaps for material-property assignment.

råáíë=Ñçê=qáãÉ=pÉêáÉë
By default, time series do not contain any informa-

tion on the units of the time/value pairs and FEFLOW
will use the internal unit of a specific parameter for the
assignment of the time-series data, e.g., [m³/d] for well
boundary conditions and [m] for a hydraulic-head
boundary condition. It is however possible to define the
unit class and user unit for editing the data of a time
series. While the unit class for the Time data is always
time, a time series may contain values of pumping
rates, hydraulic head or concentration. Selecting a user
unit for Value therefore requires prior definition of the
appropriate unit class (e.g., pumping rate, length, con-
centration).
cbcilt=SKO=ö=UP
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Time-series data are assigned similarly to time-con-
stant values. Elevation in 3D models cannot be varied
in time (except by using the programming interface).
Precondition for the time-series assignment is that the
corresponding parameter has been activated in the
Data panel, and that a selection of target nodes or ele-
ments has been made. The input box in the Editor tool-
bar has to be switched to time-series mode. The
assignment is executed by choosing the ID of the time
series to be applied at the selected nodes or elements in
the input box in the Editor toolbar and clicking the
green check mark button besides the input box (or hit-
ting the <Enter> key on the keyboard).

NMKR ^ëëáÖåãÉåí= çÑ= j~é
a~í~

Map information can be used in different ways for
parameter assignment, ranging from using the map
geometry to define targets for interactive data input to
regionalization based on map-attribute data.

The input options for attribute data depend on the
map and target (node/element/face/edge) geometries as
shown in Figure 10.6 and Figure 10.7.
NMKRKN fåíÉê~ÅíáîÉ=a~í~=fåéìí

Interactive data input is chosen in cases where the
map geometry (points, lines, polygons) serves as target
geometry for data input, but the actual values to be
assigned are unrelated to the map. 

This mode can be used in conjunction with the input

Figure 10.6 Map data input for nodal properties.

Figure 10.7 Map data input for elemental properties.
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modes for constant data, time series, or lookup tables in
the Editor toolbar. After hitting the button for point,
line, or polygon input the target geometry in the model
is chosen by clicking the corresponding geometry. All
mesh items within the distance defined in the Snap-
Distance toolbar are assigned the value. Existing selec-
tions are hereby ignored. 

NMKRKO ^ìíçã~íáÅ=a~í~=fåéìí

Many of the map formats compatible with
FEFLOW can contain attribute values, e.g., simple
triplet-text or ESRI-Shape files. These attributes can be
used as the data source for parameter assignment. 

Depending on the type of map data (point, line,
polygon), the properties may be applied to the target
geometries either directly, or via a regionalization algo-
rithm. 

m~ê~ãÉíÉê=^ëëçÅá~íáçå
For all automatic data input, it is necessary to link

the desired map attribute to a target FEFLOW parame-
ter. As this link is stored permanently with the model,
the import can be quickly repeated when the map data
have changed. The link is defined in the Parameter
Association dialog that can be accessed via the context
menu of the respective map in the Maps panel. 

Detailed settings for the data transfer can be defined
in the properties of the link in the Parameter Associa-
tion dialog. Here, it is defined whether the attribute
data are interpreted as distribution of time-constant
parameter values or as the ID of a time series for
boundary conditions or constraints or whether time-
varying material properties are assigned. For time-con-
stant data and for time-varying material properties, the
source data unit can be specified, and, for point data
sources, the regionalization method and its properties
are set. Furthermore, it is possible to relate data to a
certain slice or layer if the slice or layer number is con-
tained in the attribute data of the map. If another map is
defined as the selection map, that map defines the tar-
get geometry. Thus for example an interpolation from
point geometries can be limited to the nodes within a
polygon or along a line obtained from another map.
Either a selection map or a selection can be stored to
easily repeat the data import. 

oÉÖáçå~äáò~íáçå
The regionalization settings are edited in the

Parameter Association dialog as part of the link prop-
erties for point maps. For classic two-dimensional data
interpolation, FEFLOW contains three interpolation
methods with their respective property settings: 

• Inverse Distance
• Kriging
• Akima
The Neighborhood Relationship regionalization

assigns a property to the nearest node, or to a number
of nodes close to a map point. One typical example is
the import of pumping wells in cases where the well
locations have not been considered in the design of the
Supermesh. The wells are then applied at the node
closest to the original well location (Single Target),
and if more than one well is mapped to the same node,
the pumping rates will be summed up (Aggregation:
Sum). 

Corresponding to the Neighborhood Relationship,
the Point in Element regionalization method for ele-
mental properties assigns a value to those elements that
contain a source data point. If more than one point is
located within the same element, the point attribute val-
ues can be either summed or averaged.
cbcilt=SKO=ö=UR
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A 1-dimensional linear interpolation method along
lines is available if a line map has been chosen as the
link selection. Intended mainly for river water levels,
this regionalization provides the means for interpola-
tion between time-constant or time-varying water lev-
els, e.g., for considering the translation of a flood wave
along the river. Extrapolation from the last data point in
direction or opposite to the line direction as well as in
both directions is also supported. 

^ëëáÖåãÉåí
After defining the parameter association link, the

actual data assignment is invoked by clicking the green
check mark in the Editor toolbar presuming the follow-
ing conditions are met: The input field in the toolbar is
in map input mode, the correct map has been selected,
the corresponding parameter is active, and if no selec-
tion map has been chosen as a link property, the target
nodes or elements are selected. All requirements except
the selection can be fulfilled at once by double-clicking
on the entry for the link in the Maps panel, or, includ-
ing the selection, by double-clicking on a previously
stored node/element selection or selection map entry
for the link in the Maps panel. 

NMKRKP ^ëëáÖåãÉåí=îá~=nìáÅâ=fãéçêí

The Quick Import option can be used to assign mul-
tiple attributes of a previously exported map to several
parameters at once without the need for defining
parameter links via the Parameter Association dialog
first. This option is accessible in the context menu of a
map in the Maps panel. Prerequisites for successful
assignment via this option are:

•  The map data has been exported from FEFLOW, 
•  The export and import model are equal or similar
so that slice and layer numbers match for both
models,

• The parameter units in both models match,
• Additional required information, e.g., time series,

Borehole Heat Exchanger datasets are loaded
before performing the quick import.

The import can be limited to specific model param-
eters and/or to the current slice/layer or the current
selection. To match the input data to the mesh ele-
ments, one of the selection methods Select by element
number or Select by nearest element center(s) needs
to be applied in the Quick Import dialog.

NMKS ^ëëáÖåãÉåí= îá~= bñéêÉëJ
ëáçå

Values for the currently active parameter can be
assigned based on user-defined expressions which are
specified in FEFLOW’s Expression Editor. A double-
click in the input field of the Editor toolbar opens the
Expression Editor for editing the current expression or
any of the stored expressions if the Editor toolbar is in
Expression mode.



NMKT=^ëëáÖåãÉåí=çÑ=iççâìé=q~ÄäÉ=s~äìÉë
 
Arbitrary user-defined expressions are set up in the

work area in the center of the dialog. The available
model parameters that can be used within an expres-
sion are listed on the right-hand side of the dialog.
Several toolbars provide access to loading/saving
expressions and to mathematical operators and tem-
plates that can be used for composing equations. 

All parameters and time series as well as the left-
hand side of the equation carry units which can be
inspected via the tooltip of each parameter in the work
area or the list on the right-hand side of the dialog. By
default, the editor uses the user-defined unit which has
been set via the context menu of a parameter in the
Data panel. Changing the unit is possible via the con-
text menu of the respective parameter in the work area
or in the parameter list in the dialog.

Expressions can be stored or renamed using the
context menu of an entry in the list on the left-hand
side of the editor. 

Figure 10.8 Expression Editor.
NMKSKN ^ëëáÖåãÉåí

Values for the active parameter are assigned at
nodes or elements by selecting the currently defined or
one of the previously stored expressions from the drop-
down list of the Editor toolbar and by clicking the
green check mark symbol next to the input field.

NMKT ^ëëáÖåãÉåí= çÑ= iççâìé
q~ÄäÉ=s~äìÉë

NMKTKN iççâìé=q~ÄäÉë

Parameter lookup tables allow the definition of
named properties, e.g., material types, each represent-
ing a set of parameters, such as conductivity, drain-/fill-
able porosity, etc. When assigning a parameter, the
property name can then be used instead of assigning a
value. The definition of the lookup table is located in
Global Settings, accessed via the Tools menu. 

The lookup table is independent of the current
model, so that the properties can be used in different
projects. 

NMKTKO ^ëëáÖåãÉåí

The assignment of parameters from a lookup table
is similar to the input of constant or time-series data.
The input box in the Editor toolbar, however, has to be
in lookup-table mode. The properties in the lookup
table that contain a value for the current input parame-
ter can be selected from a drop-down list. 
î~äìÉë
~åçíÜÉê
çéíáçåK
ÄäÉ= î~äJ
É=ÅçêêÉJ
ë= Ü~îÉ
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Parameter values in the current selection can be
copied to the clipboard and pasted either to the same
nodes/elements of another parameter of the same type
(e.g., Conductivity K_xx to Conductivity K_yy), or to
another slice or layer. For time-varying material prop-
erties, the entire time-dependent material data can be
copied and pasted to another parameter of the same
type. Pasting of parameter values to multiple material
times of a time-varying parameter is also possible.

The Copy and Paste functions are available in the
context menus of the parameters, in the Edit menu, and
in the Standard toolbar. 

NMKV ^ëëáÖåãÉåí= çÑ=jìäíáéäÉ
m~ê~ãÉíÉêë

Besides assigning values to different input parame-
ters one after the other, it is also possible to edit multi-
ple parameters simultaneously. This option can be
accessed via Assign Multiple... in the context menu of
parameters in the Data panel. 

The dialog displays different parameters depending
on the entry via which the dialog was opened. Homo-
geneous values and input units can be changed, the
checkmark in front of a parameter determines whether
a new value will be assigned or not.

The assignment of new values can be applied to the
entire model domain, to the current slice/layer if the
Slice view is the active view or to the current selection
only. 

NMKNM qáãÉJs~êóáåÖ= j~íÉêá~ä
mêçéÉêíáÉë

For the definition of time-varying material proper-
ties, FEFLOW provides a number of different settings
and assignment options. As for time-series, Linear and
Akima interpolation are available for interpolation
between given material times. The defined time-vary-
ing data can be applied to the model cyclically, or it can
be used in linear mode. If the defined time stages only
cover part of the simulation time in linear mode, the
first material-time value is used from the simulation
start until the first defined time stage is reached, and
the last material-time value is used until the end of the
simulation. Time stages can be added and deleted and a
parameter can also be made stationary again, selecting
the material time for obtaining a stationary distribution
for the parameter. All settings are located in Edit Time
Dependency in the context menu of a time-varying
material property in the Data panel. Time-varying

Figure 10.9 Assign Multiple Parameters dialog.
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material properties are indicated by a blue wave sym-
bol in front of the parameter’s name in the Data panel.

Time-varying material data can be inspected using
the Inspection tool. The Inspection panel displays the
current material time and value and also the time-
dependency settings (cyclic/linear, Akima/Linear inter-
polation). The Transient-Data chart in the Inspection
panel shows a preview of the time-series curve for a
time-varying parameter. 

NMKNMKN j~åì~ä=^ëëáÖåãÉåí

To assign time-varying values to a material property
manually, the parameter has to be made transient via its
context menu in the Data panel first. In the Material
Data Time Stages dialog, a list with material times can
be edited manually or imported from a time-series
(POW) file (Figure 10.10).

To assign values to a certain material time, the

Figure 10.10 Material Data Time Stages dialog.
parameter needs to be active, the material time has to
be selected via Material Time in the context menu of
the parameter in the View Components panel. The cur-
rently selected material time is always displayed in the
parameter legend in the active view and shown in the
parameter entry in the View Components panel. The
assignment to the target element selection is executed
by typing the value for the selected material time into
the input field in the Editor toolbar and by clicking the
green checkmark to the right of the input field (or by
hitting <Enter>).

 

NMKNMKO j~åì~ä= ^ëëáÖåãÉåí= Ñêçã
qáãÉ=pÉêáÉë

The assignment of time-varying material properties
via time series is completely analogous to using time
series for boundary-condition assignment (see chapter
10.4.2). As time-varying material properties need to be
defined for the entire simulation period, time series
containing gaps are not supported for material proper-
ties.

 It is only possible to use those time series for mate-
rial-property assignment which carry the same unit
class as the parameter or cardinal units. FEFLOW
hides all time series carrying a different unit class and
does not display them in the input field of the Editor
toolbar. 

NMKNMKP ^ëëáÖåãÉåí=çÑ=j~é=a~í~

For the automatic assignment of time-varying mate-
rial properties via input maps, it is necessary to create a
link between the desired map attribute and the
FEFLOW target parameter in the Parameter Associa-
cbcilt=SKO=ö=UV
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NMK=m~ê~ãÉíÉê=^ëëáÖåãÉåí
tion dialog that is invoked via the context menu of the
input map in the Maps panel. To access the different
options for time-varying material-data assignment in
the Parameter Association dialog, the context menu of
the material property to be edited has to be used. By
default, material properties are assumed to be time-
constant. 

The available settings for the link definition and for
regionalization methods are introduced in chapter
10.5.2. 

After defining the link in the Parameter Associa-
tion dialog, the actual data assignment is invoked by
clicking the green checkmark in the Editor toolbar pre-
suming the following conditions are met: The input
field in the toolbar is in map input mode, the correct
map has been selected, the corresponding parameter is
active, and if no selection map has been chosen as a
link property, the target elements are selected. All
requirements except the selection can be fulfilled at
once by double-clicking on the entry for the link in the
Maps panel, or, including the selection, by double-
clicking on a previously stored element selection or
selection map entry for the link in the Maps panel.

^ëëáÖå=j~íÉêá~ä=a~í~=íç=`ìêêÉåí=qáãÉ
Prerequisite for this assignment is that the parame-

ter to be edited has already been made transient before
accessing the Parameter Association dialog. Addition-
ally, the parameter needs to be set active with a double-
click on the parameter’s name in the Data panel, and
the time stage to be edited needs to be selected via
Material Time... in the context menu of the parameter
in the View Components panel.

 In the Parameter Association dialog, the option
Assign material data to current time needs to be
selected from the context menu of the respective mate-
rial property. The map attribute that contains the data
for the current time stage can then be linked to the
FEFLOW parameter. The Source data unit can be
changed and depending on the format of the input map,
further link properties can be defined. The remaining
necessary steps to complete the data assignment based
on maps are listed in chapter 10.5.2.

^ëëáÖå=j~íÉêá~ä=a~í~=íç=qáãÉ=pí~ÖÉë
For this assignment option, the input map needs to

contain an attribute field for each material time. Select-
ing Assign material data to time stages in the context
menu of a material property in the Parameter Associa-
tion dialog invokes the Material Data Time Stages
dialog in case that the parameter is still time-constant.
Material times can be edited manually or imported
from a POW file. The time stages are displayed as a list
underneath the now time-varying material property.
Each attribute field that contains the values for a spe-
cific time stage needs to be linked to the corresponding
material time. To create multiple links at the same time,
all or several attribute fields that contain time-varying
data can be selected using the <Ctrl> or <Shift> keys
and double-clicking on the first time stage. The selec-
tion order defines which data set will be assigned to
which time stage. It is sufficient to define the link prop-
erties in one of the created links, the settings will auto-
matically be transferred to all remaining links.

^ëëáÖå=qáãÉ=pÉêáÉë=íç=j~íÉêá~ä=a~í~
For this assignment method, no time-series files are

used but the input map contains one attribute field with
all the time stages and a second attribute field with the
parameter values for each time stage. Choosing Assign
time series to material data from the context menu of a
material property in the Parameter Association dialog
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adds the entries Time and Value underneath the mate-
rial property. A link between the map attribute that con-
tains the time stages and the field Time and a second
link between the attribute with the parameter values
and the field Value are required. For both links, the
Source data unit can be changed.

qáãÉJpÉêáÉë=gçáåáåÖ=íç=j~éë
If a map only contains an attribute field with time-

series IDs to be used as input for time-varying material
properties but not the data directly, the required time
series (POW file) can be joined to a map in the Param-
eter Association dialog. Time series can be joined via
Join/Select Map(s) Data in the context menu in the
input map: The field TimeSeriesID in the time-series
file is linked to the attribute field with the time-series
IDs in the input map. Time stages and corresponding
values specified in the time-series file are now avail-
able as attribute fields that can be linked to a material
property. The link is completed following the same
steps as described in the previous section Assign Time
Series to Material Data.

NMKNMKQ ^ëëáÖåãÉåí=îá~=bñéêÉëëáçå

Time-varying material properties can also be
assigned via user-defined expressions set up in the
Expression Editor. All time series loaded to a model
and also the simulation time can be used as parameters
within an expression. The necessary steps to complete
the assignment based on a user-defined expression are
explained in section 10.6.1. 
NMKNN rëÉ= m~ê~ãÉíÉê= bñéêÉëJ
ëáçå

Instead of being defined by time-constant or time-
varying values, the FEFLOW parameters Source/sink
and In/outflow on top/bottom can also be linked to a
user-defined expression to account for dependencies on
other parameters. The defined expressions are evalu-
ated iteratively during the simulation run and the
parameter values are updated according to the specified
dependencies. 

Source/sink and In/outflow on top/bottom are
linked to an expression by selecting Use Parameter
Expression in the respective context menu in the Data
panel. A link to an expression is indicated by a sigma
symbol in front of the parameter in the Data panel.

NMKNO fåíÉê~ÅíáîÉ= Na= iáåÉ~ê
fåíÉêéçä~íáçå

An alternative option to using maps for the interpo-
lation between boundary conditions or constraints
along a line is the Interactive Linear 1D Interpolation.
This assignment tool can be activated in the Editor
toolbar if a boundary condition or constraint is the
active parameter in a Slice view. The interpolation
between time constant values, time series and also val-
ues calculated via the Expression Editor is supported.

The line path along which values are interpolated is
drawn manually with the tool being active. By pressing
<Ctrl> while placing a new vertex, a boundary-condi-
tion or -constraint value can be set together with the
vertex, applying the constant value, time series or user-
defined expression currently entered in the input box of
the Editor toolbar.
cbcilt=SKO=ö=VN
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NMK=m~ê~ãÉíÉê=^ëëáÖåãÉåí
Additional settings for, e.g., the interpolation of
time-varying values or the consideration of already
existing data along the interpolation path are accessible
via the main menu Tools > Global Settings > Tool
Properties.

NMKNP råáíë

FEFLOW uses a standard unit for each parameter
that is listed in the parameter description in the help
system. For parameter input and display, other units
can be applied in one of the following ways: 

• The standard unit for a physical unit (such as
velocity, time, etc.) can be changed globally for
the user interface via Units in the Tools menu.
One of three predefined systems or a user-defined
unit set can be applied. 

• For each parameter, the unit for the active model
can be chosen via the context menu of the parame-
ter in the Data panel. This unit is then the output
and default input unit. This setting is stored within
the *.fem file and applied whenever a specific
model is loaded.

• The unit of the input values can be defined at the
time of input: For manual input, the unit of the
input value can be typed in with the value. When
assigning the value, the unit is automatically con-
verted. For map-based data input, a unit conver-
sion can be specified as part of the Parameter
Association link. 

• For assignment via user-defined expressions, the
user unit of each parameter within the expression
and of the parameter to be assigned can be
changed in the Expression Editor. 
NMKNQ qìíçêá~ä

In the following exercises we use different methods
to assign process variables, boundary conditions, mate-
rial properties and discrete features.

Click Open and load the file parameters.fem.
This model is a 3D transient flow and transient mass-
transport model.

NMKNQKN qççäë

NMKNQKO ^ëëáÖåãÉåí= çÑ= `çåëí~åí= s~äJ
ìÉë

In the first exercise we assign constant values man-
ually. We start with the assignment of boundary condi-
tions for flow and mass transport. 

Set the 3D view active, go to the Data panel and
activate Boundary Conditions (BC) > Fluid flow >
Hydraulic-head BC with a double-click. Next, select
the nodes to which the boundary condition is to be
assigned. We use the node selections displayed in the

Spatial Units panel to set a selection. Double-click

Figure 10.11 Selection toolbar.

Figure 10.12 Editor toolbar.

Figure 10.13 Snap-Distance toolbar.
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on Southern Border to set the selection active. The
selected nodes of the southern border now appear as
yellow spheres. 

Now, enter a value of 32.1 m in the input box of
the Editor toolbar and click Assign. The
selected nodes are now surrounded by blue circles, the
symbol for a 1st kind boundary condition (see figure
10.14). Clear the selection with a click on  and pro-
ceed with the northern border.

Double-click on Northern Border in the Spatial
Units panel to set this node selection active. Enter

46 m in the Editor toolbar and click the green
check mark to assign the value.

We proceed with the assignment of mass-transport
boundary conditions for the two borders. Go to the

Spatial Units panel and click on Domain. In the
Data panel, activate the parameter Mass transport

> Mass-concentration BC. In the Spatial Units
panel open the context menu of Southern Border. This
time, select the option Add to Current Selection to
select both the southern and the northern border. Type a
value of 0 mg/l in the Editor input box and click

Assign. 

Figure 10.14 Boundary conditions at southern border.
To ensure a free outflow of mass at these borders we
add a constraint. First, click on Domain in the

Spatial Units panel again. In the Data panel,
open the context menu of Mass-concentration BC and
select Add Parameter > Min. mass-flow con-
straint. Double-click on Min. mass-flow constraint,
enter 0 g/d in the input box of the Editor tool-
bar and assign the value with a click on the green check
mark. The constraint will limit the applicability of the 0
mg/l fixed-concentration BC to flow entering the
model domain (here treated as positive). At BC nodes
with outgoing (here negative) flow, the fixed-concen-
tration BC will be replaced by the constraint. The mini-
mum constraints are displayed as white bars below the
boundary-condition symbols in the model. Make sure
to clear any selection before proceeding to the next
assignment.

Figure 10.15 Adding boundary constraints.
cbcilt=SKO=ö=VP
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 We assume a mass source that is defined as time-
varying mass-flux boundary condition in our model.
We therefore use a time series to assign time-varying
boundary condition values. 

Open the Time-Series Editor via Edit > Time
Series. The ID list on the top left of the dialog is still
empty and shows that the model does not contain any
time series yet. To load the time series click on

Import and choose the file massflux.pow. 
This file contains one times series with the ID 10

that is now added to the time-series list. Before the time
series can be assigned, we need to include a gap in the
series in order to turn the boundary condition off during
a specific time period. Additionally, we need to define
the unit class of the time-series values. The time-series
graph currently shows a linear increase of the mass flux
between days 60 and 90. In order to deactivate the
boundary condition between these two time stages, we
include a gap after day 60. To do so, click into the line
for day 60 in the time/value list on the right-hand side
of the editor and then click on Insert Gap. 

Figure 10.16 Time series including a gap.
Both the time/value list and the time-series graph
now reflect that the boundary condition will be turned
off between days 60 and 90 (see Figure 10.16.).

To change the unit class of the time-series values,
right-click on Value, select Change Unit Class and
then click on Integrated mass rate. The displayed
user unit now switches from cardinal to [g/m²/d].

Click on Apply and OK to confirm the
changes and to leave the dialog.

Make sure that the Slice view is the active view and
that Slice 1 in the Spatial Units panel is selected.
Double-click on Mass transport > Mass-flux BC in the

Data panel and also on the stored node selection
Mass Source to set the selection active. To assign the
time-varying mass flux, click on the symbol in the
input box of the Editor toolbar until it switches to

Time Series input mode and the time series for the
mass-flux boundary condition is displayed. Complete
the assignment with a click on Assign. The time-
varying character of the boundary condition is indi-
cated by a white wave symbol on top of the boundary
condition in the active view. The time-series ID is also
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displayed next to the BC symbol (Figure 10.17).

NMKNQKQ ^ëëáÖåãÉåí=çÑ=j~é=a~í~

NMKNQKQKN fåíÉê~ÅíáîÉ=a~í~=fåéìí

To complete the boundary conditions we assign a
fixed concentration (1st kind Mass BC) to the nodes of
the two contamination sites.

Instead of creating a selection prior to the parameter
assignment, we perform the assignment using the map
geometry as target geometry.

First, click on Slice 1 in the Spatial Units panel
when the Slice view is the active view. Activate the
parameter Mass-concentration BC in the Data
panel. Double-click Supermesh > Polygons in the

Maps panel. Enter a concentration of 500 mg/l
and switch to the now active tool Assign Data by
Map Polygon located in the map-assignment tools next
to the input field of the Editor toolbar. Reduce the
Snap distance to 1 m in the Snap-Distance

Figure 10.17 Time-varying mass-flux BCs.
toolbar to limit the selection to the nodes within the
contamination sites. Clear any active node selection
with a click on . Move the mouse cursor over the
contamination sites until they are highlighted. Assign
the concentration with a single click into each of these
areas. The boundary conditions now appear as blue cir-
cles around the nodes.

NMKNQKQKO =^ìíçã~íáÅ=a~í~=fåéìí

m~ê~ãÉíÉê=^ëëçÅá~íáçåI=oÉÖáçå~äáò~íáçå=~åÇ=
^ëëáÖåãÉåí
Having the boundary-condition assignment com-

pleted we proceed with the assignment of material
properties. To assign values for hydraulic conductivity
and recharge we use some of the maps that are included
with the model. These contain attribute values which
have to be linked to the respective FEFLOW parame-
ters.

Start with assigning hydraulic-conductivity values
to the top layer of the model. Go to the Maps panel
and open the context menu of the map conduc2d with a
right-click. Select the entry Link to Parameter to

Figure 10.18 Highlighted contamination site (left) and
assigned boundary conditions (right).
cbcilt=SKO=ö=VR
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open the Parameter Association dialog.
The list on the left hand side contains the attribute

data which are stored in the map. Click on CONDUCT.
To link these data to the FEFLOW parameter now dou-
ble-click on Material Properties > Fluid flow > Con-
ductivity K_xx in the list on the right hand side. A
black line shows the created link. The link properties
are edited in the table below.

 Leave the Link Type as Time constant data and set
[10-4 m/s] as source data unit for the conductivity val-
ues. Do not change the fields Element/Layer Selection
and Default Link Selection. 

As the map contains point data, we need to define a
regionalization method for data assignment. 

From the list of available methods select the Akima
method. Set a Linear Interpolation Type and choose 3
Neighbors and 0 Over-/Under Shooting. Confirm the
link settings and leave the dialog with  OK. 

To assign the linked conductivity data, make sure
that the Slice view is the active view and double-click
on the entry for the link in the Maps panel. Con-
ductivity K_xx now becomes the active parameter in
the Data panel, the assignment mode is changed to

Maps and the correct map for assignment is auto-
matically set in the input field of the Editor tool-
bar. 

 Browse to slice 1 in the Spatial Units panel.
Now, select all elements of the top layer with a click on

Select All. To assign the data click the green check
mark in the Editor toolbar. 

NMKNQKQKP ^ëëáÖåãÉåí=îá~=nìáÅâ=fãéçêí

To demonstrate how all or multiple exported model
parameters can conveniently be reimported into the
same model or an alternative scenario of the same
model we export all boundary conditions and then reas-
sign them using the Quick Import option. 

To export all flow and mass-transport boundary
conditions into one file, right-click on Boundary Con-
ditions (BC) and select Export Data > All Nodes
and save the file as boundary_conditions.shp. Con-
firm the automatic import of the map into the current
model with Yes. The map
boundary_conditions.shp now appears under Exported
Maps in the Maps panel.

To illustrate that all boundary conditions are
assigned correctly via the Quick Import, we delete all
boundary conditions first. The fastest option to do this
is again to right-click on Boundary Conditions (BC) in
the Data panel and to select Assign Multiple.
Make sure that the setting Apply to entire model
domain is active and confirm the deletion with

OK.
Now, go to the Maps panel, right-click on the

map boundary_conditions and select Quick
Import... from the context menu. Make sure that all the
boundary-condition types that we want to reimport are
checked. Choose the option Select by node number
as Node Selection Mode and Apply to entire model
domain as Model Domain (see Figure 10.19). After
clicking on OK all fluid-flow and mass-transport
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boundary conditions are reimported.

NMKNQKR ^ëëáÖåãÉåí=îá~=bñéêÉëëáçå

The hydraulic conductivity in z-direction is
assumed to be smaller by a factor of ten than the con-
ductivity in x-direction. To assign the conductivity val-
ues in z-direction, a user-defined expression is applied.

In the Data panel, double-click on Conductivity
K_zz. Right-click on the symbol in the input box of the

Editor toolbar and switch to Expression assign-
ment mode. Open the Expression Editor with a dou-
ble-click on Current Expression in the Editor
toolbar. Delete Current in the working window and
open Material Properties > Fluid flow > Conductivity
in the list of model parameters on the right-hand side of
the dialog. Double-click on CONDX and then click on
the Insert a fraction template symbol. To com-
plete the expression, click into the blue input box and

Figure 10.19 Assignment via Quick Import.
enter 10. Hydraulic conductivity in z-direction is
now linked to conductivity in x-direction.

Leave the dialog with Close. Select all ele-
ments of the top layer with a click on Select All in
the Slice view and execute the assignment with a click
on Assign. The completed expression is shown in
Figure 10.20.

NMKNQKS ^ëëáÖåãÉåí= îá~= `çéó= ~åÇ
m~ëíÉ

For the conductivity in y-direction the same values
as for the x-direction shall be applied. To assign the
values we copy the K_xx values to the parameter K_yy.

First, we have to create a selection from which we
want to copy. Again, select all elements of the top layer
with Select All. In the Data panel, open the
context menu of Conductivity K_xx and click on

Copy. Then, right-click on the parameter Conduc-
tivity K_yy and select Paste.

Values cannot only be copied to other parameters
but also to the same parameter on a different slice or
layer. Make sure to click Clear Selection before
proceeding. Browse to layer 3 in the  Spatial Units

Figure 10.20 Expression-based assignment.
cbcilt=SKO=ö=VT
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panel and select all elements of this layer with a click
on Select All. 

Now double-click on Drain-/fillable porosity in the
Data panel and select the option Copy from the

context menu of the parameter. Open the context menu
once more, click on Paste to Slice/Layer and select
layer 1 as target layer. The values for Drain-/fillable
porosity are now copied from layer 3 to layer 1.

NMKNQKT ^ëëáÖå=jìäíáéäÉ=m~ê~ãÉíÉêë

The material properties for mass transport are
assumed to be homogeneous throughout the entire
model domain. Except for the parameters Longitudinal
and Transverse dispersivity the already assigned val-
ues are accepted. 

To edit these two parameters simultaneously, open
the context menu of Material Properties > Mass trans-
port in the Data panel, with a right-click and select

Figure 10.21 Parameter assignment using Copy/Paste.
Assign Multiple... Uncheck all parameters except
for the two dispersivities. Double-click into the Value
field for Longitudinal dispersivity and enter a value of

70 m. Press the <Tab> key on the keyboard and
enter 7 m as Transverse dispersivity value. Make
sure that the option Apply to entire model domain
is selected and confirm the assignment with OK.

NMKNQKU qáãÉJs~êóáåÖ= j~íÉêá~ä= mêçéJ
Éêíó=^ëëáÖåãÉåí

Continue with assigning recharge which in
FEFLOW is treated as a material property. Go to the

Maps panel and select Link to Parameter in the
context menu of the map year_rec to open the Parame-
ter Association dialog. 

The map contains five different data sets which we
will assign as cyclic transient recharge data. To define
time-varying recharge values, open the context menu
of In/outflow on top/bottom in the list on the right
hand side and select the option Assign material data to
time stages. In the Material Data Time Stages dialog,
click on Import... and select the file
material_times.pow to load the time stages for which
the input map contains recharge data. Confirm the
import with OK. The loaded time stages are now
listed below In/outflow on top bottom. Click on the
entry ULTRAWET_Y, hold the <Shift> key and click
on ULTRADRY_Y. To set all links between the map
attributes and the corresponding material times at once,
double-click on 0 [d] on the right-hand side. Black
lines indicate that five links have been defined. Click
on one of the links to display the link settings.

As source data unit for the recharge values keep the
default unit of [10 -4 m/d]. Do not modify the fields
Element/Layer Selection and Default Link Selection.
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As this map is a polygon shape file no regionalization
is necessary to import the data. All necessary settings
are shown in figure 10.22.

 Click on OK to confirm the settings and to
leave the dialog. The link between the map data and the
FEFLOW parameter is now shown in the Maps
panel in the tree year_rec > Linked attributes.

To assign the linked recharge data, reduce the snap
distance to 0 m and follow the same steps as for the
assignment of hydraulic conductivity in section
10.14.4.2

The legend of In/outflow on top/bottom in the Slice
view displays the time stage that the plotted parameter
distribution belongs to.

To use the defined recharge values in cyclic mode,
open the context menu of In/outflow on top/bottom in
the Data panel and select Edit Time Depen-

Figure 10.22 Parameter Association dialog for time-
varying recharge data.
dency > Cyclic.

NMKNQKV ^ëëáÖåãÉåí=îá~=fåíÉê~ÅíáîÉ=Na
fåíÉêéçä~íáçå

 In the next step we assign a time constant boundary
condition via Interactive 1D Linear Interpolation. The
boundary condition is assigned along the outer model
boundary but the interpolation at locations within the
model domain works completely analogously. 

Make sure that the Slice view is the active view and
navigate to the top slice via the Spatial Units panel.
Activate the boundary condition Hydraulic-head BC
with a double click on the parameter in the Data
panel. Once the boundary condition is activated for
assignment, the tool Linear 1D Interpolation
becomes available in the drop-down list of tools
located at the far right in the Editor toolbar. To
use the tool, simply click on it. 

We will define both the geometry and the values to
be used for the interpolation interactively. In the input
field of the Editor toolbar, enter a value of 40
m and click on a node along the model boundary in the
East while you keep the <Ctrl> key pressed. Pressing
<Ctrl> assigns the value, time series or expression cur-
rently entered in the Editor toolbar at the selected
node location while a simple click only adds a vertex
along the interpolation path without a value. The
assigned head value of 40 m is automatically displayed
next to the first vertex. 

Place additional vertices along the outer model
boundary by clicking the left mouse button: A green
line indicates the element edges along which the line
geometry will be placed. As the snap distance is used
for the selection of vertices, make sure that it is large
enough for a convenient use of the interpolation tool.
cbcilt=SKO=ö=VV
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In case that you would like to remove the last vertex
of a line, place the mouse cursor on top of it and then
hit <Del>. 

To finish the line and to start the interpolation
between the defined values and locations, enter 38
m in the Editor toolbar, hit <Ctrl> and then dou-
ble-click on a node at the outer model boundary which
represents the end of the line. To display the interpo-
lated boundary-conditions values, check the entry

Value Label in Hydraulic-head BC in the View
Components panel. An example for interpolated
boundary conditions is shown in Figure 10.23. 

Additional options to ignore boundary-condition
values already assigned along the line geometry during
the interpolation process, options for the interpolation
of time-varying data or extrapolation are accessible via

Figure 10.23 Interpolated boundary conditions.
Tools > Global Settings > Tool Properties > Lin-
ear 1D Interpolation.

NMKNQKNM =jìäíáä~óÉêJtÉää=^ëëáÖåãÉåí

For the wells, we assume that the pumping rate is
time-constant and that the wells are screened over the
entire model depth. 

After switching to the Slice view activate Boundary
Conditions (BC) > Fluid flow > Multilayer Well in the

Data panel. In the Spatial Units panel, set the
join-edge selection Well West active with a double-
click. 

The currently active assignment mode is Multilayer
Well which is shown by the Multilayer Well symbol in
the input box of the Editor toolbar. Double-click
into the input box to open the Multilayer Well Editor
dialog (see figure 10.24).

The preview on the right-hand side of the dialog
shows the well coordinates and the currently selected
join-edges along which the well screen will be placed.

As Capacity, enter a value of 1000 m³/d. For all
other parameters we accept the default values. Set the
Multilayer Well with a click on Assign and leave
the dialog with Close. A red Multilayer Well sym-
bol now indicates the position of the specified bound-
ary condition. Use the Attributes tree in the

View Components panel to display the different
attribute values of the Multilayer Well.

Proceed with the remaining well. In the Spatial
Units panel, double-click on the stored join-edge selec-
tion Well East and open the Multilayer Well Editor
dialog again with a click into the input box of the

Editor toolbar. 
Change the capacity of the well to 500 m³/d and

follow the same assignment steps as described for the
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western well. 
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Reload the model parameters.fem to add a Bore-
hole Heat Exchanger (BHE) to the model. 

First, open the Problem Settings dialog via Edit
> Problem Settings and switch to Include transport
of... Heat on the Problem Class page. Confirm the
changes with Apply and leave the dialog with

OK.
In the Data panel, activate Boundary Condi-

tions (BC) > Heat transport > Borehole Heat

Figure 10.24 Multilayer Well Editor.
Exchanger with a double-click. In the Spatial
Units panel, double-click on the stored join-edge selec-
tion BHE to set the edges active along which the BHE
will be placed.

As a first step, a BHE dataset has to be created that
defines the geometric characteristics of the heat
exchanger and also contains the information on the
properties of the refrigerant and exchanger compo-
nents. Double-click on Borehole Heat Exchanger in
the input box of the Editor toolbar to enter the
Borehole Heat Exchanger Editor. To add a new data-
set, click on Edit borehole heat exchanger datas-
ets and then on Add new borehole heat exchanger
dataset. This creates the new BHE Dataset #1. Alter-
natively, the BHE Dataset Editor can be accessed via

Figure 10.25 Borehole Heat Exchanger Dataset Editor.
cbcilt=SKO=ö=NMN
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Edit BHE Datasets in the Borehole Heat
Exchanger toolbar if the Slice view is the active view. 

Leave the Double U-shape geometry and only
reduce the Borehole Diameter to 0.1 m. The
geometry change is automatically reflected in the bore-
hole sketch at the bottom of the dialog window. For the
Heat-transfer coefficients switch from User-
defined to Computed mode. Confirm the settings
and return to the Borehole Heat Exchanger Editor
with a click on OK.

The BHE data set is now available for assignment
and the geometric properties are displayed in the dia-
log. Two remaining properties need to be defined, the
flow rate of the refrigerant within the borehole pipes
and also the inlet temperature. Instead of applying a
constant inlet temperature, we assign a temperature dif-
ference between the inlet and the outlet of the BHE.
Switch from Inlet Temperature to

Temperature Difference and enter a value of -
3° C. Next, enter a Flow Rate of 30 m³/d. For the
extent in z-direction leave the setting From
Selected Join Edges. The dialog with all settings is
shown in figure 10.26. Assign the Borehole Heat
Exchanger with a click on Assign and leave the
Editor with OK. 

Use the Attributes tree in the View Compo-
nents panel to display the different attribute values of
the heat exchanger.
NMKNQKNO aáëÅêÉíÉJcÉ~íìêÉ=^ëëáÖåãÉåí

Reload the model parameters.fem. 
On slice 3 we assign some onedimensional discrete

features that represent highly conductive fractures. In
the Spatial Units panel, double-click on the stored
slice-edge selection Fractures. Use the slice list in the

Spatial Units panel to switch to slice 3. 
To add discrete features at the selected locations, go

to the Data panel and open the context menu of
Discrete Features. Select Add Slice-Edge Feature
Element > Hagen-Poiseuille (see Figure 10.27).

Figure 10.26 Borehole Heat Exchanger Editor.
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The discrete feature is now added to the Data
panel as Feature 1, The chosen flow law and geometry
type are displayed behind the feature’s name. Change
the name of the feature to Fractures by selecting

Rename... in the context menu of Feature 1.
To show the discrete feature in the active view, click

on Slice 3 in the Spatial Units panel and then dou-
ble-click on one of the discrete-feature parameters in
the Data panel. 

We want to edit the parameter Hydraulic aperture
at all slice-edges belonging to the discrete feature.
Double-click on Hydraulic aperture and also on Frac-
tures in the Data panel to set the edge selection
active again in case that you have already cleared the
selection. Enter a value of 1 m in the input box of
the Editor toolbar and click on the green check-
mark button to assign the value.

Figure 10.27 Adding Discrete Features.
Figure 10.28 Discrete Features in the view and Data
panel.
cbcilt=SKO=ö=NMP
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The FEFLOW user interface keeps all visualization
options available during the simulation. The simulation
progress can thus be conveniently monitored and prob-
lems can be detected early.

 FEFLOW does not separately store initial condi-
tions of hydraulic head or concentration/age/tempera-
ture during the simulation. So the hydraulic-head
process variable contains the initial head values before
the simulation, the current hydraulic head results at
each time step of a transient simulation, and the final
hydraulic head after the simulation. These final results
are also retained when leaving the simulation mode by
clicking Stop in the Simulation toolbar. 

NNKO jçÇÉä=`ÜÉÅâ=

Before running the model, all input parameters and
other model properties should be thoroughly checked.
A basic overview of the model characteristics is pro-
vided in the Problem Summary page in the Problem
Settings dialog. The icon preceding each material prop-
erty in the Data panel indicates whether the respective
parameter is homogeneous or heterogeneous (see chap-
ter 11.6.2).

NNKP oÉëìäíë=lìíéìí

Simulation results can be stored in two different for-
mats: a reduced results file (*.dar) and a full simulation
record (*.dac). Both results files can be recorded at the
same time.

The reduced format contains text output for the
observation points and well locations only. It is espe-
cially useful for automatic output processing with user-
programmed scripts or optimization software such as
PEST. Reduced results files always contain values for
all the time steps.

In contrast, the full simulation record contains all
nodal values of the primary variables (hydraulic head,
concentration, temperature) and of the flow velocities.
By default, results at all time steps are stored. It is pos-
sible, however, to skip a number of time steps between
each output, or to specify the simulation moments for
which output is desired. In the latter case, the automatic
time-stepping scheme ensures that results are calcu-
lated exactly at the prescribed output moments.
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It is also possible to record a results file that only
contains the final time step.

NNKQ oìååáåÖ=íÜÉ=páãìä~íáçå

The handling of the interface is as easy as starting a
tape or video recorder: The Start button in the Simula-
tion toolbar starts the simulation, the Pause button
pauses it, the Stop button exits the simulation mode,
and when the Record button is pressed before starting
the simulation, the results are recorded in a file while
the simulation runs.

All visualization and also some results-evaluation
features (Rate- and Period-Budget panels, Subdomain
Boundary Rate and Subdomain Boundary Period pan-
els, Content panel) can be used during the simulation.
It should be considered, however, that some of these
features might slow down the simulation. Especially
more elaborate visualization options such as isosur-
faces or budgeting may require significant calculation
effort. 

After the simulation finishes, FEFLOW remains in
paused simulator mode. Thus simulation results such as
flow velocities and the solution of the last time step
remain available for postprocessing. Only when exiting
the simulation mode via Stop these data are removed
from memory, and streamline/pathline calculation or
budget analysis are no longer possible. Any postpro-
cessing then requires loading of the full simulation-
record file.

NNKR `çåîÉêÖÉåÅÉ

When solving non-linear problems for steady state,
or for transient conditions with constant or varying
time steps, an Error-Norm chart is shown. Once the
change in results between two subsequent iterations is
below a certain error tolerance (see chapter 7.1.4), the
simulation is terminated. FEFLOW brings up an alert
box and shows a message in the Log panel if no con-
vergence was achieved within the defined maximum
number of iterations. 

In transient simulations with an automatic time-
stepping procedure, the time step is shortened if neces-
sary to achieve convergence. Only if repeated time-step
reductions do not improve the situation, a log message
is shown indicating that time-step reduction failed. The
simulation is continued with the results of the last cal-
culation for the time step. In general, models that show
convergence problems even after greatly reducing the
time-step length should be checked for errors in the
input data or for insufficient mesh resolution. 

NNKS qìíçêá~ä
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Load the file simulation.fem via Open. Before
we start the simulation we want to make sure that all
necessary parameters have been properly assigned, that
the problem settings have been set correctly and that all
necessary settings for later postprocessing have been
made.

Start with the problem settings. Go to Edit >
Problem Settings and open the Problem Summary

Figure 11.1 Simulation toolbar.
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page in the dialog. Here, an overview of key simulation
control and model parameters is presented. The prob-
lem class settings, information on the mesh quality and
boundary condition types and numbers are displayed
(see Figure 11.2). 

Leave the Problem Settings dialog with
Cancel.

To check values at specific nodes or elements we
can use the Inspection tool. Double-click on
Boundary Conditions (BC) > Fluid flow in the

Data panel. All fluid-flow BCs are now displayed
in the Inspection panel. After clicking on

Inspection move the mouse cursor over the nodes
where boundary conditions are set to check the values
that have been assigned there. The value for the respec-
tive boundary condition, the node and the slice number
are shown in the Inspection panel.

Both constant values and time series can be checked
with the Inspection tool. Set the Slice view as active

Figure 11.2 Problem Summary.
view and move the mouse cursor over the nodes where
a multilayer well is set. The assigned time series for the
capacity is then shown in the Transient-Data chart in
the Inspection panel. The well geometry and fur-
ther well properties are also displayed in the

Inspection panel (see Figure 11.3). 

The distribution type of a material property can be
quickly checked in the Data panel. Homogeneous
values are indicated by a  symbol, heterogeneous
values by a  symbol in front of the parameter.

NNKSKP oÉëìäíë=lìíéìí

Before we start the simulation we define how and
where the results should be recorded. Click on

Record in the Simulation toolbar to open the
Record Properties dialog. Check the check box for

Save complete results (DAC file) to create an out-

Figure 11.3 Checking boundary conditions with the
Inspection tool.
cbcilt=SKO=ö=NMT
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put file. Click on Browse to choose the location for
the results file. As we intend to calculate the accumu-
lated mass that leaves the model via the southern bor-
der, we cannot skip any time steps. Leave the dialog
with OK.

NNKSKPKN _ìÇÖÉí=dêçìéë

If time series for the fluid- and mass-rate and period
budget at selected node locations are to be calculated
and recorded, these locations need to be selected and
activated for this kind of budgeting before a simulation
is started.

 In the Spatial Units panel, open the context
menu of the stored node selection Wells and select

Budget-History Charting > BCs to calculate fluid
and mass quantities related to the specified multilayer
well BC that leave the model at these locations. Repeat
the same steps for the node selection Southern Border.
For both selections, a time series will be shown in the
Fluid- and Mass-Rate Budget and Fluid- and Mass-
Period Budget charts.

NNKSKPKO lÄëÉêî~íáçå=mçáåíë

We also import observation points to monitor and
compare the obtained hydraulic-head results at certain
locations against measured water levels. 

Set the Slice view active. In the Maps panel,
open the context menu of the shape file obs_points and
select Convert to > Observation Points. 

In the Observation Points - Column Bindings dia-
log, select the field SLICE as Slice number and
the field TITLE as Label. For the reference data,
set Hydraulic head as Parameter ID (see Figure
11.4). As the flow equations are solved for transient
conditions, the reference data that the results will be
compared to are loaded from time series and not as
time-constant values. Choose the field TS_ID as
Time series ID. The time series that contain the refer-
ence data have already been loaded to the model. As
Confidence interval, choose CONF_INTER and
confirm the observation-point import with OK.

To check the properties of the observation points,
click on Edit Observation Point Properties in the

Observation-Point toolbar. The reference values
and confidence interval for each observation point are
then displayed in the dialog (see Figure 11.5).

Figure 11.4 Observation Points import.
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After checking the model properties and defining
the record location we start the simulation by clicking

Start in the Simulation toolbar. 
Five different charts appear: Hydraulic Head, Pres-

sure, and since we are simulating transient flow and
transport, also the Time-Steps and Local- and Average-
Concentration charts. Graphs for the well locations
and also for the observation points are displayed.

The elapsed simulation time is shown at the bottom
of every view window.

During the simulation we can display different
parameters in the active view. Go to the Data panel
and double-click on Process Variables > Mass trans-
port > Mass concentration to see how the mass distri-
bution changes with time. 

Figure 11.5 Observation Point Properties.
Open the Rate-Budget panel via View >
Panels and set the check mark in front of Active to
monitor the fluid-rate budget while the simulation is
running. After a short computation time the rate budget
for each boundary condition type, for source/sink
terms, storage capture and release and the imbalance
are displayed. 

Now click Stop to terminate the simulation.
Once the simulation has stopped, notice that the rate
budget is no longer displayed in the Rate-Budget
panel due to the now lacking fluid-flux vector field.
Evaluation of flux-based results is still possible by
loading the simulation record.
cbcilt=SKO=ö=NMV
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As the evaluation of modeling results takes place
both during and after the simulation, the content of this
chapter applies to monitoring the simulation results at
runtime, after finishing the simulation, and after load-
ing a simulation record (postprocessing). 

Results evaluation also involves all visualization
and animation options described in chapter 9 and chap-
ter 13. This section focuses on the tools specifically
designed for output interpretation.

NOKO lÄëÉêî~íáçå=mçáåíë

Observation points are used to monitor simulation
results at specific locations in the model domain via
chart windows. Using the tools in the Observation
Point toolbar, observation points can be defined either
manually in a Slice view, or by converting the current
node selection into observation points. Features of
point maps can be directly converted into observation
points using the context menu of the map in the Maps
panel. The import also allows to obtain a label and slice
or node number for the point from the attribute data of
the map, as well as reference information, typically
from measured field data. Observation points can be
placed on a slice or at an arbitrary xyz position. 

During the simulation, charts are automatically
shown for the results of the primary variables (hydrau-
lic head, concentration, and temperature) at the obser-
vation points. Additional charts, e.g., for pressure, can
be added via the View menu.

By selecting Observation Points as plotting target
(in the Spatial Units panel) for a process variable, the
deviation between computed and measured values can
be displayed in the current view. This includes graphi-
cal comparison of the deviation using error bars and the
confidence intervals, as well as labels showing the
absolute deviation.

Observation points can be added before the start of
a simulation or when a results file is loaded. 

NOKOKN pÅ~ííÉê=mäçí

The deviation between observed data and computed
results can also be shown in Scatter plots. Scatter plots
are invoked via the context menu of the charts for the
primary and process variables. FEFLOW automatically
NO
oÉëìäíë=bî~äì~íáçå
Analyzing the simulation results
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uses the loaded observation data to calculate the devia-
tion. Additionally, the absolute error, the root mean
square (RMS) and the standard deviation are displayed. 

In a results file, the plot always reflects the cur-
rently displayed simulation time.

NOKP _ìÇÖÉí=^å~äóëáë
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The Rate-Budget panel can show the current fluid-,
heat-, or mass rate balance for a selected domain of
interest (DOI) at the current simulation time. A budget
can be calculated for the entire model domain, a selec-
tion of nodes or an arbitrary subdomain consisting of
elements. Any stored nodal or elemental selection can
be used as a DOI either via context menu in the Spatial
Units panel, or by pressing the green ‘plus-sign’ button
in the upper left corner of the budget panel after select-
ing one or more stored selections in the Spatial Units
panel. All budgets set active will be computed and
dynamically updated whenever FEFLOW is in simula-
tor mode, i.e., when the simulation is running, is
paused, or has completed.

The Period-Budget panel shows the accumulated,
i.e., time-integrated budget for the simulation period
specified in the panel. The period-budget calculation
can only be activated before a simulation is started, or
when postprocessing a simulation-record (*.dac) file.
Activating a period budget will implicitly activate the
corresponding rate budget as well.

The respective fluid, heat, or mass balance is subdi-
vided into flows related to the various boundary-condi-
tion types, contributions from distributed sources/sinks
(e.g., groundwater recharge), storage capture (negative)
and release (positive), and a remaining imbalance term
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arising from solver residual error and errors due to the
spatial and temporal discretization. When using an ele-
ment selection (i.e., a subdomain) as DOI, the addi-
tional - Internal Transfer - category appears in the
Rate- and Period-Budget panels. This category repre-
sents the transfer across those parts of the DOI bound-
ary that are inside the model domain. Model-internal
flows crossing the subdomain-boundary into and out of
the DOI are considered as positive and negative,
respectively.

By activating the export option in the Period-Bud-
get panel before starting the budget calculation, the
associated rate- and period-budget values for the speci-
fied simulation period can be exported to a (*.txt) file. 

The budget results of the currently selected time
step can also be exported via Export Current Values...
in the context menu of the Rate- and Period-Budget
panels after the budget calculation.

Figure 12.1 Rate-Budget and Period-Budget panels.
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To calculate the fluid, heat, or mass flow across the
boundary of a specific subdomain within a model, the
Subdomain Boundary Rate and Subdomain Bound-
ary Period Budget panels can be used. While the con-
cept and sign convention of these two panels
correspond to those of the general Rate-Budget and
Period-Budget panels, there are some key distinctions:

• Subdomains are always defined as an element
selection, so only element selections can be used
as DOI for subdomain-boundary budgeting.

• Only the boundary of the subdomain will be con-
sidered in the budgeting.

• Values shown in the BCs category will only
include budget values for those BC-assigned
nodes that are located (1) on the subdomain
boundary and (2) not shared with any part of the
model domain adjacent to the DOI.

• A masking domain can be defined to limit the
extent of the subdomain boundary that is consid-
ered in the budgeting.

If no masking domain is applied, the values shown
in the Internal Transfer category will correspond to
those in the same category of the general budget panel
for a given subdomain, i.e., element selection.

In many cases though, it may be of particular inter-
est to compute the flow through only a part of the
boundary of a subdomain. This is accomplished by
using a second elemental selection as a Masking
Domain (MD). Any stored or the current elemental
selection can be applied as a MD by selecting it in the
Spatial Units panel and pressing the green check mark
button in the Masking Domain (MD) section of the
Subdomain Boundary Rate panel. 

By default, the masking will constrain the budget
evaluation to those parts of the subdomain (DOI)
boundary that also belong to the MD. The MD panel
section also provides an option to invert the masking so
that only those parts of the DOI boundary are consid-
ered that do not belong to the MD.

Subdomain-boundary budgets supersede the now-
deprecated Flow-Rate and Flow-Volume panels whose
results are based on approximated Darcy-flux values
and which are kept for compatibility and comparison
purposes only. As subdomain-boundary budgets are
obtained by using the primary solution together with
the respective terms of the Continuity Equation, they
can be generally expected to be more accurate.

NOKPKP _ìÇÖÉí=dêçìéë

Any stored node selection in the Spatial Units panel
can be used as a separate budget group for which the
summed calculated rate and period budget can be dis-
played as time series in the Rate-Budget and Period-
Budget charts, e.g., to calculate the flow balance along
a river or to determine drained water volumes in dewa-
tering scenarios, etc. 

To invoke this budgeting option and to display time
series for a node selection in the budget charts, Budget-
History Charting and one of the following four bud-
get-evaluation options need to be selected in the con-
text menu of a stored node selection in the Spatial
Units panel: 

• BCs: Flows related to boundary conditions,
• Distributed Sink(-)/Source(+),
• Storage Capture(-)/Release(+),
• Imbalance: Sum of flows related to boundary con-

ditions, distributed sinks/sources and storage cap-
ture/release.

As an additional fifth option, ‘Total Balance’ is
cbcilt=SKO=ö=NNP
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available as a legacy mode which includes flows
related to distributed sources/sinks + boundary condi-
tions, but no budgeting of storage changes.

The budget time series for a stored node selection
can only be displayed in the budget charts if the bud-
geting option for a node selection was activated before
the simulation was started. Adding budget groups to an
existing simulation record is not yet supported.

The calculated summed rate and period budgets can
be exported via the context menu of the Rate- and
Period-Budget charts.

NOKQ jìäíáä~óÉê= tÉääëW= cäçï
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For multilayer wells, the total capacity is internally
associated with the lower-most node that belongs to the
well screen. Therefore, the Rate- and Period-Budget
panels only display the total pumping/injection rate or
volume and not the rates or volumes associated with
each layer. 

To check the flow for each layer that belongs to a
multilayer-well screen, Multilayer well needs to be
plotted in the active view. The entry Flow per Layer in
the list of multilayer-well attributes in the View Com-
ponents panel can then be activated to display the flow
for each layer.

NOKR `çåíÉåí=^å~äóëáë

The Content panel provides access to the values for
various spatially integrated quantities, always at the
current simulation time. Depending on the FEFLOW
problem class of a given model, the panel contains sep-
arate tabs for Fluid, Mass, Groundwater Age and
Heat. In case of multiple chemical or age species, a
separate tab is created for each species. Depending
again on problem class and type, content integration
can provide quantities such as domain size, pore space,
fluid volume, dissolved mass, absorbed mass, heat
energy in fluid and solid phases, etc.

If the entire model domain is considered, discrete
features can be included in the calculation as well.
Alternatively, the current element selection or any
stored element selection (i.e., subdomain) can be used
for content evaluation via the context menu in the Spa-
tial Units panel.  

NOKS píêÉ~ãäáåÉë= ~åÇ= m~íÜJ
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Streamlines and pathlines can be very helpful in
visualizing steady-state and transient flow fields. While
a streamline represents the trajectory of a particle in a
flow field assumed to be constant in time, a pathline
follows a particle in a transient flow field. Pathline
computation therefore requires loading a simulation
record of a transient model. Pathlines and streamlines
are coincident in a steady flow field.

Streamlines and pathlines can be calculated for-
wards or backwards from the starting point. The start-
ing points (seeds) can be set at points, circles around
points, at the surface of a cylinder or sphere or distrib-
uted along lines. Distributed seeds can either be equally
spaced along the starting line, or spaced such that the
distance between adjacent seeds is inversely propor-
tional to the local flux magnitude. 

Streamlines can also be shown during a transient
simulation. In this case, the computed trajectory will
change with the flow field after each time step. 

To visualize travel times of the particles along
streamlines and pathlines, isochrone markers or period
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sections can be used.
The correct calculation of travel times requires the

definition of an effective porosity. For this, one of the
available porosities for the given model type (specific
yield, porosity for unsaturated flow, mass or heat trans-
port porosity) or an arbitrary reference distribution can
be applied. 

For mass-transport models FEFLOW additionally
provides the option to account for retardation due to
Henry-type sorption.

To display streamlines or pathlines, a selection of an
appropriate source geometry in the Spatial Units panel
(node selection, 3D point set, 3D polyline, 3D loop,
cylinder or sphere) is required. Node selections can be
created by storing the current selection, tools for gener-
ating the other 3D geometries are available in the
Drawing toolbar. 

The second important component for streamline/
pathline generation is the Pathlines or Streamlines
entry in the Process Variables section of the Data
panel. Following a double click on either Forward or
Backward the pathlines/streamlines are calculated and
added to the active view. Pathline properties are found
in two different locations: While the effective porosity
for isochrone calculation is selected in the Problem
Settings dialog, view-specific visualization options
such as number of seeds along a line, line width or time
periods for period sections are controlled via the Prop-
erties of the pathlines or period sections entry in the
View Components panel.
NOKSKN o~åÇçãJt~äâ= m~êíáÅäÉJqê~ÅâJ
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Random-Walk Particle-Tracking (RWPT) solutions
can be obtained by proceeding as with standard advec-
tive streamlines and pathlines, and by distributing the
required additional dispersive parameters: molecular
diffusion and coefficients of dispersivity. RWPT solu-
tions are theoretically consistent with advection - dis-
persion equation solutions - provided that a sufficiently
large number of particles is used.

NOKT bñéçêí

The FEFLOW export options can roughly be
grouped into export of raster images (movies and snap-

Figure 12.2 Pathline analysis.
cbcilt=SKO=ö=NNR
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shots of a view), and export of vector data (data and
plots). 

Snapshots of the active view are exported by using
the camera button in the View toolbar. A resolution
enhancement can be applied to the image and texts
(e.g., legend text) to obtain high-resolution output suit-
able for poster printing. Snapshots of a Slice view can
also be exported as georeferenced images. Additional
3D export settings are used when exporting stereo-
scopic images. Chapter 13 describes how movies are
created from a view animation.

Data and plot export encompasses a variety of dif-
ferent file formats, ranging from simple column-based
text files to GIS and CAD files. Data of process vari-
ables, boundary conditions, material properties and ref-
erence distributions are exported via the context menus
of one or several selected parameters in the Data or
View Components panel. If a full simulation results file
is loaded, data can be exported for the current time
step, a user-defined selection or for all recorded time
steps.

Visualization features such as isolines or fringes are
exported by using their context menu in the View Com-
ponents panel. If supported by the output format (e.g.,
ESRI Shape file, AutoCAD Exchange file), plot files
are exported in 3D from 3D models. 

NOKU qìíçêá~ä

In the following exercises we use a simulation
record to evaluate the modeling results after the simu-
lation. Start FEFLOW and click Open to load the
file results.dac. The file contains the complete results
for every calculated time step of a transient flow and
mass transport simulation. 
NOKUKN qççäë
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For the loaded simulation record, nine different
charts can be displayed: Time Steps, Hydraulic Head,
Pressure, Local and Average Concentration, Fluid-
Rate and Fluid-Period Budget, and Mass-Rate and
Mass-Period Budget.

To open a chart, right-click in an empty part of the
FEFLOW workspace, select Charts and then the
chart that is to be displayed. For each observation point
a curve is plotted so that the hydraulic head, concentra-
tion and pressure changes at these locations can be
monitored during and after the simulation. 

Figure 12.3 Simulation toolbar.

Figure 12.4 Observation points with error bars and labels
and hydraulic-head scatter plot.
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 To compare the field data for Hydraulic head to the
calculated head results at observation-point locations,
activate the Slice view first, switch to slice 2 and select
Model Locations > Observation Points in the

Spatial Units panel. Next, double-click on Process
Variables > Fluid flow > Hydraulic head in the

Data panel. The deviations between measured and
computed water levels are now shown as colored bars
and as labels next to the observation-point locations
(see Figure 12.4). The error bars and labels always
refer to the currently selected simulation time. Use the
tools in the Simulation toolbar to switch to differ-
ent simulation steps to check how the deviations
change. Green bars indicate deviations within the con-
fidence interval, red bars indicate that the deviations
exceed the confidence interval. The position of an error
bar indicates whether the deviation is positive or nega-
tive.

In addition to displaying the water-level deviations
in the active view, we open a scatter plot to compare
measured and computed data. Open the context menu
of the Hydraulic-head chart and select Scatter plot.
The plot always reflects the results at the currently
selected simulation time, displayed in both the

Simulation toolbar and the view windows. 

NOKUKP _ìÇÖÉí=^å~äóëáë

We can use the Rate-Budget panel to monitor
the fluid and mass flows that enter and leave the model
domain, or only specific areas. 

For mass-transport simulations, the Rate- and
Period-Budget panels contain two tabs, one for

fluid and one for mass (see Figure 12.1). To start the
budget calculation for the entire model domain set the
check mark for Active in the respective tab for fluid
and mass. After a brief computation, the Rate-Bud-
get panel shows the flow rate for each boundary condi-
tion type, for sources and sinks, storage capture and
release and the imbalance term representing the
remaining residual error. Flows that leave the model
have a negative algebraic sign while flows that enter
the model have a positive algebraic sign. 

Use the Period-Budget panel to calculate the
time-integrated budget the first 1000 days of the simu-
lation: Switch to day 1000 via the drop-down list of
stored time steps in the Simulation toolbar and
then click on  in the panel to start the calcula-
tion.

We now calculate the fluid budget for the border in
the south instead of taking the entire model as budget
domain. Go to the Spatial Units panel, open the
context menu of Southern Border and select Use
Selection as Budget Domain. The domain of interest is
automatically switched from Domain to

Southern Border in both the Rate and the
Period-Budget panels. Start the rate-budget calcu-

lation with Active. The rate budget is now calcu-
lated for the selected nodes only. The budget shows
that water is leaving the model domain through the bor-
der in the south.
cbcilt=SKO=ö=NNT
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 Additionally, the in- and outgoing flows can be
visualized as scaled spheres. Set the 3D view as active
view and click on Southern Border in the Spatial
Units panel. 

Now, double-click on Fluid flow > Rate Budget in
the Data panel. Blue and green spheres of different
sizes are plotted at nodes along the southern border
where water leaves the model. We now increase the rel-
ative size of the spheres in order to make smaller
spheres visible. Open the context menu of Fluid rate
budget > Scaled Spheres in the View Components
panel and select Properties. In the Size tab increase
the relative size to 3.0 and click Apply. Figure
12.5 shows the resulting plot in the 3D view.

To check how much mass has left the model via the
border in the south over time, we use the Mass-Period
Budget chart. Open the chart via View > Charts >
Mass-Period Budget History and check the curve
Southern Border. 

Figure 12.5 Scaled budget spheres along the southern
border.
NOKUKQ pìÄÇçã~áåJ_çìåÇ~êó=_ìÇÖÉí

To evaluate how much mass enters the lower aqui-
fer via the two contamination sources, we apply the
Subdomain Boundary Budget panels. 

First, we need to define layer 5 as domain of interest
for the budget calculation. In a subsequent step, we cre-
ate a second element selection which we will apply as
masking domain. This step is required as we would like
to compute the mass flow through only those boundary
parts of layer 5 which are in direct contact with the
contamination sites. 

Activate the Slice view and switch to slice 6 in the
Spatial Units panel. Make sure that the geometry

type is set to Select Elements in the Selection
toolbar and select the entire bottom layer with a click
on Select All. Right-click into the Slice view and
select Store Current Selection. Rename the selec-
tion to Lower Aquifer and finish with <Enter>.
The stored selection now appears in the Spatial
Units panel. To use this selection as domain of interest
in the Subdomain Boundary Budget panels, right-click
on Lower Aquifer and select Use Selection as
Boundary-Budget Domain. The selection is now avail-
able as domain of interest in both the Subdomain
Boundary Rate and Period Budget panels. In the

Subdomain Boundary Rate Budget panel, switch
to the Mass tab and start the budget calculation with
the Active check box. The panel now displays the
mass rate entering and leaving this subdomain at the
currently selected simulation time.

As we are only interested in the amount of mass
entering the lower aquifer via the bottom sections of
the two contamination sites, we now apply a second
selection as masking domain. First, clear the current
selection with a click on Clear Selection. Now
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switch to slice 5 in the Spatial Units panel and acti-
vate the Supermesh Polygons map for selection via a
double-click on this entry in the Maps panel. Then,
reduce the Snap distance to 1 m in the Snap-
Distance toolbar and switch to the Select by Map
Polygon tool in the drop-down list in the

Selection toolbar. Move the mouse cursor over
the model domain and create the two selections with a
single click into the two contamination sites. Use the
context menu of the Slice view to store the selection as

Contaminations. To apply this second selection as
masking domain, click on Contaminations in the

Spatial Units panel and then click on the green
check-mark symbol in the Masking Domain section in
the Subdomain Boundary Rate Budget panel. The
mass-flow calculation is now limited to these element
faces which are shared by both selections (see
Figure 12.6).

The settings of the Subdomain Boundary
Period Budget panel follow those of the Rate panel. To
invoke the time-integrated budget calculation, set the
check mark in front of Active, enter the starting
time for the budget calculation and click on .
After a brief computation time, the mass entering and
leaving the domain of interest via the selected boundar-
ies is displayed (Figure 12.6).
NOKUKR `çåíÉåí=^å~äóëáë

To check how much mass the model domain con-
tains at different time steps we use the Content
panel. Switch to the tab Mass and activate the content
calculation for Dissolved Species Mass. The cur-
rently contained amount of mass is now displayed in
grams. Browse the time-step list in the

Simulation toolbar to check how the mass content
changes with time. 

NOKUKS píêÉ~ãäáåÉëI=m~íÜäáåÉë

To visualize the steady and transient flow field we
plot both streamlines and pathlines. Start with a 3D plot
of streamlines that start at the two well locations. 

First, set the 3D view as active view and deactivate

Figure 12.6 Subdomain Boundary Rate and Period Bud-
get panels with results for the selected DOI.
cbcilt=SKO=ö=NNV
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Geometry > Faces in the View Components panel
as otherwise the streamlines located below slice 1
would be concealed. 

Now, click on Node Selection > Wells in the
Spatial Units panel and double-click on Stream-

lines > Backward in the Data panel. Start the plot
by setting Traces in the View Components
panel active. After a brief computation the streamlines
are shown in the 3D view.

To visualize the flow field in the vicinity of the
wells we increase the radius for the streamline seeds
around the wells. To change the radius and other
streamline properties, open the context menu of Travel
time, backward streamlines seeded@Wells in the

View Components panel and select Properties.
In the upcoming Properties panel type 30 m as
radius, hit <Enter> and click Apply. Several
streamlines are now plotted around the two wells. Fig-
ure 12.7 shows a 3D plot of streamlines around the
wells.

To visualize the transient flow field with pathlines,

Figure 12.7 3D Streamlines around the wells.
go back to the Data panel and double-click on
Pathlines > Backward. To start the plot, repeat the
same steps as previously described for the streamlines.
Furthermore, select time step #66 in the

Simulation toolbar.
We also add Period Sections to visualize particle

travel times. In the View Components panel, deacti-
vate Traces and activate Travel time, backward
pathlines seeded@Wells > Period Sections and then
double-click on this entry to edit the period-sections
settings in the Properties panel. On the Iso tab,
deactivate the Automatic option, enter an interval
of 365 d and confirm the changes with Apply.

To plot each period section in a different color, open
the Properties panel of Travel time, backward
pathlines seeded@Wells via its context menu in the

View Components panel. Right-click into the color
bar on the left-hand side of the panel and select

Presets > Rainbow. Figure 12.8 shows the resulting
plot. 

Streamlines or pathlines can also start from poly-

Figure 12.8 Period sections.
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lines. To draw a polyline for streamline plotting, open
the context menu of Streamlines > Forward and select

Draw seed line/points > Draw a 3D Line. Start an
arbitrary line on the top slice of the model with a single
click. Extend the line by adding points and finish with a
double-click. 

The line is now displayed in the active view and is
shown as Domain Locations > 3D Polyline #1 in the

Spatial Units panel.
Now, click on 3D Polyline #1 in the Spatial

Units panel and start the streamline plot with a double-
click on Streamlines > Forward in the Data panel.
Figure 12.9 shows an example for a streamline plot
from a polyline.

Figure 12.9 Streamlines starting at a polyline.
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To illustrate a RWPT event we select Backward
Random-Walk Tracks in the Data panel, for the
same seeded wells as in the previous section.

Go to Edit > Problem Settings >Field-Line
Computation > Random-walk tracks and use the
default, homogeneous dispersive parameters for molec-
ular diffusion and the coefficients of dispersivity.

Note that dispersivity values are small. As opposed
to standard advection-dispersion solution techniques,
the RWPT does not suffer from numerical dispersion
effects and stability constraints. Thus, there is no need
to distribute dispersive coefficients according to mesh
size. In other words, RWPT can be solved even if the
mesh is very coarse with arbitrary dispersive coeffi-
cients, in preference close to their physical values.

Figure 12.10 Defining RWPT parameters.
cbcilt=SKO=ö=NON
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In order for RWPT solutions to be consistent with
advection-dispersion solutions, a sufficiently large
number of input particles must be used. The greater the
amount of used particles the more the RWPT and
advection-dispersion solutions will be comparable.
However, RWPT solutions can be very memory-
demanding when many particles are used so it is rec-
ommended to (i) start with a relatively small amount of
particles (e.g. 100), (ii) analyze the runtime and mem-
ory occupation, and (iii) subsequently increase the
number of used particles if possible. Most problems
will require a minimum number of about 10.000 parti-
cles for RWPT solution to be able to explore all possi-
ble advective-diffusive/dispersive paths and thus be
consistent with advection-dispersion solutions. Note
that there is a control during the RWPT solution phase
on memory usage such that memory overflow situation
should not occur.

Figure 12.11 Backward RWPT solution from the wells.
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To export the mass distribution obtained at the end
of the simulation browse to the last time step in the

Simulation toolbar and double-click on Mass
concentration in the Data panel. Open the context
menu of Mass concentration in the View Compo-
nents panel and select Export Data > Current
Time #116 7300 d > All Nodes. Select a file name and
choose the ESRI Shape File 3D format (.shp). The
exported data can be loaded again as a map and
assigned as initial mass distribution in subsequent sim-
ulations. 

Plots can be exported in the same way as data. To
export the isolines plot open the context menu of Mass
concentration > Isolines in the View Components
panel and select Export Plot. Choose a file name
and format for the exported isolines and finish the
export with Save.

A further option to export simulation results is to
take snapshots of the active view window. Click

Snapshot of the Active View in the View tool-
bar and choose a resolution enhancement factor for the
exported snapshot. After clicking OK, choose a
name and file format for the snapshot.
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Dynamic visualization is essential when presenting
model results to clients, authorities and the public, and
facilitates understanding of complex processes. 

NPKO `êÉ~íáåÖ=~=mêÉëÉåí~íáçå

A dynamic presentation can be set up for each view
window using its autopilot. The autopilot of the active
view window is accessible via the Autopilot panel
where up to four separate categories, Simulation Time,
Position, Clipping, and Visibility can be set up along a
common presentation-time line. Presentation time is
real time as observed on a wrist watch during presenta-
tion play-back. The available categories depend on the
type of the respective view window. Each category has
an Engage checkbox that acts similarly to a clutch.
When engaged, the autopilot completely controls the
respective category. For example, engaging the autopi-
lot Position category will disable user-controlled navi-
gation via the Navigation panel or mouse tools and all
object positioning becomes autopilot-controlled.
The total length of the presentation (in seconds) can
be entered in the Autopilot panel. The displayed per-
centage value corresponds to the position of the time-
line slider. It can be edited to explicitly set a timeline
position.

A play-back function is provided to preview the
autopilot animation sequence.

A simple movement is produced by defining two
object-position keys, one at the beginning and one at
the end of the presentation-time line. Whenever the
autopilot Position category is engaged (e.g., during
autopilot play-back and movie export), all intermediate
object positions are automatically interpolated between

Figure 13.1 Autopilot panel.
NP
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the bracketing keys, resulting in a continuous object
movement. To produce more complex paths, additional
keys can be freely placed along the presentation-time
line. 

When visualizing FEFLOW simulation records
(*.dac files) for transient problems, the simulation-
time axis (often covering days, months, or years) has to
be mapped to the presentation-time axis (typically, sec-
onds or minutes long). The autopilot performs this
mapping simultaneously with the dynamic object posi-
tioning.

While the autopilot Simulation Time category is
engaged, the candidate time step shown in the Simula-
tion toolbar is obtained by interpolating the user-
defined simulation-time keys on the presentation time-
line. By default, beginning and end of the simulation
period are mapped to beginning and end of the presen-
tation timeline, respectively. Thus, in the simplest case,
no additional simulation-time keys have to be specified
at all.

To obtain animation effects such as a gradually
extending cut-out section progressively exposing inter-
nal isosurfaces, the autopilot of a 3D view window can
dynamically interpolate between predefined (key) clip
settings.

While the autopilot Clipping category is engaged,
the settings for clipping and cutout planes are obtained
by interpreting the user-defined clipping keys on the
presentation timeline. At a given presentation moment,
the status of each plane (‘Disabled’, ‘Clipping’, or
‘Cutout’) will be given by the respective previous clip-
ping key on the presentation timeline while position
and orientation of all planes are continuously interpo-
lated between the respective bracketing clipping keys. 

The autopilot can dynamically apply predefined
feature-visibility settings to control the display of mul-
tiple data sources in sequence or to display features
such as the finite-element mesh or a surface map dur-
ing only a portion of the entire presentation.

While the autopilot Visibility category is engaged,
the feature-visibility settings are obtained from the
user-defined visibility keys on the presentation time-
line. At a given presentation moment, the visibility sta-
tus of each feature will be given by the respective
previous visibility key on the presentation timeline. 

NPKP jçîáÉ=bñéçêí=

Export of the autopilot presentation of the active
view to a movie is evoked via Export AVI from Active
View in the File menu or the View toolbar. Any of the
video compression codecs available on the operating
system can be chosen for the export. As formats, the
standard AVI format can be selected or the animation
can be exported as 3D stereoscopic movie in AVIS for-
mat.

NPKQ qìíçêá~ä
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In this exercise we create a presentation from a
results file of a transient free & movable simulation
and export the presentation as a movie. First, click

Open and load the file animation.dac. 
We start with a very simple presentation in the 3D

Figure 13.2 Simulation toolbar.
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view in which we show how the mesh stratigraphy
changes during the simulation. Switch to the

Autopilot panel located below the view windows
and make sure that the 3D view is the active view.

By default, beginning and end of the simulation are
mapped to beginning and end of the presentation time-
line, respectively. The two green bars at beginning and
end of the Simulation Time line show that time keys
are set at these positions.

For showing the mesh movement during the simula-
tion no additional settings are necessary. Simply click

Preview to preview the first presentation.
In the next step we extend the animation to 20 sec-

onds and add further time line-keys to slow down the
animation at the stages where strong changes are visi-
ble. 

First, enter 20 sec as total presentation time and
hit <Enter>. In the upcoming Expand presentation dia-
log select the option Rescale all existing key timings
and click Rescale. Now, browse to time step 40 in
the time step list in the Simulation toolbar, type

8.0 sec in the left input field of presentation time
and hit <Enter>. Alternatively, the white slider bar can
be moved manually to 8.0 sec of presentation time. To
set a key at this time step click the green checkmark in
the Simulation Time line. A green bar appears indicat-
ing that a key has been set here.

Repeat the same steps to set the second time key for
time step 65 at 16 seconds of presentation time. After
this time key has been set, move the white slider bar to
the beginning of the presentation and click

Preview again to see the presentation. 
In addition to presenting the mesh movement during

the simulation we want to change the model position in
the active view during the presentation.

 The model is to move from the upper left corner
towards the center of the active view during the presen-
tation. An increasing zoom factor and some rotation are
also desired. 

First, press the middle mouse button and drag the
model to the upper left corner of the view. Now, use the
right mouse button to zoom out and then, with the left
mouse button, slightly rotate the model backwards and
to the left. To set the first key at this position move the
white slider to the beginning of the presentation time
and click the green checkmark in the Position line. 

For the second key, position the model in the center
of the view, zoom in and rotate the model to the right.
Move the slider to the end of the presentation and click
the green checkmark in the Position line again. The
position of the model will now dynamically change
between these two prescribed positions during the pre-
sentation. 

We complete the presentation by removing the han-
dles from the active view. Right-click in the view win-
dow and deselect Show > Handles. Now click

Preview again to see the final presentation. 

NPKQKP jçîáÉ=bñéçêí

When all presentation keys are set we proceed with
the export of the presentation as a movie. 

In the Autopilot panel, choose a Frame Rate of
20 fps and click Export AVI from Active View

in the View toolbar. Choose a name for the movie
and click Save. Finally, select one of the available
compression codecs and the desired quality and click

OK to start the movie export. 

NPKQKQ bñéçêí=pÉííáåÖë

Presentations can also be exported and reloaded
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again. The presentation settings are exported together
with the settings of the active view. After creating the
presentation right-click in the active view window and
select Export Settings to save the presentation and
view settings as xml-file. 

Reloading the animation and view settings works in
the same way: Go to Window > New and select 3D
View. Right-click in the new 3D view to invoke the
context menu, select Import Settings and load the
file that we have just exported. The view and animation
settings are now adopted from the xml-file. 
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FEFLOW provides the capabilities to conveniently
calculate groundwater age, lifetime expectancy and
exit probability. These three properties are rooted in the
same theoretical framework of component exposure
time and are obtained by solving standard mass-trans-
port equations for which specific coefficients and
boundary conditions must be defined. Transport of age
therefore is available as a new problem class, similar to
the transport of mass or heat. Solving for lifetime
expectancy and exit probability in addition to ground-
water age requires the definition of these additional
Age Species in the Problem Settings dialog and the
assignment of the corresponding transport parameters. 

The solutions of groundwater age, lifetime expec-
tancy and exit probability can be used to perform spe-
cific diagnoses on a flow field, such as the analysis of
the flow dynamics and mixing processes, the estima-
tion of outlet vulnerability, or the evaluation of outlet
capture zones and the origin of water. 
NQKO dêçìåÇï~íÉê=^ÖÉ

Mean age represents the elapsed average time spent
in the aquifer since groundwater has entered the model
domain, i.e., it indicates the travel time from the inflow
boundary to the current location. Typically, it is
assumed that groundwater ‘life’ starts at inflow into a
model and FEFLOW therefore automatically assigns a
Dirichlet boundary condition of 0 days at all inflow
boundaries. If groundwater age is not assumed to be 0
at inflow boundaries, an age-concentration BC with the
specific age value needs to be assigned at these loca-
tions manually. 

Age solutions provide information on underground
travel times and mixing processes and the results on
mean groundwater age can be used for calibration pur-
poses if age data are available.

NQKP jÉ~å= iáÑÉíáãÉ= bñéÉÅJ
í~åÅó

Lifetime expectancy is defined as the average time
for groundwater still needed before exiting the domain
via an outlet. It therefore corresponds to the expected
NQ
dêçìåÇï~íÉê=^ÖÉ=`~äÅìä~íáçå
Crucial information on flow dynamics and mixing, and for capture zone analysis and risk assess-
ment
cbcilt=SKO=ö=NOT
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travel time from the current location to an outflow
boundary. As lifetime expectancy is 0 at outflow
boundaries, FEFLOW automatically assigns a LTE-
concentration BC with a value of 0 days at these loca-
tions.

Results for lifetime expectancy can be used for risk-
vulnerability assessments and the analysis of ground-
water dynamics: Zones with longer lifetime expectancy
indicate groundwater divides whereas areas close to
outflow boundaries show shorter travel times.

NQKQ bñáí=mêçÄ~Äáäáíó

 The parameter exit probability can be used to cal-
culate the probability of water exiting the model
domain at specific locations. In contrast to age and life-
time expectancy simulations, boundary conditions for
exit probability are not applied automatically. Instead,
outflow locations for which the exit probability is to be
calculated have to be selected manually. As the proba-
bility of exit is 100% at an outflow boundary, a proba-
bility BC with a value of 1 needs to be assigned there.

Assigning a probability boundary condition of 1 at a
pumping-well location allows to delineate the capture
zone of the well and also to determine the origin of the
pumped water. 

Evaluating exit probability via the Content panel
provides information on the amounts of water related
to the capture zone of the well. The proportions of
water extracted can be calculated according to their ori-
gin of infiltration using the Rate- and Period-Budget
tools.
NQKR qìíçêá~ä

In the following exercises we set up a groundwater-
age simulation problem and solve for Mean Age, Life-
time Expectancy and Exit Probability. The results will
be used to delineate the capture zone for a pumping
well and to determine the contributions of the different
sources to the total pumped water.

NQKRKN qççäë

NQKRKO pÉííáåÖ= ìé= ~= dêçìåÇï~íÉê
^ÖÉ=páãìä~íáçå

Start FEFLOW and click Open to load the file
age.fem. To setup an age, lifetime expectancy and exit
probability solution problem, open the Problem Set-
tings dialog via the Edit menu. On the Problem
Class page activate the option Include transport of...

Age and confirm with a click on Apply. By
doing so a new page named Age Species is created in
the tree on the left-hand side of the dialog. Enter the
Age Species page and click Add species twice to

Figure 14.1 Selection toolbar.

Figure 14.2 Editor toolbar.

Figure 14.3 Simulation toolbar.
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create three age species in total. Change the Type of the
second species to Lifetime Expectancy and the
third species to Exit Probability (Figure 14.5).
Confirm the changes with Apply and leave the dia-
log with a click on OK. 

Each declared age species is now defined as a trans-
port property and transport parameters such as porosity,
molecular diffusion and coefficients of dispersivity
need to be defined accordingly. By default, FEFLOW
only displays the Dirichlet-type boundary condition for
each age species: Age-concentration BC, LTE-con-
centration BC and Probability BC. Additional bound-
ary-condition types can be added via Add
Parameter in the context menu of the specific bound-
ary-condition section if needed. 

The boundary conditions for fluid flow consist of a
fluid-flux BC in the upper west model region, a fluid-
transfer BC representing a river and two pumping
wells. Additionally, water enters the domain via

Figure 14.4 Activating groundwater age as problem class.
recharge.
To determine the capture zone for the upper pump-

ing well, we need to assign a Probability BC of unity at
this node location. Double-click on Probability BC in
the Data panel and then double-click on the stored
node selection Pumping well to set the selection active.
Enter a value of 1 in the input box of the

Editor toolbar and hit <Enter> to complete the
assignment. Boundary conditions for mean age and
mean lifetime expectancy do not have to be assigned as
these will be set automatically once the simulation
starts.

The transport parameters for the different age spe-
cies do not have to be changed as we will use the
default parameters. 

To start the simulation, click on Start in the
Simulation toolbar. 

Figure 14.5 Defining age species in the Problem Settings
cbcilt=SKO=ö=NOV
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NQKRKPKN qê~îÉäJqáãÉ=^å~äóëáë
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The results for mean age and mean lifetime expec-

tancy are displayed in units of time. To plot these nodal
distributions in the active view, go to the Spatial
Units panel and click on Domain. Next, double-click
on Mean age in the Process Variables section in the

Data panel. Water enters the model domain with an
age of zero and locations close to inflow boundaries
therefore show short travel times. To identify the nodes
at which water enters the model domain, double-click
on Mass transport - age#1 (f) > Age-concentration
BC. Inflow locations are now indicated by an age-con-
centration BC with a value of 0 days. 

For better visibility we uncheck the Edges entry in
the View Components panel. To plot the remaining
travel time for water molecules to reach an outflow
boundary, double-click on Mean lifetime expectancy
in the Data panel. As we would like to combine this
plot with the exit-probability distribution in a later step,
lock this parameter in the view by right-clicking on
Mean lifetime expectancy - lte#1 (f) in the View
Components panel and selecting Lock Data View.
Uncheck the Continuous plot and activate

Isolines instead. To change the interval to be used
for the isoline plot, double-click on Isolines. This
opens the Properties panel and we remove the
check mark in front of Automatic. Change the Pre-
scribed interval to 2 [a] and confirm the changes
with Apply. The resulting plot is shown in
Figure 14.6.
 

qçí~ä=qê~îÉä=qáãÉ
To determine the total travel time from inlet to out-

let, Mean age and Mean lifetime expectancy need to
be summed up. The sum can be calculated and dis-
played using a nodal expression. 

The model already contains a prestored nodal
expression called Total travel time which can now be
edited. Open the context menu of Total travel time in
the Data panel with a right click and select Edit
Parameter Expression. Delete the right side of the
expression and double-click on the process variable
Mean age, then enter + and double-click on Mean
lifetime expectancy in the list on the right-hand side of
the dialog. The expression should look like the one in
Figure 14.7. Leave the dialog with OK.

Double click on Total travel time to plot the total

Figure 14.6 Distribution of mean lifetime expectancy.
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travel time from model inlet to outlet.

NQKRKPKO `~éíìêÉ=wçåÉ=aÉäáåÉ~íáçå=J=bñáí=
mêçÄ~Äáäáíó

The distribution of exit probability represents the
capture zone of the target which in our example is the
pumping well. A typical limit for capture-zone delinea-
tion is the 0.5-probability contour. 

To plot the capture zone for the well, double-click
on Exit probability in the Process Variables section in
the Data panel. To limit the plot to probability val-
ues between 0.5 and 1, double-click on Exit probability
- epr#1 (f) in the View Components panel. In the

Properties panel of this parameter, uncheck the
option Auto-update range, enter 0.5 as the mini-
mum value and confirm the changes with Apply.
The colored area now represents the well-capture zone.

By examining exit probability in combination with
the isolines for mean lifetime expectancy it is possible
to determine the remaining travel time from a specific
location within the capture zone to the outlet.

Figure 14.8 shows the capture zone of the well con-
sidering a probability of 0.5 together with the mean
lifetime-expectancy contours.

Figure 14.7 Nodal Expression for total travel time.
Outflow nodes can be displayed by plotting the
Probability boundary condition. FEFLOW automati-
cally assigns a boundary condition with a probability
value of 0 at these node locations.

NQKRKPKP `~éíìêÉJwçåÉ=`çåíÉåíI=pçìêÅÉ=
m~êíáíáçåáåÖ=~åÇ=lêáÖáå=çÑ=t~íÉê

To calculate the capture-zone water content, acti-
vate Exit Probability Domain Fluid Volume in the

Content panel. If the capture zone is limited to
probability values between 0.5 and 1, it is necessary to
create an element selection for this limited probability
range and to calculate the content for this element
selection only.

Budget calculations for exit probability can be used
to determine the different sources of water at an out-
flow boundary, as well as the proportions of the respec-
tive sources. 

In the Rate-Budget panel, switch to the tab EP -
epr#1 (f) and start the mass-budget calculation for exit

Figure 14.8 Well-capture zone and plot of remaining travel
times.
cbcilt=SKO=ö=NPN
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probability by checking the box in front of Active.
As the flow field is inverted for the exit-probability
solution, positive values indicate outflow and negative
values indicate inflow boundaries. 

The displayed budget indicates that the pumping
well captures water which entered the model domain
via fluid-flux and fluid-transfer boundary conditions
and also via recharge.

The source locations can be displayed in the active
view by double-clicking on Mass transport - epr#1 (f)
> Rate budget in the Data panel (see Figure 14.10).

Figure 14.9 Mass budget returning the proportions of the
pumping-well rate with respect to their origin of infiltra-
tion.
Figure 14.10 Budget spheres for exit probability represent-
ing source locations 
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15 FePEST

NRKN fåíêçÇìÅíáçå

This chapter aims at FEFLOW users that may or
may not have prior experience with PEST. Various ref-
erences to the PEST documentation and other texts are
provided within the text for further reading. 

The methods are described in their functional rela-
tion to the overall workflow and their relation to other
methods. This initial orientation will help to understand
how PEST works, and should motivate the user on the
way of becoming proficient in uncertainty modeling.

The focus will be (with some exceptions) on those
PEST methods that are actually supported by FePEST.
It should be emphasized that PEST provides many
more, exciting features, which will become available in
future releases of FEFLOW. To use them already now,
we encourage you to see the PEST manual for further
information. 

NRKNKN tÜ~í=fë=mbpq\

PEST is a software widely used in environmental
modeling to calibrate models, to determine uncertainty
associated with parameters and predictions, and for
related tasks. Today, PEST is probably the most com-
monly used software for the calibration of groundwater
models.

However, PEST provides much more than calibra-
tion. Besides assisting the modeler in classical calibra-
tion tasks, it implements methods that address the fact
that the outcome of a calibration is not unique, and that
the prediction given by a calibrated model is only one
out of many possibilities.

Instead of only providing one calibrated model,
PEST aims to analyze the spectrum of possible solu-
tions and consequently the uncertainty range associated
with parameters and predictions. Of course, these
methods (for both traditional calibration and uncer-
tainty analysis) must be learned and understood before
they can be successfully applied. Fortunately, good lit-
erature is available to do so. See the literature review
(section 15.1.5) for more information.

PEST is model-independent. Any modeling soft-
ware that reads input and writes output from a file—or
can be adapted to do so—can be linked to PEST. The
effort to do this depends on the complexity of the file
format.

On a more technical level, PEST can be seen as a
NR
cÉmbpq
 The graphical user interface for running FEFLOW models with PEST
cbcilt=SKO=ö=NPP
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toolbox of different programs to setup, run, and evalu-
ate the results of a specific task (e.g. calibration). These
programs are all started from the command-line
prompt, and are configured using command-line
parameters and/or configuration files without a graphi-
cal user interface. FePEST has been developed to pro-
vide more convenient access to PEST functionality
when using FEFLOW models—without limiting it. 

NRKNKO tÜÉêÉ=íç=dÉí=mbpq\

PEST is free software. It is developed by John
Doherty (Watermark Numerical Computing) and can
be downloaded, including all documentation, from
www.pesthomepage.org.

Please also see the FePEST installation instructions
for further information.

NRKNKP tÜ~í=fë=cÉmbpq\

FePEST links PEST with a FEFLOW model
through a convenient graphical user interface.

With FePEST it is possible to use a range of PEST
functionality without the need to learn the syntax of its
various command line tools and configuration files,
and to manually adapt FEFLOW’s model files for
usage in PEST. Visual feedback on the optimization
progress is provided during and after the model run.
This will give the user major savings of time both in
terms of learning and productive work.

The range of supported PEST features in this
release of FePEST includes:

• Model calibration (including Regularization and
pilot point parametrization)

• Subspace methods
• Parallelization (locally and/or using remote serv-
ers, incl. file transfer)

• Linear sensitivity analysis
• Predictive analysis (worst-/best case evaluation)

NRKNKQ tÜÉêÉ=íç=pí~êíKKK

NRKNKQKN fÑ=vçì=^êÉ=kÉï=íç=mbpq

Most PEST features required for model calibration
using PEST are accessible through FePEST. The user is
in many cases not required to make changes to the
PEST files and therefore does not need to learn the syn-
tax of the files and commands of PEST.

However: It is still essential that the methods of
PEST are understood to be able to interpret the results
of a PEST run correctly! It is suggested that the time
saved on understanding PEST's file structure and com-
mand line tools is invested in understanding these
methods.

NRKNKQKO fÑ=vçì=^êÉ=~å=bñéÉêáÉåÅÉÇ=mbpq=
rëÉê

PEST provides more functionality than FePEST can
cover. We have chosen to implement those work flows
that will be most relevant for most users (and more will
be implemented in the future). 

This does not pose a limitation to use FePEST for
other methods at all. In fact, it is developed in an
"open" way thus that the benefit of a rapid PEST file
setup can be used even for unsupported methods. The
following aspects will support experienced users to
customize their setups:
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• The user interface cites the original names of
PEST variables and tools. Experienced users will
therefore quickly recognise how the user interface
relates to the respective PEST functionality.

• The file setup created by FePEST strictly follows
the syntax specified in the PEST documentation
and is fully accessible. The structure of these files
- including several batch-files - are designed to
allow adaptations for different purposes.

• Especially if the optimization involves the pilot-
point method, experienced users will use FePEST
for the otherwise elaborate fundamental work
steps like the definition of observations and
parameters, and then adapt the resulting PEST
setup for the particular purpose.

• Users familiar with the FEFLOW IFM program-
ming interface can use a respective feature in
FePEST to allow IFM plug-ins to communicate
with PEST directly. This extends the scope of
FePEST beyond the predefined observation and
parameter types.

NRKNKR oÉä~íÉÇ=iáíÉê~íìêÉ

The following list of literature should help users new to
PEST to find a reasonably easy access to the science be-
hind its tools. Initially, PEST might be sought as a tool
to accelerate model calibration. PEST has a very high
potential to accomplish this task if the underlying con-
cepts are sufficiently understood. Later, more advanced
methods might be applied to understand the uncertain-
ties associated with calibrated models and predictions
made by them.

• The document Use of PEST and Some of its
Utilities in Model Calibration and Predictive
Error Variance Analysis: A Roadmap pro-
vides a first overview.

• For a more in-depth understanding, the PEST tu-
torial Methodologies and Software for PEST-
Based Model Predictive Uncertainty Analysis
is recommended. It provides a comprehensive
introduction to basic and advanced methods, and
conveys important knowledge of the concepts
behind them.

• The PEST Users Manual and the Addendum
to the PEST manual are the primary and most
complete reference to all PEST features and
tools. This manual will refer to these documents
regularly for further reading.

• Another useful document Getting the Most out
of PEST describes some general settings and
procedures that avoids a major part of typical
problems. FePEST uses a major part of these
recommendations by default.

See www.pesthomepage.org for additional docu-
mentation on PEST.

NRKNKS lîÉê~ää=tçêâÑäçï

The structure of this document follows the work
flows to perform the supported tasks in FePEST. 

After a brief introduction to some of PESTs meth-
ods and algorithms (section 15.2), the following tasks
are explained: 

• Fundamental Problem Setup (section 15.3)
The fundamental problem setup prepares the
model to be processed by PEST. These configura-
tions form the basis for all basic and advanced
cbcilt=SKO=ö=NPR
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PEST methods. It includes the definition of
adjustable parameters, observation and prior
knowledge, the choice for subspace regularization
methods and the setup of remote servers for paral-
lel computing.

• Parameter Estimation/History Matching/Calibra-
tion (section 15.4)
The history matching process targets the estima-
tion of a parameter set that satisfies both the his-
torical observations and the prior knowledge.
After doing the required settings and starting
PEST, the feedback of PEST is reviewed and the
resulting model is opened in FEFLOW.

• Predictive Analysis (section 15.5)
For most environmental models it is possible to
find more than one calibrated model, with predic-
tions varying at different levels. Finding maxi-
mum or minimum possible key predictions among
these models is a simplistic approach to identify
worst-case or best-case scenarios of well-posed
problems that are compatible with the calibration
data set. 

• Sensitivity Analysis (section 15.6.1)
FePEST allows to export the sensitivities of the
parameters. These can be used to create sensitivity
maps in FEFLOW, or be processed with other
software or PEST tools.

• Customized PEST Setups (section 15.7)
Experienced PEST users may want to use PEST
methods that go beyond the functionality of
FePEST.

NRKNKT ^ÅâåçïäÉÇÖÉãÉåíë

The author likes to thank John Doherty of Water-
mark Numerical computing for his ongoing support of
the development of FePEST and its documentation.
John Doherty is the author of PEST and as such pro-

vides regular training courses in calibration and predic-
tive uncertainty analysis of numerical models. His
documentation of PEST, as well as various papers and
tutorial exercises on this topic are a valuable source of
information learning-stage and on-going work with this
software.

Parts of the text and several illustrations used in this
manual have been derived from his work.

The FEFLOW model shown in Figures 15.6, 15.9
and 15.12 is based on work by J. Doherty and C.
Moore. 

NRKO jÉíÜçÇë=~åÇ=`çåÅÉéíë

The fundamental methods applied by PEST during
the calibration process are briefly described in the fol-
lowing. As already mentioned in section 15.1, this
description allows the reader to quickly understand
their respective role in the overall workflow. The PEST
documentation, to which specific references are pro-
vided, describes the methods in full detail.

NRKOKN dij^=pÉ~êÅÜ=^äÖçêáíÜã

The central feature of the PEST engine is the
GLMA search algorithm, that iteratively optimizes the
model parameters to improve its fit to observed data
and other objectives.

The fit to the observations is hereby expressed
through the Measurement Objective Function. In the
simplest case, this will be the weighted sum of squares
of the residuals between measurement and simulation
results
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where (hobs denotes an observation (typically from
a field measurement), hsim its related simulation result,
and w the weight that has been applied to the measure-
ment (observation weights will be discussed in section
15.2.1.2).

The equation shown is also the formulation FePEST
uses to defines the measurement objective function.
The observations hi are loaded from the FEFLOW
model and the weights wi can be changed by the user
within the user interface (Figure 15.1).

The search algorithm used in PEST is the Gauss-
Levenberg-Marquardt algorithm (GLMA). The
GLMA changes the model parameters until a minimum
objective function value is found. Running PEST, the
user will observe two working steps per iteration:

• Derivative calculation: The parameters are
changed incrementally. By repeating the model
run for each parameter, and observing the result-
ing changes of observation values, the partial

 wi hi
obs hi

sim– 
2

i

=

Figure 15.1 The objective function is defined through
the observation definition in FePEST.
derivative for each pair of parameter and observa-
tion can be calculated by finite-difference approx-
imation. These derivatives form the elements of
the Jacobian matrix. The numerical effort to cal-
culate the Jacobian matrix usually dominates the
iteration.

• The parameter values are adjusted aiming to
reduce the objective function. The direction and
magnitude of the adjustment is expressed by the
parameter upgrade vector. To identify the opti-
mal direction of this vector, the GLMA uses a
combination of two strategies:

- While the objective function shows a pre-
dominantly linear behavior, the method of
gradient descent is applied. This method
determines the parameter upgrade vector
from the direction of steepest descent of
the objective function. This can often be
observed during the initial phase of the op-
timization.

- Objective-function nonlinearity is ad-
dressed via the Gauss-Newton method.
This method computes a parameter up-
grade vector based on the presumption of a
quadratic behavior of the objective func-
tion.

The two methods are not mutually exclusive:
The GLM algorithm interpolates between them,
controlled by a scaling parameter (the Mar-
quardt-Lambda).
PEST dynamically updates lambda depending
on the progress in reducing the objective func-
tion. The current lambda as displayed by
FePEST during the PEST run is a good indicator
for the current nonlinearity of the objective func-
cbcilt=SKO=ö=NPT
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tion.

- high lambda values (e.g., > 10) indicate lin-
ear behavior (and predominant use of the
gradient descent method).

- small lambda values (e.g., < 2) indicate
nonlinear behavior (and predominant use
of the Gauss-Newton method).

Figure 15.2 and Figure 15.3 illustrate the devel-
opment of the objective function and the Mar-
quardt lambda during a typical PEST optimiza-
tion. Gradient descent is used in the first itera-
tions, indicated by higher lambda values. When
the objective function approaches its (local)
minimum, Lambda falls to near zero indicating
almost exclusive use of the Gauss-Newton meth-
od.

Figure 15.2 Development of the objective function and
the Marquardt lambda during a PEST run.
If successful, the GLMA will find a parameter set
that constitutes a local minimum of the defined objec-
tive function. This is an important restriction because
multiple local minima might be present, and it is not
guaranteed that the one found is also the global mini-
mum.

It is therefore possible that different PEST runs
result in different parameter sets if the iteration starts at
different initial parameter values. These should there-
fore be chosen as close as possible to those values that
are expected.

The modeler should also critically review the result-
ing parameter set and the model-to-measurement-misfit
(see Figure 15.4). Strong, but also very low (see section
section 15.2.4) departures indicate potential problems
with the optimization.

Further reading: PEST Manual (5th Ed.), Ch. 2.1:
The Mathematics of PEST.

Figure 15.3Schematic illustration of contours of the
objective function and the path of the parameter
upgrades vectors, after Doherty.



NRKO=jÉíÜçÇë=~åÇ=`çåÅÉéíë
Figure 15.4 Scatter plot of simulated vs. observed data
before (top) and after (bottom) optimization.
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The calculation of derivatives is a fundamental ele-
ment of the GLM algorithm.

The derivatives are calculated through numerical
differentiation. Each parameter is incrementally
changed, and the model is run each time to calculate
and record the resulting change of the model observa-
tions. The derivative of each parameter â observation
relationship is then calculated through finite-difference
techniques.

Correct calculation of derivatives is of critical
importance to the optimization, as failure to it will lead
to an unstable optimization procedure and PEST will
not be able to lower the objective function.

Model instabilities are a frequent cause of PEST
failures!

Instabilities introduce noise to the observation,

Figure 15.5 Calculation of derivatives during stable
(left) and unstable (right) model behavior. If the model
is unstable, random noise dominates the physical
change of the observation value. PEST tries to com-
pensate with higher-order finite-difference methods.
í~ÄáäáíáÉ
ÑêÉèìÉå
pq=çéíá
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which is random and not related to the physical-based
simulation result. Figure 15.5 illustrates this effect. If
this noise - and not the incremental parameter change -
dominates the observation response, the direction of
the upgrade vector becomes random itself and the opti-
mization will fail.

Even though certain countermeasures are available
(see section 15.3.2.2), the modeler should always aim
at maintaining maximum stability of the FEFLOW
model. With JACTEST (section 15.6.2) PEST pro-
vides a tool to check the integrity of the derivatives cal-
culation for specified parameters.

Further reading: PEST Manual (5th Ed.), Ch. 2.3:
The Calculation of Derivatives.

NRKOKNKO lÄëÉêî~íáçå=tÉáÖÜíë

The weight of an observation controls how strong
its residual (the deviation between computed and mea-
sured result) contributes to the measurement objective
function. A reasonable choice of weights can positively
influence the convergence behavior and result of the
GLM algorithm.

Different weighting strategies can be applied (alone
or in combination), some examples are given in the fol-
lowing.

• Weighting by Measurement Noise
A common strategy of adjusting observation
weights is applying the inverse of its expected
measurement noise as a weight factor. The con-
tribution of less trustworthy observation values
to the measurement objective function is re-
duced, limiting the risk of inaccurate measure-
ments having a negative impact on the optimiza-
tion and leading to the estimation of parameter
values which are thereby in error.

• Weighting by Absolute Measurement Value
The absolute values of observations in a PEST
optimization can encompass several orders of
magnitudes, especially (but not limited to) if ob-
servations of different types are involved (e.g.,
Hydraulic head [m] and Mass-concentrations
[mg/l]).
Observations with small values are therefore un-
der-represented in the measurement objective
function. Normalizing the values by assigning a
weight equal to the inverse of the absolute com-
pensates for this effect and makes sure that the
information contained in these values finds ap-
propriate representation in the optimization.

• Equalizing Observation-Group Contributions
Observations of different types are assigned to
different observation groups. One may also de-
cide to manually assign observations of the same
type to different observation groups. Using a
spreadsheet or the PEST tool PWTADJ1 obser-
vation weights can be adjusted to equalize the to-
tal contribution of each observation group to the
total objective function at the start of the optimi-
zation process. This helps to ensure that the in-
formation that is contained in each of these ob-
servation groups is used in estimation of model
parameters, and not undervalues or overvalued
because of too low or too high a contribution to
the initial objective function.

• Declustering
Observations can be correlated. Water level
measurements at observation wells close to each
other are often not independent. It is likely that
values and changes at these wells are similar,
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and the worth of information contributed by one
well is diminished because it was already con-
tributed by a different well in its vicinity. The
worth of the information provided by each of the
wells is therefore lower than a separate measure-
ment at a larger distance. In this case, the weight
of correlated observations should be reduced.
Time series are good examples of this principle
as well. Daily measurements of the groundwater
level might carry the same worth of information
as a measurement taken on a monthly basis does.
Because the daily measurement has more mea-
surement points, it would be overrepresented if
the weights of each of these measurement points
are not compensated for. This makes it advisable
to normalize the weights of observations of time
series by the sampling rate of the measurement.

Further reading: PEST Manual (5th Ed.), Ch. 2.1.2:
Observation Weights.

NRKOKO máäçíJmçáåí=jÉíÜçÇ

The pilot-point method defines parameters as a spa-
tially variable distribution.

In the classical calibration approach, it is a common
assumption that geologic formations have spatially
constant parameter values. In reality, this is rarely true.

Therefore, instead of applying a homogeneous
parameter value across a zone, varying values for the
parameter are assigned at particular locations (the pilot
points). Each pilot point represents an adjustable
parameter in PEST. An interpolation method then cre-
ates a continuous distribution of this parameter.
Figure 15.6 illustrates the method.

The resulting large number of parameters adds to
the degrees of freedom in the inversion process. This
will generally lead to a better fit to the measurement
data. At the same time, it will increase the level of non-
uniqueness and therefore better reproduce the uncer-
tainty associated with the model predictions.

Pilot points often lead to lower objective functions
and better fits to measured data. However, the modeler
should be aware of the risk of overfitting the parame-
ter field and should always check that the solution is
plausible in a geological sense, and regularize it if nec-
essary (see section 15.2.4.2).

Figure 15.6Distribution of hydraulic transmissivity,
interpolated from a set of 15 pilot points.
cbcilt=SKO=ö=NQN
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Further reading: PEST Groundwater Data Utilities,
Part A, ch. 5: Model Parameterization based on pilot-
points.

NRKOKP m~ê~ãÉíÉê=kçåìåáèìÉåÉëë

A typical challenge when history-matching (cali-
brating) an environmental model is the inherent nonu-
niqueness associated to the inverse solution. Usually
many different parameter sets exist which are all com-
patible with the historical observation data.

Observation data is usually sparse and usually not
sufficient to uniquely identify more than just a few of
the large number of model parameters that can be made
adjustable.

This has two consequences:
• Different calibrated parameter sets lead to differ-

ent predictions. This makes it difficult to use a sin-
gle model alone for decision-making.

• Some or many of the parameters will be insensi-
tive to observations. The GLMA-based optimiza-
tion process can become unstable under this
condition, leading to long optimization run-times
or even failure to optimize.

Regularization techniques can provide a defence
against these issues. They restrict the parameter search
to identifiable parameters, either by adding additional
constraints to the parameters (Structural Regulariza-
tion, Tikhonov Regularization) or separating identifi-
able parameters from non-identifiable parameters
(Subspace Regularization).

This manual restricts itself to Tikhonov regulariza-
tion (discussed in section 15.2.4.2) and Subspace regu-
larization (discussed in section 15.2.5).

See the PEST tutorial Methodologies and Software
for PEST-Based Model Predictive Uncertainty Analy-
sis, pp. 46 (see the literature review, section 15.1.5), for
a very good discussion on different regularization tech-
niques.

NRKOKQ mêáçê=håçïäÉÇÖÉ

Prior knowledge is introduced in the optimization if
some knowledge about the estimated range of parame-
ters values exists. (This is also referred to as pre-cali-
bration parameter probability.)

The general procedure can be explained in compari-
son to the history matching process: In history match-
ing, the departure of computed observations from their
measured values is expressed as a function (the mea-
surement objective function). Minimizing this func-
tion leads to a parameter set that reproduces the
historical measurements, hence a calibrated model is
found.

When using prior knowledge, the departure of the
applied parameter values from parameter values pre-
ferred by the modeler is expressed as a second function
(the regularization objective function). This kind of
regularization is therefore a method that introduces
knowledge about the plausibility of parameter values
into the calibration process. This knowledge is often
subjective, but nevertheless valuable.

PEST implements two principal methods to perform
a concurrent optimization on measurement and regular-
ization objective function: Prior Information and Tik-
honov Regularization.

NRKOKQKN mêáçê=fåÑçêã~íáçå

Prior information is the simplest way to implement
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preference for parameter values or to preferred rela-
tionships between them (e.g., a preferred ratio between
horizontal and vertical hydraulic conductivity). The
sum of squares of departures from these equations con-
tribute to the regularization objective function.

Minimization of the total of regularization and mea-
surement objective function leads to a parameter set
that reproduces the historical measurements and shows
a plausible parameter distribution at the same time.

Further reading: PEST Groundwater Data Utilities
(5th Ed.), ch. 2.1.3: The Use of Prior Information in the
Parameter Estimation Process.

NRKOKQKO qáâÜçåçî=oÉÖìä~êáò~íáçå

The Tikhonov regularization method as imple-
mented in PEST automatically generates a number of
“information" equations, which defines the initial value
of each parameter as the preferred value (see
Figure 15.7). The user can also make changes to these
equations, or set up his/her own additional equations.

Figure 15.7 Regularization of parameters: departures
(red) from preferred parameter values (green) are
penalized.
When using Tikhonov regularization the calibration
process is formulated as a constrained minimization
process as follows “minimize the regularization objec-
tive function while ensuring that the measurement
objective function is set at the user-specified
target”.Figure 15.8 illustrates this approach. If this
user-specified target is not met, then PEST minimizes
the measurement objective function. In the meantime it
adjusts weights applied to prior information such that
they act as Lagrange multipliers in the constrained
optimization process. PEST thus determines the appro-
priate relative weighting between measurements and
respect for prior information in accordance with a
user’s choice of target measurement objective function.

As a result, Tikhonov-Regularization reduces the
number of possible parameter sets that constitute a cal-
ibrated model by rejecting calibrated models with unre-
alistic parameter values.

Further reading: Methodologies and Software for

Figure 15.8 Constraint optimization: the regularization
objective function (green contours) is minimized while
staying within the defined limits (red contour) of the
measurement objective function.
cbcilt=SKO=ö=NQP
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PEST-Based Model Predictive Uncertainty Analysis:
Regularization (p. 46).

NRKOKQKP oÉÖìä~êáò~íáçå=çÑ=máäçíJmçáåí=
m~ê~ãÉíÉêë

If parameter fields are defined as a varying distribu-
tion using the pilot point method, this will allow a bet-
ter fit to the observation data during history matching
compared to a result obtained using constant parame-
ters. While this is favorable to some extent, the result-
ing parameter field might look implausible, especially
when pilot points are placed at a high density.

 Figure 15.9 provides an example. Because there are
more pilot points (104, purple crosses) than observa-

Figure 15.9 An overfitted parameter field.
tions (12, flags), a perfect match between observed and
simulated results is obtained.

The transmissivity field however reveals that this
result is flawed nonetheless: The distribution looks
somewhat "bumpy", especially around the observa-
tions. Even more severe, the transmissivity above the
northernmost row of observation points is totally dif-
ferent (lower) from the one in the remaining area.

A parameter distribution like this is unlikely, and
accordingly a prediction made with this model has a
high potential of wrongness even though it is perfectly
aligned with its calibration data. This state is called
overfitting.

To prevent overfitting, a second objective (next to
the measurement objective function) is required,
through that plausibility is preferred.

A common approach is to prefer homogeneous dis-
tributions of parameters over heterogeneous distribu-
tions. If different values are assigned to neighboring
pilot points to lower the measurement objective func-
tion, this difference will be penalized and will give rise
to the regularization objective function (See figure
Figure 15.10). As a consequence, the optimization will
yield a balanced compromise between calibration fit
and homogeneity Finding the right distance within
these penalties are applied is important. Differences
between closely located points needs to be penalized
stronger as the likeliness of parameter differences
becomes smaller. Pilot points located far apart (above a
certain distance, the correlation length) do not need to
be penalized at all.

 This distance and the strength of correlation are
defined through a variogram (Figure 15.11)



NRKO=jÉíÜçÇë=~åÇ=`çåÅÉéíë
 Thus, within the range of correlation, implausible
heterogeneities are suppressed unless they are neces-
sary to meet the targeted value of the objective func-
tion. PEST calculates the expected correlation between
each two pilot points and creates a covariance matrix
which is used to impose the correct weights. In sum-
mary, the correlation length allows to define a preferred
variability of a model property, in addition to the pre-
ferred mean value that is provided through the initial
parameter value.

Figure 15.12 shows the same model, regularized
with a correlation length of 200 m. The transmissivity
field is smoother, but still reflects general trends sug-
gested by the observation data. Even though it yields a
stronger model-to-measurement misfit, predictions
made using this model will have higher confidence.

Figure 15.10 Regularization of pilot point parameters:
by penalizing differences between pilot points (red), a
homogeneous (smooth) distribution is preferred. Initial
parameter values are still preferred through prior infor-
mation (grey).
Further reading: PEST Groundwater Data Utilities,
ch. 5.6: Regularization (of pilot points).

 

Figure 15.11 A spherical-type variogram with a corre-
lation length (Range) of 200 m.

Figure 15.12 Regularization of pilot points parameters
leads to a smoother parameter field (compare with
Figure 15.9)
cbcilt=SKO=ö=NQR
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Subspace regularization follows a different
approach than Tikhonov regularization.

The fundamental idea of subspace regularization is
to separate identifiable parameter components from
non-identifiable parameter components in order to
exclude the latter one from the parameter search.

The identifiability of a parameter is related to the
way and extent it influences existing observation data
(if a parameter does not influence any of the existing
observations, it cannot be identified).

Parameters (called base parameters in the follow-
ing) are usually neither completely identifiable or non-
identifiable. It is however possible to create linear com-
binations of base parameters for which this is the case.
These are called super parameters.

The transformed (super-)parameter space is sepa-
rated into two subspaces: One subspace is comprised of
combinations of parameters that have an influence on
observations. These combinations of parameters can be
uniquely estimated through the history matching pro-
cess.

The remaining parameter combinations occupy the
so-called null subspace. These combinations of
parameters have no or very small influence on model
outputs corresponding to observations; hence estima-
tion of these parameters through history matching is
not possible.

The groups are also denoted as sub-spaces of the
parameter space (the parameter space is the combina-
tion of these two orthogonal subspaces, and contains all
parameters):

• The group of identifiable parameters is called
solution subspace (or often just solution space)
• The group of non-identifiable parameters is
called null subspace (or often just null space)

NRKOKRKN qêìåÅ~íÉÇ=páåÖìä~ê=s~äìÉ=aÉÅçãJ
éçëáíáçå

Singular Value Decomposition (SVD) is the name
of the method through which the parameter space is
partitioned into the two orthogonal solution and null
subspaces.

In most groundwater modeling contexts the solution
space is smaller than the null space. The earth is com-
plex, and the information content of most calibration
data sets is insufficient to provide unique estimation of
the parameters which describe this complexity.

SVD analyzes the Eigenvectors of the covariance
matrix to identify the super parameters. The Eigenval-
ues - a measure for the post-calibration variability of
their associated Eigenvectors - are the criterion to
decide if a parameter is associated with the solution
space and therefore included in the optimization or not.
The ratio of highest to lowest eigenvalue is a measure
of the extent to which the inverse problem approaches
ill-posedness. If this ratio is more than about 5e-7 then
the problem can be considered to be ill-posed (in which
case PEST would fail to optimize).

The truncated SVD separates the parameter space
into solution and null subspace using this ratio as a cri-
terion, and therefore omits any super parameters that
are to insensitive to be uniquely estimated. As a conse-
quence, the inversion of the solution space is always
well-posed and a stable optimization is guaranteed
(unless flawed by other sources of error, e.g. bad deriv-
ative calculation, section 15.2.1.1).

FePEST applies truncated SVD with a threshold of
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5e-7 by default in any PEST setup.
Further reading: PEST Manual (5th Ed.), Ch. 8.4:

Truncated Singular Value Decomposition.

NRKOKRKO psaJ^ëëáëí

The SVD-A method uses the concept of the SVD to
reformulate the inversion problem in a way that it can
be solved with much less numerical effort.

The SVD first identifies those combinations of
parameters which are uniquely estimable on the basis
of the current calibration data set and defines them as
super parameters. SVD-A creates and run a new PEST
setup based on super parameters instead of base param-
eters.

When calculating finite-difference derivatives of
model outputs with respect to parameters, it actually
calculates these derivatives with respect to the super
parameters rather than the native model parameters
(base parameters). Hence only as many model runs are
required per iteration as there are dimensions in the
solution space (i.e. number of super parameters).

This method is of fundamental importance for the
pilot point method, as it allows calibration and predic-
tive error analysis of highly parametrized models (e.g.,
using 1000+ parameters) with reasonable effort.

Further reading: PEST Manual (5th Ed.), Ch. 8.5
SVD-Assist

NRKOKRKP iÉ~ëí=pèì~êÉë=EipnoF

Least Squares (LSQR) is an alternative to the SVD
method for highly-parametrized inversion problems.
Experience has shown that its application is useful
when more than 2500 parameters are involved.
Further reading: C. C. Paige and M. A. Saunders,

LSQR: An algorithm for sparse linear equations and
sparse least squares, TOMS 8(1), 43-71 (1982). and C.
C. Paige and M. A. Saunders, Algorithm 583; LSQR:
Sparse linear equations and least-squares problems,
TOMS 8(2), 195-209 (1982).

NRKP cìåÇ~ãÉåí~ä=pÉíìé

The fundamental setup prepares the model to be
processed by PEST. Its steps are common to most
PEST methods.

The fundamental setup comprises the definition of
parameters, observations and prior knowledge (if avail-
able). A decision on using subspace methods is to be
made, and finally, parallel computing may be config-
ured to distribute workload on different computers.

NRKPKN cbcilt=~åÇ=cÉmbpq

FePEST requires a FEFLOW model as a starting
point for any PEST setup. FePEST asks for the file
name of the FEFLOW model when a new optimization
project is created.

When setting up a FEFLOW model that is planned
to be subject to a PEST optimization, bear in mind that
the run-times should be reasonably short and that the
model must run stable. It is possible to exchange the
FEFLOW model by another one, provided that the new
model file contains the same observation points and
parameter zone selections (usually a modified version
of the original model).

It is also possible to open a model simultaneously in
FEFLOW and FePEST. If changes are made and the
model is saved within FEFLOW, a reload must be per-
cbcilt=SKO=ö=NQT
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formed within FePEST to inform it about the changes
made.

NRKPKO ^Çàìëí~ÄäÉ=m~ê~ãÉíÉêë

Choosing the model parameters that PEST can
change to minimize the objective function is usually
the first part of the setup.

An adjustable parameter can be described by its
parameter type (e.g., hydraulic conductivity) and the
zone of application (e.g., a certain geological forma-
tion).

• The parameter type can be any time-constant
material property of the FEFLOW model.

• The zone can be any elemental selection that is
stored in the FEFLOW model.

Note that the choice for the zones already consti-
tutes a kind of regularization (called structural regular-
ization), that has the power to significantly influence
the calibration process (in a good or bad way).

If making changes to elemental selections in
FEFLOW, remember that you must reload the model

Figure 15.13The Edit menu allows access to the prob-
lem settings dialog (Control / Parameters / Observa-
tions) and allows to open, reload and change the FEM
file.
after you have saved them in the FEFLOW file.

NRKPKOKN aÉÑáåáíáçå=çÑ=m~ê~ãÉíÉêë

An optimization problem commonly comprises
many parameters sharing identical or similar settings.

To avoid that the user needs to setup these parame-
ters one-by-one, similar parameters are defined through
a parameter definition. A parameter definition allows
central adjustment of default values of its dependent
parameters which are created from it. This allows con-
venient management of large lists of parameters.

Usage of a parameter definition differs depending
on the choice of the assignment method. Possible
assignment methods are:

• Zonally constant:
The user specifies one or multiple zones in
which the value of a parameter is to be estimat-
ed. A dependent parameter will be created for
each of these zones (see Figure 15.14). During
each model call of a PEST run, a constant value
will be assigned to the chosen FEFLOW model
property in each separate zone.

c
bj=ÑáäÉ
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•  Interpolate from pilot points:
The user chooses exactly one zone, which can be
the model domain (a separate definition is re-
quired for each zone if pilot points are used).
Within the limits of this zone, a cloud of pilot
points is either imported from a file or is auto-
matically generated by FePEST. Each of these
points represents a single parameter of the PEST
setup (see Figure 15.15)

Figure 15.14Zonal parameter distribution

Figure 15.15 Pilot point based parameter definition
The parameter definition of a pilot-point based
parameter includes the settings of the interpola-
tion method that is used to interpolate parameter
values between pilot points. Available options
are Kriging and Radial Basis functions.
Note that FePEST will apply the same settings to
regularize the pilot-point parameters if the re-
spective option for the Tikhonov Regularization
is active.

The user can now define the settings that will be
applied to the dependent parameters by default (indi-
vidual changes can be done later). These include:

• Transformation of the parameter

- Logarithmic transformation often allows
faster and quicker reduction of the objec-
tive function by linearizing of the system).

- A parameter can be tied to a different pa-
rameter, in this case its value will be
changed according to the parent parameter,
always maintaining the ratio of their initial
values.

- A parameter can be fixed, thereby remov-
ing it from the optimization.

• Change limit
This setting defines how to determine the maxi-
mum offset with that a parameter can be changed
within a single iteration. Note that relative
change limits are not allowed if the parameter is
log-transformed.

• Initial value
The parameter value that is applied in the first it-
eration. The value assigned in the FEFLOW
model will be used by default, assuming that this
cbcilt=SKO=ö=NQV
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represents the preferred value of the expert mod-
eler.

• Bounds
An upper and a lower limit can be defined for the
parameters. A good approach is to use a very low
and very high value initially that does not im-
pose a restriction to the optimization.

• Scale and offset
Before a parameter value is assigned to the mod-
el, it is multiplied with Scale and then added to
Offset. These settings usually do not need to be
changed.

Figure 15.16 Creating a new parameter definition.
Choose from Zonally constant or pilot point interpo-
lated parameter distributions. The Defaults tab defines
the standard settings for the dependent parameters.
The OK button applies the new parameter defini-
tion. At the same time its dependent parameters are
added to the parameter list.

These parameters inherit the default parameters of
their parent definition (Figure 15.17). If required,
changes to settings of individual parameters can be
done (overriding the defaults), including the removal of
parameters.

Working with large lists is easier with a spreadsheet
program. The Copy/Paste buttons allow a quick trans-
fer to and from other programs using the system clip-
board.

Also see section 15.7.5 for information on how to
implement parameters through IFM plug-ins.

NRKPKOKO m~ê~ãÉíÉê=dêçìéë

The parameter groups allows the configuration of

Figure 15.17 After a parameter definition has been
created (top), its dependent parameters appear in the
list below.
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the derivative calculation for the parameters (see sec-
tion section 15.2.1.1. FePEST applies default values
that have been tested to work with most FEFLOW
models, and often adjustments are not necessary when
setting up a PEST model.

If the PEST optimization however fails due to bad
derivatives calculations (which cannot be excluded as
every model is different), a reconfiguration of these
settings might be required. Detailed explanation and
literature references to the different settings are given
in the FePEST help system.

NOTE: The PEST utility tool JACTEST (section
15.6.2) is a utility to check for bad derivative calcula-
tion.

By default, FePEST defines one parameter group
per FEFLOW parameter type and assigns the adjust-
able parameter to these groups accordingly:

• The Derivative method is chosen automatically
(option "switch", starting with the more effec-
tive 2-point methods, switching to higher order
methods if required)

• The Increment size (set to 1.5% by default) can
be increased if minor model instability issues are
observed. Do not increase this value unneces-
sary, as high values would violate the linearity
assumption of the derivative calculation.

NRKPKP lÄëÉêî~íáçåë

The observations provide the primary (and only)
measure that informs the optimization algorithm about
the model-to-measurement misfit.

For each observation FePEST requires:

• its type (e.g., hydraulic head),
• its location (e.g. an observation data),

• the time at that it was recorded (in case of a tran-
sient model) and

• the value that was observed in reality.
Because the observation points set in FEFLOW

already contain this information, it is possible to import
them directly from the FEFLOW model.

By default, all observations are weighted with a
weight of unity. These can be adapted by the user
(compare section 15.2.1.2).

Supported observation types are all observations of
system state (e.g., hydraulic head, saturation, mass con-
centration, temperature) depending on the models
problem class. Reference values are constant values if
the model is steady state. In a transient model, a time
series contains the data of observations at different
points in time.

Advanced users may also use IFM plug-ins or third
party software for other types of observations.

NRKPKPKN aÉÑáåáíáçå=çÑ=lÄëÉêî~íáçåë

Observations are defined in a similar way as param-
eters. If observations are of the same type (e.g., obser-
vations from the same well field), often similar or
identical settings are required.

For convenience, and to avoid many repetitive
adaptations of these setting when creating or making
changes to observations, each observation depends on
an observation definition. A definition allows central
adjustment of the default values of its dependent obser-
vations (see Figure 15.18). This allows a better man-
agement of a large number of observations.
cbcilt=SKO=ö=NRN
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In the easiest case the definition of observations
only requires the choice of the observation type (e.g.,
Hydraulic Head, Pressure, Mass concentration).

• FePEST can automatically import the observa-
tion points of the given type from the FEFLOW
model. If the model is transient, it adds multiple
observations per observation point, each repre-
senting a sample point of the respective time se-
ries. A weight of one is applied by default.

• Alternatively, an external file can provide the
observation locations and data.

• Advanced users may choose to create additional
observations in the PEST setup, that can be im-
plemented using IFM plug-ins or third-party
software (see also section section 15.7.5).

Figure 15.18 Observation definitions (top) and their
dependent parameters (list below).
Observations created in this way now populate the
observation list (this being the actual list of observa-
tions as PEST sees it).

It is possible to change settings of particular obser-
vations (overriding the defaults). This is required espe-
cially when adapting the observation weights to
achieve better optimization behavior and results.

HINT: Working with large lists is easier using a
spreadsheet program. The Copy/Paste buttons allow a
quick transfer to and from other programs using the
system clipboard.

NRKPKPKO lÄëÉêî~íáçå=dêçìéë

FePEST automatically assigns observations of dif-
ferent type to different observation groups. This allows
PEST to distinguish how strong the different groups

Figure 15.19 Creating a new observation definition
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contribute to the measurement objective function.
In the same way it is possible to allocate observa-

tions of the same type to different groups (e.g., to dif-
ferentiate between hydraulic head measurements in
different aquifers).

Advanced users may specify an observation covari-
ance file to define the weights for these observations.

NRKPKQ mêáçê=håçïäÉÇÖÉ

Prior Knowledge - if available - can be described
during this step of the PEST setup. In most cases the
Tikhonov regularization option will be preferred over
the manual setup of equations of prior information (see
section 15.3.4 for details).

NRKPKQKN mêáçê=fåÑçêã~íáçå

Equations of prior information allow to define pre-
ferred values for parameters, or preferred relations
between parameters. Any deviation form this relation-
ship will contribute to the regularization objective
functions. As though there are certain similarities to
observations:

• Name
A user-defined name to identify the equation.

• Weight
Each equation has a weight to allow to control
the strength with that it contributes to the objec-
tive function (relative to other prior informations
and field observations). Individual weights of
prior information should reflect the trust that is
associated with the underlying assumptions.
• Group
It is possible to associate different prior informa-
tions to different observation groups, hereby de-
fining more multiple regularization groups. The
principle is the same as for the observation
groups.

The formula itself has to be written in a special syn-
tax specified in the PEST manual. Note that FePEST
will not check for correct syntax on its own, however
the PESTCHECK feature can performed from the
Tools menu to do so (recommended after each change
made to prior information).

A default formula is provided for convenience,
which needs to be adapted for the specific purpose by
the user.

NRKPKQKO qáâÜçåçî=oÉÖìä~êáò~íáçå

When activated, Tikhonov regularization can imple-
ment two different aspects of regularization in the
PEST setup:

• Regularization based on initial parameter values
Assuming that the initial parameter value repre-
sent the expected values of the expert modeler,
equations of prior information are created that
will penalize departures of parameter values
from initial values.
As a result, parameter values close to initial pa-
rameters will be preferred during the optimiza-
tion.

• Regularization of pilot point parameters using
covariance matrices
Pilot-point type parameter values for each defi-
cbcilt=SKO=ö=NRP
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nition are regularized taking into account the ex-
pected correlation (using a covariance matrix).
Differences in parameter values of pilot-points
closer than their correlation length will be penal-
ized.
As a result, homogeneous (smooth) parameter
definitions will be preferred over heterogeneous
ones.

lÄàÉÅíáîÉ=cìåÅíáçå=iáãáíë
As it is described in section 15.3.4, the Tikhonov

regularization aims at finding a minimum of the regu-
larization objective function, while maintaining user-
defined limits for the measurement objective function
(under which the model is still considered calibrated).

The following settings determine this limit:

• Target measurement objective function (PHIM-
LIM)
This is the limit for the measurement objective
function below which the model is considered to
be calibrated.
The value can be calculated by summing up the
(weighted) measurement noise associated with
the observations. If this is not possible, a value
somewhat higher than the objective function that
results from a calibration run without Tikhonov
regularization can be chosen.

• Acceptable measurement objective function
(PHIMACCEPT)
This additional threshold is usually set slightly
(5% to 10%) above PHIMLIM. PHIMLIM and
PHIMACCEPT define a buffer zone for the
measurement objective function value for stabil-
ity reasons. In this zone, an objective function
value is tolerated even though it does not meet
the target value. This is necessary as the param-
eter upgrade vector will often "miss" the exact
limit because it relies on a linearity assumption.
Figure 15.20 illustrates how the iteration adapts
to these limits.

• Successive reduction of the objective function
Limit (FRACPHIM)
This option allows a different strategy to deter-
mine the target objective function limits. If set to
a non-zero value (allowed values are between 0
and 1), PHIMLIM is determined by multiplying
the last achieved value of the measurement ob-
jective function with FRACPHIM.
In this way, PHIMLIM gets lower from iteration
to iteration. It will however never be smaller
than the value defined in PHIMLIM.
Optimal values for FRACPHIM are normally in
the range 0.1 to 0.3.

Figure 15.20 Development of the regularization and
measurement objective function during Tikhonov-reg-
ularized parameter estimation.
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FePEST activates this option by default in com-
bination with a very low objective function
(these are the same defaults as applied by the
PEST tool ADDREG1). This improves the well-
posedness of the optimization and thereby leads
to a more stable behavior of the GLMA optimi-
zation. The limits should however be adapted by
the user as these settings might not yield the de-
sired plausible parameter values.

See Section 7.3.3 of the PEST user manual for a full
discussion of these variables.

tÉáÖÜí=c~Åíçêë=~åÇ=^ÇàìëíãÉåí
Settings to determine the weight factor can be used

for fine tuning or trouble shootings. Their default val-
ues follow general recommendations that are suitable
for most applications of PEST.

NRKPKR pìÄëé~ÅÉ=oÉÖìä~êáò~íáçå

As described in section 15.3.5, subspace regulariza-
tion methods can greatly improve the stability and
reduce the required modeling effort of an optimization.

NRKPKRKN páåÖìä~ê=s~äìÉ=aÉÅçãéçëáíáçå

SVD is the recommended option for any PEST
setup (unless LSQR has been chosen, which tends to be
faster for PEST runs involving more than 2500 param-
eters). FePEST activates this option by default.

The particular settings determine how many singu-
lar values / super parameters are regarded during the
optimization:

• The eigenvalue threshold, below which super
parameters will be truncated, is by default set to
5e-7. At this value, the optimization is still re-
garded well-posed, which ensures stability of the
optimization.

• In addition, it is possible to further limit the
number of singular values / super parameters to
maximum number.

 See the PEST users manual (5th Edition), section
8.4.2: Implementation of SVD with PEST for a full dis-
cussion of these settings.

NRKPKRKO psaJ^ëëáëí

SVD-Assist (SVD-A) is useful to speed-up the cali-
bration of highly parametrized models (often involving
the pilot point method).

It can be chosen from two principle ways to deter-
mine the number of singular values:

• By default, PEST uses the SUPCALC tool to de-
termine the optimal number automatically.

• Manual specification of the number of super pa-
rameters can be useful if the run is carried out on
multiple CPUs in parallel:
Each iteration requires one model run per super
parameter to calculate the Jacobian matrix. Op-
timal usage of computational resources is given
of the number of super parameters equals a mul-
tiple of total amounts of slaves (See section sec-
tion 15.3.6).

NRKPKS m~ê~ääÉäáò~íáçå

An inherent issue of calibration and uncertainty
analysis, scenario runs and sensitivity analysis is the
cbcilt=SKO=ö=NRR
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large number of required model calls and the often sig-
nificant required run times.

Fortunately, many steps of a PEST run, especially
the numerically expensive calculation of the Jacobian
matrix, is very suitable for parallel computing. By
involving a multitude of computers (whether this being
a limited number of office PCs, a HPC cluster or cloud-
based computers) computation times can be reduced to
an acceptable level. But even if applied only locally on
a single computer, parallelization can improve model
run times significantly.

In case of highly-parametrized inversion processes,
parallelization is often a requirement to finish a compu-
tation within typical project time frames.

FePEST deploys BeoPEST - a network capable ver-
sion of PEST - for this task. FePEST also transfers the
required model files to the slave computers.

The port denotes the network (IP) port of the local
computer (Host) that FePEST uses for communication.
If the default settings conflicts with a different applica-
tion, choose a different port number. Make sure that no
router, firewall or anti-virus software blocks the net-
work connection even if no remote computers are
involved (localhost only).

Slaves shows the list of servers that will be used to
undertake model run jobs during the PEST run (ini-
tially empty). You can add and remove servers to the
list, or edit the settings of existing entries.

See also installation instructions for parallel com-
puting.

• Host name
The host name specifies the host name or IP-ad-
dress of the server computer. Enter "localhost"
to add the local computer to the list.
Note that FePEST has to be started in server
mode on all remote servers (except the local
computer) before commencing the PEST run.

• No. of Slaves
The number of slaves is the number of models
that will be run simultaneously on the computer.
In most cases, this will be set to the number of
available CPU cores on that computer.

 FePEST must be started and set to server mode (see
Figure 15.22) on each of the slave servers. 

Figure 15.21 The parallelization page contains the
slave machines running FePEST in server mode.

Figure 15.22 When running in server mode, the cur-
rent computer acts as a slave server that can receive run
jobs from another computer.
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The terms parameter estimation, history matching
and calibration are used synonymously in this docu-
ment.

History matching of a model requires completion of
the fundamental setup as explained in section 15.3.

After the fundamental setup has been completed,
PEST can be advised to perform history matching. The
history matching process targets the estimation of a
parameter set that optimally satisfies both the historical
observations and - if provided â the prior knowledge.
The resulting parameter set is then regarded as a cali-
brated model.

This section explains the required settings, how the
run is commenced and how to interpret the visual feed-
back during and after the run. Exporting a new
FEFLOW model with optimized parameters is the final
step.

NRKQKN oÉèìáêÉÇ=pÉííáåÖë

NRKQKNKN léíáãáò~íáçå=`çåíêçä

By default, FePEST assumes that history matching
is to be performed and applies the respective PEST
operation mode accordingly.

Note that the FePEST operation mode is slightly
different than the PEST operation mode: If "Estima-
tion" is set, FePEST chooses automatically from "regu-
larization" mode (if the calibration involves Tikhonov
regularization) and "estimation" mode (if not).

A second important option is the NOPTMAX set-
ting found in the termination criteria setting. For cali-
bration purposes, this option must be set to "Number of
iterations" and a sufficiently high value (e.g., 30 itera-
tions, which is the default setting).

NRKQKNKO líÜÉê=pÉííáåÖë

The default settings represent recommendations that
are meant to be suitable for a range of optimization
processes. Changes might be advised for fine-tuning
and trouble shooting. The individual settings will not
be explained in detail here, but detailed information is
provided in the FePEST help system and the PEST
documentation.

See Section 4.2.2 Control Data of the PEST user
manual (5th Edition) for a full discussion of these vari-
ables.

NRKQKO pí~êíáåÖ=mbpq

Starting the history matching process is done in a
sequence of several steps.

NRKQKOKN mêÉÑäáÖÜí=`ÜÉÅâë

Before running the model, a sanity check of the
PEST setup is recommended. PEST provides several
tools (PESTCHEK, TEMPCHEK and INSCHEK) that
can be run through the Estimation menu of the FePEST
user interface.

These utilities check the most important files of the
PEST setup (the control file, the template file and the
instruction file) for errors and warnings. Errors will
prevent PEST from running, while warnings are indica-
cbcilt=SKO=ö=NRT
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tions for possible problems and give suggestions for
improvements of the setup.

NRKQKOKO =oìååáåÖ=mbpq

PEST is finally started using the Run button in the
toolbar. Usually no change needs to be done to the
sequence of steps provided in the upcoming dialog (see
Figure 15.24).

Figure 15.23 The Checks utility in the Estimation
menu checks the PEST setup for validity and provides
suggestions for improvement.
The sequence is:

• Create the files required by PEST
FePEST generates the required PEST files ac-
cording to the settings.

• Recalculate Jacobian Matrix
This option is available if the Jacobian matrix is
still available from a former PEST run. Ad-
vanced users can choose to deactivate this option
to save computational effort.

• Start PEST
This finally executes PEST itself and commenc-
es the actual history matching process. The
FePEST windows display the progress of the
PEST iteration.
Users experienced in PEST can choose to gener-
ate the PEST files without immediately starting
the PEST run itself. See also section 15.7.

It is possible to interrupt (pause) or stop the PEST
run. A stopped PEST run can be continued at a later
point in time, even if FePEST had to be closed in the

Figure 15.24 The Run dialog. Usually all options will
be active.
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meantime. This is useful if the optimization has to be
interrupted, e.g., because the computer is turned off.

NRKQKP lìíéìí=ÇìêáåÖ=mbpq=oìå

During the PEST run, FePEST reads and analyzes
the output of PEST and displays key information in
several panels and charts:

• Output
The primary output of PEST is shown in this
window. Users familiar with the output of PEST
will find information otherwise omitted in the
FePEST output here.

• Status
Key information on the status of the PEST run is
shown in the Status panel.

• Objective Function
The history of the objective function shows the
progress of the optimization run and allows

Figure 15.25 The Status panel contains key informa-
tion about the progress of the optimization.
identifying the occurrence of problems during
the run. Ideally, the function value is shows a
continuously falling behavior.

• Simulated vs. Observed
The panel shows a scatter plot that compares the
simulated values with their (observed) reference
values.

• Simulated vs. Time
A graph shows the time-dependent observations
in the model. The measured time series is shown
for comparison. This panel is not available for
steady-state models.

Because the size of the text panels is restricted, they
may not contain the complete file. In this case the View

Figure 15.26 The development of the objective func-
tion is shown in the correspondent panel.
cbcilt=SKO=ö=NRV
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button allows to open the respective file in an external
text editor.

NRKQKQ lìíéìí=~ÑíÉê=mbpq=oìå

PEST provides additional statistics after the history
matching process. As already during the run, FePEST
displays these and other key information in additional
panels.

• Run Details
PEST journalizes all important information about
setup and results of a PEST run into a run record
file, which is shown in full in the Run details
panel.

• Parameter Sensitivities
For all iterations, PEST journalizes composite
parameter sensitivities in the sensitivities file,
which is shown in full in the Run Details panel.
This information can be used to check for example
for hypersensitive parameters. The composite sen-
sitivity of a parameter is a measure of the sensitiv-
ity of all model outputs for which there are
corresponding observations to this parameter. By
inference, it is a measure of the information con-
tent of the calibration data set with respect to this
parameter.

• Observation Sensitivities
PEST writes the observation sensitivities of the
last iteration to an observation sensitivities file,
which is shown in observation sensitivities.

• Residuals
This panel lists the measured and simulated value
for each model observation, as well as the differ-
ence between these values (the residual).
The native (non-weighted) residuals allow to iden-
tify well or poorly calibrated observations. The
weighted residuals (shown separately) are valu-
able to check for an appropriate choice of observa-
tion weights.
The content of this tab is identical to the residuals
file created by PEST.

• Covariance and Correlation matrix
Covariance and Correlation matrices are only
available when not using regularization.
These tables show the covariance and correlation
between the parameters, respectively, the latter
being normalized to values ranging from 0 (no
correlation) to 1 (strong correlation). A color gra-
dient facilitates interpreting the values.

• Eigenvectors and Eigenvalues
Eigenvectors and Eigenvalues are only available
when running PEST in estimation mode and not
using singular value decomposition.
Each observation contains a certain amount of
information that contributes to the identification
of the calibrated parameters. Because observa-
tions and parameters are often correlated, respec-
tively, the information contributed from a
particular observation might overlap with the
information that was already provided from a dif-
ferent observation. As a result the number of
observations is not necessarily proportional to the
combined information of these observations.
If the covariance matrix undergoes principle com-
ponent analysis, orthogonal combinations of
parameters can be identified, together with the
extent to which these combinations have been
informed by the calibration process. These combi-
nations are the eigenvectors of the covariance
matrix. If a low eigenvalue is associated with this
eigenvector, then its post-calibration variability is
low. Conversely, if a high eigenvalue is associated
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with an eigenvector, then its post-calibration vari-
ability is high.
The ratio of highest to lowest eigenvalue is a mea-
sure of the extent to which the inverse problem
approaches ill-posedness. If this ratio is more than
about 5e-7 then the problem can be considered to
be ill-posed. Furthermore, unless some kind of
regularization is being employed (Tikhonov or
SVD) PEST will not be able to solve this inverse
problem. Instead its behavior will be numerically
unstable, and the objective function may not fall at
all.

The contents of the text panels can be easily trans-
ferred to a spreadsheet program for further processing
and visualization.

See section 5.2: The PEST Run Record and section
5.3: Other PEST Output Files of the PEST user manual
(5th Edition) for a full discussion of these output files.

NRKQKR bñéçêí=íç=cbcilt

After PEST was able to successfully reduce the
objective function to an acceptable level (or another
termination criterion was met), it ceases the optimiza-
tion and FePEST will display a list of resulting parame-
ter values.

To inspect the resulting model more in detail, save it
as a new FEM file and open it in FEFLOW.

The found parameter set can also be applied as the
initial parameter values, especially if further PEST
methods are going to be used.

To return to this dialog at a later point in time, use
the Show Results option in the Estimation menu.
cbcilt=SKO=ö=NSN
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Predictive Analysis requires completion of the fun-
damental setup, and it is recommended to successfully
run a history matching (calibration) process prior to it.
The parameter set found as a result of the latter must
have been applied as the initial parameter values to the
current FePEST setup (in the Show results panel).

For most environmental models it is possible to find
a multitude of calibrated models. Unfortunately, even
though these model all match the historical data, the
predictions made by these models will nonetheless
vary at different levels. The prediction given by the
particular model that was found during the calibration
therefore represents only one out of many possible pre-
diction.

Predictive analysis is a simple tool in PEST for non-
linear model predictive error and uncertainty analysis.
It searches for the calibrated model with the maximum
or minimum key prediction. In this way it is possible to
identify the worst-case or best-case scenarios among
the set of calibrated models.

However, use of PEST in predictive analysis model
is restricted to well-posed problems, where variability
arises from measurement noise alone. In case of an ill-
posed problem, advanced users may choose to use
PEST methods such running PEST in Pareto mode.

Further reading: PEST Manual (5th Ed.) Ch. 6:
Predictive Analysis

NRKRKN oÉèìáêÉÇ=pÉííáåÖë

NRKRKNKN léíáãáò~íáçå=`çåíêçä

The required operation mode in PEST is the Predic-
tive analysis mode; the optimization control section of
the Problem Settings dialog contains the respective set-
ting.

NRKRKNKO lÄëÉêî~íáçå=~åÇ=qóéÉ

Predictive analysis aims to either maximize or mini-
mize a key prediction while maintaining the objective
function below a user-specified value.

The prediction can be any observation (e.g. a spe-
cific hydraulic head) defined during the fundamental
problem setup. Usually, a weight of zero will be
applied to this particular observation to exclude it from
the measurement objective.

The Predictive Analysis section of the problem set-
tings dialog provides the settings for the choice of the
prediction whose value must be maximized/minimized,
and for the value of the objective function which must
not be exceeded.

NRKRKNKP lÄàÉÅíáîÉ=cìåÅíáçå=iáãáíë

The maximum/minimum prediction is searched
under the constraint of maintaining the calibrated state
of the model. It is important to define a maximum
objective function value below which the model is con-
sidered to be calibrated.

For this purpose, Objective function limits are to be
chosen. The model is assumed to be calibrated if the
value of the objective function is less than the defined
Target objective function.

A common choice is a value which is 5...10%
greater than that achieved through objective function
minimization through the preceding calibration pro-
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cess. The choice is however always somewhat subjec-
tive and can have significant influence on the result.
Where the statistics of measurement noise are well
known, this limiting objective function can be set in
accordance with theory. See the PEST manual for more
details.

See the PEST Manual (5th Ed.), Ch. 6.2.2: PEST
Variables used for Predictive Analysis for a full discus-
sion of these variable.

NRKRKNKQ líÜÉê=pÉííáåÖë

The default settings represent recommendations that
are meant to be suitable in most cases of a predictive
analysis run. The individual settings will not be
explained in detail here, but detailed information is
provided in the FePEST help system and the PEST
documentation.

NRKRKO pí~êíáåÖ=mbpq

To start the predictive analysis, follow the same
steps as described for the parameter estimation in sec-
tion 15.4.

NRKRKP lìíéìí= ÇìêáåÖ= mêÉÇáÅíáîÉ
^å~äóëáë

The history of the objective function shows the
progress of the optimization run.

In case the initial parameter set does not resemble a
calibrated model, PEST will first conduct a calibration
to reduce the objective function until it falls below the
defined target objective function.

PEST will then start maximizing/minimizing the
model prediction. The objective function during the
required iterations will be in the allowed range between
target objective function and acceptable objective func-
tion. Outputs after the PEST run.

NRKRKQ bëíáã~íáçå=oÉëìäíë

The first line of the parameter list shows the maxi-
mum or minimum prediction value that was found. The
found parameter set resembles the calibrated model
that is the worst-case (or best-case scenario), and can
again be exported to FEM file.

PEST also generates additional statistical data.
These are shown in additional panels after the model
run.
cbcilt=SKO=ö=NSP
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NRKSKN pÉåëáíáîáíó=bñéçêí

Linear sensitivity indicates how strong a parameter
influences certain observations. These derivatives are
calculated during the optimization and contained in the
Jacobian matrix.

The sensitivities are therefore a potentially valuable
by-product of the optimization, and can as such be
exported for further processing.

NRKSKNKN oÉèìáêÉÇ=pÉííáåÖë

Export of Sensitivities is possible after a Jacobian
matrix was calculated. This is the case whenever an
optimization (no matter if parameter estimation or pre-
dictive analysis) has been performed (successfully or
not).

If no optimization has been performed yet, the
NOPTMAX setting in the Termination criterion set-
tings can be set to "Jacobian only" (-1). With this set-
ting PEST will calculate only the Jacobian matrix of
the first iteration and terminate without any changes to
the initial parameter values.

Further reading: PEST Manual (5th Ed.) section
2.2.9: Termination Criteria.

NRKSKNKO bñéçêí=çÑ=pÉåëáíáîáíáÉë

The Sensitivities feature in the Estimation menu
runs the JROW2VEC tool of PEST to extract the sensi-
tivities of parameters for the chosen observations. The
resulting table can be
• Transferred to a spreadsheet program for further
processing (using the Copy option)

• Exported to an ASCII table (dat-) file. Used in
conjunction with spatial maps that relate the pa-
rameters to their zones or pilot point locations,
sensitivity maps can be created in FEFLOW or
GIS software (a FEFLOW example is shown in
Figure 15.27).

NRKSKO jçÇÉä= pí~Äáäáíó= qÉëíë= Eg^`qJ
bpqF

As discussed in section 15.2.1.1, it is important that

Figure 15.27 Sensitivity maps (plain view of layer 5
and cross-section of indicated line shown.) of hydraulic
conductivity in a 3D model. These are created by spa-
tial interpolation of pilot point parameter sensitivity.
White line indicates the water table.
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the numerical model is stable enough to provide repro-
ducible observation - parameter relationships.

As a measure of trouble-shooting, PEST provides a
tool (JACTEST) that checks if the model is running
sufficiently stable to calculate the Jacobian matrix.
This tool can be activated from within FePEST using
the Model Stability option in the Estimation menu.

JACTEST will run the model multiple times, each
incrementing/decrementing the chosen parameter
according to its settings for derivative calculation and
plotting the response of the observations.

Further reading: Addendum to the PEST Manual
(5th Ed.) section 3.20: JACTEST

NRKSKOKN rëáåÖ=g^`qbpq

If PEST fails to reduce the objective function and
bad derivative calculation is the suspected reason, stop
PEST (if it is still running). Open the Show Results
dialog and Apply the latest values as initial parameter
values (you may want to save the FPS file now under a
different name).

Open the Model Stability dialog from the Estima-
tion menu. The only settings required by the users are:

• Specification of the parameters that are subject
to the test.
Those parameters that are suspected to cause in-
stabilities should be chosen here.

• Number of iterations to be performed on each
parameter.
A value of 4 should initially suffice to identify
parameter–observation relations that show a cer-
tain randomness.

After the calculation has finished, the diagram win-
dow shows the resulting observation values. If the
slopes are similar or change gradually and monoto-
nously, no problems are indicated. An example for a
stable model is shown in Figure 15.28.

If the parameter values change randomly (and sig-
nificantly), noise dominates the observation. Identify
the affected parameter–observation combinations, and
open and run the model in FEFLOW to find and solve
the instability issue.

NRKT `ìëíçãáòÉÇ=mbpq=pÉíìéë

PEST is a model-independent parameter estimator
and as such easy to integrate with most numerical mod-

Figure 15.28 JACTEST result indicating stable model
behavior. Two parameters are incremented / decre-
mented four times each by 1.5 % around the initial
value, the resulting values for a particular hydraulic
head observation are plotted.
cbcilt=SKO=ö=NSR
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els. The transparent design of its file setup allows the
user a lot of customization and to implement own func-
tionality.

One goal in the development of FePEST was to not
restrict this flexibility. It provides a convenient user
interface to set up the PEST files, but at any time the
user is free to abandon the use of FePEST and continue
working with PEST in the traditional way (by direct
editing its configuration files and running its tools from
the command line).

This release of FePEST implements those PEST
features that are commonly used for model calibration.
As it was discussed before, PEST has a lot more to
offer.

Users that are experienced in using PEST might
want to make use of features like Pareto methods or
Null-Space Monte-Carlo analysis, or to make changes
to certain PEST variables or options that are not acces-
sible through the FePEST GUI. Implementation of own
pre- or post-processing code (including third-party
software and IFM plug-ins) into the PEST iteration
loop might also be desired.

To make the best use of both FePEST and tradi-
tional PEST, just configure the PEST setup in FePEST
as close as possible to the final settings. Then, generate
the respective files, which can be edited as desired.
Finally PEST can be started (in some cases, this can be
done again from within FePEST).

NRKTKN `êÉ~íáåÖ=íÜÉ=mbpq=pÉíìé

The PEST setup files are created when the PEST
run is commenced. To be able to edit the files, press the
run button, but disable the options for running PEST
(and recalculating the Jacobian if applicable) before
pressing the OK button (see Figure 15.29).
The Checks option will also initiate the creation of
the files if these are not present when it is executed.

NRKTKO `çåîÉåáÉåÅÉ=qççäë

To make the manual editing of the file setup easier,
and to allow quick access to the relevant files and loca-
tions, the following features become available in the
Estimation menu of FePEST after the PEST files have
been generated.

• Checks
Runs the PEST error check tools PESTCHEK
(checks the control file), INSCHECK (checks
the instructions file) and TEMPCHEK (checks
the template file). Errors and warnings - if raised
- will be shown in the dialog.

• Open work folder in explorer
Use this option to open the work folder, operate
with files or to open them for editing.

• Open work folder in console window

Figure 15.29 Settings in the Run dialog to create the
PEST files.
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Use this option to open a new command line
window, from where PEST (and other) com-
mands can run.

• Open control file
Directly opens the PEST control (pst) file in the
standard editor.

• Show command
Shows a command line string with that the PEST
run can be initiated. Use this command if you
want to run PEST outside the FePEST GUI.

NRKTKP cáäÉ=píêìÅíìêÉ

Figure 15.30 shows the basic file structure as it is
created by FePEST for the simplest case. Additional
files may be present depending on the selected meth-
ods.

• PEST script (run_pest.bat)
This script file is executed when the PEST run is
started by the user within FePEST. Besides other
commands, the PEST executable is called. The
content of this script will vary depending on the
settings done in FePEST (e.g., SVDAPREP will
be run from this script if SVD-Assist is active).
Change this script to implement additional com-
mands to the overall PEST process.

• Model script (run_model.bat)
This script is executed by PEST directly to com-
mence a model call (It is cited as the model com-
mand in the PEST control file). The actual FE-
FLOW execution is cited in here.
Add commands to this file that should be execut-
ed with every model run.
• FePEST input file (<case>.fpi)
PEST writes parameter values to the FePEST in-
put file (as advised in the respective template
file), from where they are read by FePEST. The
format is kept very simple, thus that user-specif-
ic scripts or plug-ins can access it.

• FePEST output file (<case>.fpo)
FePEST writes observation values to the
FePEST output file, from where they are read by
PEST (as advised in the respective instructions
file). Once again, a very simple format is used
thus that user-defined scripts or plug-ins can ac-
cess this file.

• PEST control file (<case>.pst)
This is the primary PEST control file which de-
fines the configuration of PEST. Edit this file to
make changes that are not supported by FePEST.

• SVDA files (super.pst and others)
If SVD-Assist is used, a second pest setup will
appear in the directory after SVDAPREP has
been executed by the PEST script.

• Supportive files
Other files may appear depending on settings.
E.g., several PLPROC files will be generated if
the pilot-point method is applied, and a covari-
ance matrix will be created by PPCOV if pilot-
points are regularized.

The FePEST help contains a detailed description of
these and other files.
cbcilt=SKO=ö=NST
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Figure 15.30 PEST file structure created by FePEST. Additional files may be present depending on the used methods
(e.g., SVDA or pilot points)
NRKTKQ oìååáåÖ= `ìëíçãáòÉÇ= mbpq
pÉíìéë

A customized setup of files can be run in two ways:
Either from within or outside of FePEST:

• Run from within FePEST
This option is more convenient and should be
preferred if applicable. Click on Run again, but
deactivate the Create Files option this time (oth-
erwise, the files would be overwritten, see
Figure 15.31).
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FePEST will commence the PEST run by run-
ning the PEST script (run_pest.bat under win-
dows), including all user modifications.
Note that because FePEST parses the primary
output of PEST during run-time, FePEST visual
feedback might fail partially or completely if the
PEST output changes significantly due to the
user modifications.

• PEST script from command line
The FePEST is part of a superordinate batch run,
the PEST script (or its contents) can be incorpo-
rated into another script.
Even though visual feedback cannot be provided
any more, FePEST (called in its simulation
mode) still ensures that parameters and observa-
tions are correctly transferred between FE-
FLOW and PEST.

Figure 15.31 Settings in the Run dialog to run PEST
without recreating the file setup.
NRKTKR fåíÉÖê~íáåÖ= fcj= mäìÖJáåë= ~åÇ
qÜáêÇJm~êíó=`çÇÉ

When creating a new observation definition or
parameter definition, FePEST offers the type "IFM
implemented" to add a specified number of additional
parameters to the PEST file setup. These can be
directly modified by an IFM plug-In or a third-party
code (e.g., a script or another program).

• IFM plug-ins
An IFM plug-in must be attached to the FE-
FLOW model and registered in FEFLOW before
the PEST run is started. If parallelization is used
that involves remote servers, the plug-in must be
installed on all remote machine as well (these
will not be transferred automatically).
It opens the fpi-file during run-time of the model
to read parameters, and opens the fpo-file to save
observations.

• Scripts and third-party software
Any program used for additional postprocessing
can access the fpi (to read parameters) and fpo
file (to save observations) accordingly. To in-
clude them in the optimization, they have to be
started appropriately from one of the batch files
(either the model batch file or the pest run batch
file).
For user-defined parameters, consider creating a
new parameter group with appropriate settings
for the derivative calculation.
cbcilt=SKO=ö=NSV
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For this exercise, a new FEFLOW file
fepest_fri_1.fem is created based on the original dem-
onstration-exercise file exercise_fri_13.fem. In this
stage, all boundary conditions, material properties and
problem settings have already been assigned. The file
is located in the folder femdata in the tutorial section.

While a steady-state flow problem is considered
here, the same workflow can be followed for other
FEFLOW problem classes (including transient simula-
tions) as well. The tutorial covers the four main steps
that apply to any FePEST problem:

• Definition of observation points (in FEFLOW
and/or FePEST)

• Definition of parameters zones (in FEFLOW)
• Definition of PEST problem (in FePEST)
• Post-processing of PEST results (in FePEST and

FEFLOW)

NRKUKN `çåÅÉéíì~ä=jçÇÉä

The material property Conductivity K_xx is cali-
brated in this FePEST demo exercise. Conductivity
measurements were taken in different locations at the
surface level (Slice 1 in FEFLOW). Initially, the spatial
distribution of conductivity in FEFLOW for this slice
was computed by means of a Linear Akima regional-
ization method. Using existing information of conduc-
tivity measurements, structure parameters of
semivariogram (or variogram) were identified. Meth-
ods for variogram fitting are outside of the scopes of
this chapter. Therefore, additional bibliography is rec-
ommended.

Two sets of field measurements (Hydraulic Head)
are used for the parameter estimation problem.
Pilot points together with a regularization approach
are applied to estimate the final conductivity distribu-
tion in Slice 1. Simple Prior knowledge is used to
incorporate existing information of conductivity in the
regularization techniques.

NRKUKO cáÉäÇ=jÉ~ëìêÉãÉåíë= ~åÇ= oÉÑJ
ÉêÉåÅÉ=a~í~

Seven Observations Points are already defined in
fepest_fri_1.fem. Together with four additional obser-
vation points to be included later in FePEST, they will
be used for the calibration of K_xx. Details of observa-
tion-points manipulation wild be discussed in this
chapter.

Distribution of measured conductivity is shown in
Figure 15.32. Here, a first overview gives an idea of
the wide range of conductivity values in the model
domain. A classical approach in this situation is to
apply a log-transformation to the distribution of K_xx.
From the measurement distribution, a variogram struc-
ture can be estimated using geostatistical methods. In
our case, the distribution of log(K_xx) is well repre-
sented by a spherical variogram with nugget = 0,
sill = 0.58, and range = 4200. This information will be
implemented in the FePEST problem.



NRKU=cÉmbpq=qìíçêá~ä
Figure 15.32Field measurements of conductivity in Fried-
richshagen FEFLOW model domain.

NRKUKP cbcilt=jçÇÉä=mêÉé~ê~íáçå

If the parameter estimation considers only a specific
zone of the FEFLOW model domain (e.g., a layer,
slice, or arbitrary subdomain), some preliminary steps
are needed in FEFLOW before initiating FePEST.

In this FePEST demo exercise, conductivity is cali-
brated in slice 1 only; therefore, an element selection of
this area is created first after opening fepest_fri_1.fem
in FEFLOW 6.2:

• In the active view, go to Slice 1.

• In the Selection toolbar, indicate as selection
target Elements.
• Click on Select All.

• In the Spatial Units panel, store the element
selection and rename it as Slice_1.

This element selection Slice_1 will be available in
FePEST as a Zone for the parameter estimation.

The Observation Points already included in the
FEFLOW problem can be verified by opening the
Observation Point Properties dialog (Figure 15.33).
The same dialog is also used to assign measurement
time series to observation points.

Click on OK to leave the dialog without any
changes. In the Slice view, navigate through the differ-
ent slices. Notice that Observation Points are situated
on slices 1 and 4 of the FEFLOW model while the
actual parameter estimation in this example will be
limited to the first slice. Observation wells to be
included for the calibration problem can be still defined
later in FePEST.

Save the fem file as fepest_fri_1.fem.
cbcilt=SKO=ö=NTN
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Figure 15.33Observation Point Properties dialog.

NRKUKQ cÉmbpq=fåáíá~ä=`çåÑáÖìê~íáçå=

FePEST is the graphical user interface for PEST.
Although FePEST provides full communication
between FEFLOW 6.2 and PEST (main program and
PEST utilities), the user has the option to manually
update the PEST program files and thus to control
which PEST version is used in FePEST. During
FEFLOW 6.2 installation, PEST program files are
automatically installed as well. Their location is con-
trolled via the menu Tools > Options in FePEST
(Figure 15.34).

Figure 15.34Location of main PEST files and PEST utilities.

NRKUKR aÉÑáåáíáçå= çÑ= ~= kÉï= cÉmbpq
mêçÄäÉã

Open FePEST and create a new problem from the
menu File > New. A dialog prompts for the location of
the FEFLOW fem file that will be used for FePEST
optimization (Figure 15.35). Specify the previously
saved file

\tutorial\femdata\fepest_fri_1.fem

Click on OK to create a new FePEST problem.
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FePEST now automatically retrieves all important
information from the FEFLOW model such as problem
class (flow, mass, heat and/or age), material properties,
observation points with their corresponding time series
(if applicable), stored element selections, etc.

 

Figure 15.35Definition of new FePEST problem.

NRKUKS léíáãáò~íáçå=pÉííáåÖë

Next, the FePEST Problem Settings dialog will
prompt for the information needed to define the PEST
problem and to create the main PEST files:

• Optimization Control
• Parameters
• Observations
• Prior Knowledge
• Subspace Regularization
• Predictive Analysis
• Parallelization
Experienced PEST users will recognize the tradi-
tional code names of the PEST parameters shown in
bold letters.

While for most groundwater models, the default
values suggested by the PEST manual and indicated in
the Problem Settings dialog should be appropriate,
some modifications may be needed for highly-parame-
terized FEFLOW models.

In the Optimization Control section, the PEST
operation mode is indicated. For the case of this exer-
cise, PEST runs in Estimation operation mode. This is
the default mode in FePEST

Click on APPLY to confirm changes.
In Optimization Control > Termination Criteria

(Figure 15.36), the different criteria to terminate PEST
execution are listed. A maximum number of PEST iter-
ations (NOPTMAX) of 30 is recommended. It is wor-
thy to notice that a single PEST iteration includes
several FEFLOW model runs. The total number of
FEFLOW runs depends on the number of parameter to
be calibrated and the selected kind of PEST statistics.
The most-demanding PEST operation is the computa-
tion of the Jacobian Matrix.

Other termination criteria are the relative reduction
of the objective function (PHIREDSTP), the maxi-
mum number of consecutive iterations which failed to
lower the objective function (NPHINORED), the max-
imum relative parameter change (RELPARSTP), and
the maximum number of consecutive iterations with
minimal parameter change (NRELPAR).

The value of NOPTMAX in FePEST also defines
the type of action to undertake in the current PEST run.
In a classical PEST configuration (no FePEST inter-
face), a value of NOPTMAX equal to 0 means that
PEST runs only once to compute the measurement
cbcilt=SKO=ö=NTP
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objective function. A value of -1 computes the Jaco-
bian matrix and statistics, and a value of -2 the Jaco-
bian matrix only. In FePEST these options are
controlled via the combo box below NOPTMAX in the
Termination Criteria section.

The type of optimization statistics (covariance
matrix, correlation matrix and eigenvalues) for the final
PEST run needs to be indicated in the Optimization
Control > Optimization Statistics section.

 

Figure 15.36Problem Settings dialog: Termination Criteria.

NRKUKT m~ê~ãÉíÉê=aÉÑáåáíáçå

Parameters in a FePEST optimization problem can
be defined either as homogeneous zones, or as spatially
variable using pilot points. In both cases, material
properties (so-called Parameter definitions) are speci-
fied for Zones (or for the entire model domain). Typi-
cally, zones reflect different geological units with
respective FEFLOW material properties.

Zones correspond to stored element sections in a
FEFLOW *.fem file. After opening the file with
FePEST, all existing element selections will be listed in
the Zones section of the Parameter definition dialog.

In the Parameters section of the Problem Settings
dialog, click on New to create a new parameter
definition. The Parameter definition dialog
(Figure 15.37) shows that the FEFLOW file contains
an element selection named Slice_1.

In the Parameter definition dialog (Figure 15.37),
select Slice_1 as Zone, choose K_xx as Parameter type
and Interpolate from pilot points as the assignment
method.

The assignment method via #IFM implemented# is
for advanced users with experience in FEFLOW inter-
face programming. A FEFLOW plug-in module (previ-
ously attached and registered in FEFLOW 6.2) can be
made responsible for transferring parameter values to
FePEST. This is a powerful option to calibrate
FEFLOW parameters not available via the FePEST
graphical interface, e.g., boundary conditions.

After defining Interpolate from pilot points as the
assignment method, the Parameter definition dialog
slightly changes (Figure 15.38). 

Now the locations of pilot points need to be speci-
fied using as reference a specific geographical position
(X, Y, Z), slice number, or layer number.
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Figure 15.37 Parameter definition dialog.

FePEST provides a very convenient automatic gen-
erator of pilot points. Click on Generate to open
the Pilot point generation dialog (Figure 15.39) which
will prompt for the number of points desired. For this
exercise, enter a value of 60. Pilot points can be
distributed in one of three automatic patters: uniform,
stagger rows and stagger columns.

Choose the option uniform and close the dialog by
clicking OK.
Figure 15.38Parameter definition dialog in pilot point mode.

Notice that the actual number of pilot points will
depend on the geometry of the FEFLOW model
domain and pattern specified. Indeed, the final number
of pilot points in our case is 61. If the automatic gener-
ation was not satisfactory, pilot points can be edited
and/or deleted in the Parameter definition dialog.

PEST will calibrate parameter values at each indi-
vidual pilot point. Subsequently, PEST interpolates
(and/or extrapolates) parameter values over the entire
Zone specified as pilot-point domain. Kriging or
Radial basis functions are available as interpolation
methods. 
cbcilt=SKO=ö=NTR
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Figure 15.39Pilot point generation dialog.

For this exercise, the Kriging interpolation method
is used.

Click on  Interpolation method properties to
assign properties of the experimental variogram. In the
Kriging configuration dialog (Figure 15.40), four well-
known variogram types are available (Spherical,
Exponential, Gaussian and Power). In Geostatistics,
these are called theoretical variograms (or semivario-
grams) and they represent the spatial structure of a
measured property, in particular, how field measure-
ments are correlated depending on sampling distance.
Notice that all the variogram properties (range, sill,
nugget, etc.) have to be set up in FePEST and the
uncertainty of these parameters will be also reflected in
the parameter estimation.
 

Figure 15.40Kriging configuration dialog.

After a click on Show variogram and on
Refresh, FePEST computes the experimental var-

iogram (dots) and theoretical variogram (continuous
line) in the chart (Figure 15.40). FePEST can also com-
pute variograms for different lag tolerances. This fea-
ture gives a faster overview about the goodness-of-fit
between experimental and theoretical variograms.
Chart information can be exported by choosing the

Properties option from the context menu.
For this exercise, use the values presented in

Figure 15.40. Click on OK to confirm changes in
the Kriging configuration dialog.

Next, click on the Defaults tab in the Parameter
definition dialog. Depending on the material property,
a parameter log-transformation may improve the PEST
optimization result. Parameters such as conductivity
and transmissivity are typically log-transformed



NRKU=cÉmbpq=qìíçêá~ä
because they can change several orders of magnitude
within a given model domain.

FePEST offers four possibilities to define a PEST
parameter (none, log, fixed and tied):

• None: Parameter calibration is carried out without
any transformation of the parameter.

• Log: A log-transformation is applied to the param-
eter before PEST is executed. PEST statistics are
presented based on transformed parameters.

• Fixed: The parameter is listed within the PEST
control file, but is not modified during PEST opti-
mization. Fixed parameters do not influence the
objective function.

• Tied: The parameter is tied to a so-called “parent”
parameter and its value will depend on the current
value of the parent. Tied parameters will be
updated during the PEST run with the same ratio
as given by the initial parameter values.

In this exercise, Initial value is set as current, i.e.,
FePEST will retrieve automatically all parameter K_xx
values from the FEFLOW *.fem file.

In a first PEST run, it is always recommended to
provide wide bounds for the parameter to be estimated
so that the PEST optimization would not be influenced.
Here, modify Upper Bound to a value of 500 m/d.
In further PEST runs, parameter bounds can be
adjusted based on parameter tendency observed from
previous runs.

Click on OK to close the dialog.
Since our FEFLOW model contains information in

three dimensions, values of conductivity in K_yy and
K_zz are also available in the fem file. However, these
two material properties in FEFLOW are related to val-
ues of K_xx, i.e. K_yy = K_xx and K_zz = Kxx / 10.
Therefore, PEST and FePEST should also update the
spatial distributions of K_yy and K_zz according to the
modifications of K_xx. This is accomplished by defin-
ing K_yy and K_zz as tied parameters, with parent
parameter K_xx.

Click on New to create a new parameter defini-
tion. Indicate conductivity K_yy as parameter type. In
the Assignment method, choose Tied to other parame-
ter definition. Indicate xco (Conductivity K_xx) in the
field Tied to. In the Defaults tab, modify Upper Bound
to a value of 500 m/d. Click on OK to confirm
changes. FePEST automatically creates 61 pilot points
to compute the distribution of K_yy based on the distri-
bution of the parent-parameter pilot points.

Repeat the steps for K_zz.
Click on Apply to assign all changes made in

the Parameter section.
cbcilt=SKO=ö=NTT
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Figure 15.41PEST parameters for parameter definition (tied
parameters).

NRKUKU lÄëÉêî~íáçåë=aÉÑáåáíáçå

In the Observations section of the Problem Settings
dialog, all field measurements (Hydraulic head, Mass
concentration, Temperature, Groundwater age, etc.)
to be used in the PEST optimization problem are speci-
fied.

Create a new observation definition by clicking on
the New button. In the Observation definition dialog,
indicate Hydraulic head as Observation type. As
Source method, select Reference values in the
FEM (Figure 15.42). This option will automatically
retrieve the information for all Observation Points
(Figure 15.33) from the FEFLOW file. 

In the Defaults tab in the Observation definition
dialog, indicate a Weight of 10 for this observation
group. The weight value will reflect how much a obser-
vation group affects the measurement objective func-
tion. Different Weights can be used between
observation groups to include different uncertainty of
the measurements. As a “rule of thumb”, observation
weights can be calculated as the inverse of the mea-
surement standard deviation.

Click on OK to add this observation group to
the FePEST problem (Figure 15.42).

Since also the Observation Points located on Slice 4
were retrieved into FePEST, they need to be deacti-
vated so that they do not influence objective function.
Double-click on the observation line corresponding to
GWM2 and change Weight to 0. Click on OK
to confirm modifications. Repeat these steps for
GWM5, GWM8, GMW10, GMW11 and GMW12.

The second set of observation points is added
directly using an external file. This group has a higher
uncertainty (standard deviation of 0.35 m).

• Click on New to create a second observation
definition. Define Hydraulic head as Observation
type.

• Select External file as Source for importing
observation points.

• In the file dialog, select the FEFLOW triplet file
named new_observations.trp.

• In the Defaults tab, insert a Weight of 2.86 (1/
0.35) as shown in Figure 15.42.
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• Click on OK to complete definition of this
second observation group.

Figure 15.42Observation definition dialog.

A FEFLOW triplet file can be easily prepared in a
spreadsheet or text editor. This file type has a very sim-
ple structure and can accommodate geographical coor-
dinates and observation values, as shown in
Figure 15.43. Further details can be found in the
FEFLOW Help System.

 

Figure 15.43Structure of a FEFLOW triplet file used to
import observations.

Information for all the observations considered in
the FePEST optimization problem is given in the lower
part of the Observation section in the Problem Settings
dialog (Figure 15.44), including observation type,
name, coordinates, value, weights, etc. Any time series
associated with FEFLOW Observation Points would
also be listed here.

Observation items can be edited directly within
FePEST. Additionally, FePEST provides the possibility
to edit all or some of the observations in an external
spreadsheet. Clicking Copy will generates a copy
of the entire observation list (this also applies for the
parameter list).

 

cbcilt=SKO=ö=NTV
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Figure 15.44Final list of observations used for PEST optimi-
zation.

NRKUKV m~ê~ääÉäáò~íáçå=jçÇÉ

FePEST allows a PEST run in parallel mode.
FePEST uses BeoPEST (third-part software) as tool for
the communication between slaves and master.

In the Parallelization section of the Problem Set-
tings dialog, click on New to create a Slave defini-
tion. In the Slave definition dialog, the server to be
used is specified under Host name. In this exercise,
localhost is used for sake of simplicity. This means that
multiple FEFLOW executions will simultaneously run
on different cores of the same computer. As No. of
slaves, insert a value of 3. Make sure Active is
selected (Figure 15.45).
Click OK to close the Slave definition dialog.
Click Apply to confirm the changes in the Paral-
lelization section.

Similarly, slave definitions can be created if multi-
ple slave servers are available. Status (Active or Inac-
tive) of a slave definition can be modified any time
before the PEST problem is initiated.

 

Figure 15.45Definition of slaves for a PEST run in parallel
mode.

For reference, all the FePEST runs in this exercise
were computed using a Intel(R) Core™ i7 – 3840 QM
CPU with 2.80 GHz and 16.0 GB RAM. Depending on
hardware, FePEST running times may vary.

NRKUKNM bëíáã~íáçå=jÉíÜçÇ=~åÇ=oÉÖìJ
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PEST provides two approaches for the PEST esti-
mation mode (parameter calibration):

• No regularization methods
• Regularization methods

- Tikhonov Regularization

- Singular Value Decomposition (SVD)

- SVD-Assist

- Least Squares Regularization (LSQR)
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By default, FePEST uses Singular Value Decom-
position. This is a very powerful option for FEFLOW
models, as discussed in the theoretical part of this chap-
ter. For this exercise, scenarios are implemented with
and without regularization. The options Least Squares
and SVD-Assist are not covered in this chapter. All the
PEST runs considered are listed in Table 15.1. 

Table 15.1 Summary of FePEST projects with different 
PEST setups: no regularization, Tikhonov 

regularization and Singular Value Decomposition 
(SVD), and with/without inclusion of observation error.

NRKUKNMKNkç=oÉÖìä~êáò~íáçå=pÉíìé

For a PEST run without use of regularization tech-
niques, the default option of Singular Value Decompo-
sition needs to be deactivated. In the Problem Settings
dialog, Subspace Regularization > Singular Value
Decomposition, uncheck the option for Singular Value
Decomposition (Figure 15.46). Click Apply and

OK to confirm changes.

Case Setup

A No Regularization + Observation Error

B1 Tikhonov (Setup 1) + Observation Error

B2 Tikhonov (Setup 2) + Observation Error

C SVD + Observation Error

D Tikhonov + SVD + Observation Error

E Tikhonov + SVD
Save the FePEST project under the name
fest_fri_A.fps.

Figure 15.46Subspace regularization: Singular Value
Decomposition.

NRKUKNMKOqáâÜçåçî=oÉÖìä~êáò~íáçå=pÉíìé

In FePEST open the project named fest_fri_A.fps
from the menu File > Open. Save the file as
fest_fri_B1.fps.

Click Control to open the Problem Settings
dialog. For a PEST run with Tikhonov regularization
only, go to section Prior Knowledge > Tikhonov Regu-
larization, activate Tikhonov regularization and
include Add simple regularization prior informa-
tion equations based on initial parameter value
cbcilt=SKO=ö=NUN
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(Figure 15.47). In the Objective function settings of
Tikhonov Regularization, specify values of 17,
17.85 and 0.1 for the PEST parameters PHIMLIM,
PHIMACCEPT, and FRACPHIM, respectively.

Click on Apply and OK to confirm
changes.

Save changes under same FePEST project name
fest_fri_B1.fps.

Now the same Tikhonov regularization is applied
for case B2; however Objective function parameters
are changed for a different handling between measure-
ment objective function and regularization objective
function, as discussed previously in section 15.2.4.

 

Figure 15.47Activating Tikhonov regularization mode.

The FePEST project named fest_fri_B1.fps is
saved as fest_fri_B2.fps to create a second project file
without overwriting first one.
Click on Control to open Problem Settings
dialog, go to section Prior Knowledge > Tikhonov
Regularization > Objective function and define the
following values:

PHIMLIM 1e-10
PHIMACCEPT 1.05e-10
FRACPHIM 0.1

Click Apply and OK to confirm changes.
Save changes under FePEST project name

fest_fri_B2.fps.

NRKUKNMKPpáåÖìä~ê=s~äìÉ=aÉÅçãéçëáíáçå=
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Open the FePEST project named fest_fri_A.fps.
Save this file as fest_fri_C.fps. So far, the file con-

tains no regularization techniques. Click Control
to open the Problem Settings dialog. For a PEST run
with SVD regularization only, go to section Subspace
Regularization > Singular Value Decomposition and
activate with Singular value decomposition.
Leave the default parameter values.

Click on Apply and OK to confirm
changes.

Save the changes to fest_fri_C.fps.

NRKUKNMKQpáåÖìä~ê=s~äìÉ=aÉÅçãéçëáíáçå=
~åÇ=qáâÜçåçî=oÉÖìä~êáò~íáçå

Open the FePEST project named fest_fri_C.fps and
save as fest_fri_D.fps.

Click Control to open the Problem Settings
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dialog, go to section Prior Knowledge > Tikhonov
Regularization, activate Tikhonov regularization
and =Add simple regularization prior information
equations based on initial parameter value.

Click on Apply and OK to confirm
changes.

Save the changes to fest_fri_D.fps.

Now a final FePEST project is created with reduced
noise in the second observation group. Click

Control to open the Problem Settings dialog. In
the Observations section, modify the Value entry for
the last four observations (those belonging to group
head2): Enter 40.1, 40.8, 38.95 and 41.9 for obser-
vation points 1, 2, 3 and 4, respectively. Modify the
Weight to a value of 10. Now all observations will
equally affect the measurement objective function.
Click Apply and OK to confirm changes. 

Save the changes to a new FePEST project
fest_fri_E.fps.

NRKUKNN oìååáåÖ=mbpq

In the previous section, a number of FePEST proj-
ects were prepared for different regularization tech-
niques:

• fest_fri_A.fps
• fest_fri_B1. fps
• fest_fri_B2. fps
• fest_fri_C. fps
• fest_fri_D. fps
• fest_fri_E. fps

Next, it is described how these files can be run.
First, open the file named fest_fri_A.fps. In the

active view FePEST shows pilot points, observation
points and parameter zones (Figure 15.48), as indicated
in the Problem Settings dialog.

Navigation through different slices and layers of the
FEFLOW domain is possible via Map Contents
panel (if not visible, this is found in menu View > Map
Contents). 

Figure 15.48FEFLOW model with assigned pilot points,
observation points and for FePEST project.

Before initiating a PEST run, all configuration files
need to be created. Click on Checks to generate the
three PEST main files (Control file, Template file and
Instruction file) and batch files for FEFLOW and PEST
runs. At the same time, the PEST check tools PEST-
CHEK, TEMPCHEK, and INSCHEK are executed. A
dialog in FePEST will show any errors and/or warnings
found.

If errors are found, modifications can be made via
the Problem Settings dialog. As general recommenda-
tion, íÜÉ= Checks tools should be always run after
any modification to the FePEST project.

PEST is initiated with a click on Run. FePEST
still provides the possibility to re-create PEST files if
modification have been made in the Problem Settings
cbcilt=SKO=ö=NUP
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dialog. If a FePEST project involves the use of pilot
points, this option should be marked, as pilot-point
files PLPROC are not automatically created by

Checks tool.
In the Run dialog, activate Create the files

required by PEST and click OK to initiate the
PEST optimization.

Output panels appear after PEST initialization.
In the case of running PEST in parallel mode, addi-
tional Output panels will appear on the master dis-
play for each slave. The information presented in the

Output panels is identical to that appearing on the
console in a classic command-line PEST execution.

 In a similar manner the rest of FePEST projects can
be executed.

NRKUKNO mçëíéêçÅÉëëáåÖ=mbpq=oÉëìäíë

Immediately after the first FEFLOW model execu-
tion, FePEST provides graphical feedback of the opti-
mization problem and the status of the objective
function (Figure 15.49). In the Simulated vs.
Observed panel, the current misfit between FEFLOW
results and observation is shown.
 

Figure 15.49 Status panel in FePEST with current PEST iter-
ation information.

Open the file fest_fri_A.fps, which considers a
parameter estimation without regularization and run it.
After the PEST optimization process has finished,
results are available via the Estimation > Show results
menu. 
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Figure 15.50Estimation results and different export options.

In the Estimation results dialog, the final estimated
value of K_xx for each pilot point is shown. From here,
several options are available:

• Click Save to save results in a FEFLOW
*.fem file with final parameter estimates (auto-
matic assignment of material properties in
FEFLOW).

• Click Save and Use the new FEM to
connect a new FEFLOW *.fem file (with new
material properties) to the current FePEST proj-
ect.

• Click Apply to create a new FePEST project
based on the final parameter estimates.

Use the first option to review PEST results directly
in FEFLOW. Save the new file as fepest_fri_1a.fem
and open it in FEFLOW 6.2. Make sure that Slice 1 is
selected in the Spatial Units panel. Double-click on
K_xx under Material Properties > Fluid Flow > Con-
ductivity in the Data panel to plot this parameter in
the Slice view.

In the Map panel, right-click on ASCII Table
Files and choose Add Map(s) to folder ASCII Table
Files. Select new_observation_wells.dat to include a
file with new observation points (second group in
FePEST).

Right-click on this new entry and choose option
Convert to > Observation Points. Click OK to
accept the defaults settings.

 Double-click Observation Points in the
Spatial Units panel to plot them in the active view.
The distribution of K_xx estimated by PEST is

shown in Figure 15.51. Observation points NEW1-
NEW4 strongly influence the conductivity values.
cbcilt=SKO=ö=NUR
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Figure 15.51Distribution of conductivity K_xx estimated by
PEST without regularization techniques.

Areas of high conductivity (shown in red in
Figure 15.51) are mainly overestimated. Here, K_xx
coincides with Upper Bound defined in the Parameter
definition dialog in FePEST. The sole criterion in
PEST was to match measured observations only.

The initial distribution of conductivity K_xx has
been previously stored as a User Data > cond_original
in the Data panel. Double-click on cond_original
to plot its distribution in the Slice view. By default,
User Data are plotted using a linear color mapping.
Double-click on cond_original in the View Compo-
nents panel to open the Properties panel. Here,
change to the Logarithmic option and click Apply
to confirm. The distribution of the original (initial) con-
ductivity K_xx is shown in Figure 15.52.

Figure 15.52Distribution of initial conductivity K_xx inter-
polated by a Akima regionalization technique.

The initial distribution of conductivity K_xx looks
somewhat “bumpy” due to the Akima regionalization
applied.

To compute the “parameter error”, the initial distri-
bution cond_original is used as reference. In the

Data panel, right-click on User Data to open the
context menu and select Add Elemental Expres-
sion. Rename this elemental expression to error. Right-
click on error to open its context menu and select

Edit Parameter Expression. In the Expression
Editor, write the same expression as shown in
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Figure 15.53.

Figure 15.53Use of Expression Editor in FEFLOW 6.2 to
compute the parameter error.

 
Click OK to confirm the changes, leave the dia-

log and plot the element expression in the active view
(Figure 15.54).

The distribution of the error given in Figure 15.54.
shows that the approach without regularization tech-
niques did not find convincing parameter estimates,
and that the values computed by PEST differ signifi-
cantly from initial distribution and K_xx measure-
ments.

In similar manner, the distribution of estimated
K_xx and of the error can be analyzed for all other
FePEST projects.
Figure 15.54Distribution of error parameter for case without
regularization techniques.

Open the FePEST project named fpest_fri_D.fps,
which applies a combination of Tikhonov and Singu-
lar Value Decomposition regularizations. Repeat the
previous steps to compute the parameter error as User
Data.

The distribution of conductivity K_xx for case D
with Tikhonov and Singular Value Decomposition is
shown in Figure 15.55. Note that the estimated distri-
bution is significantly smoother due to the regulariza-
tion techniques. Still, higher noise and uncertainty is
found around the four observation wells (NEW1-
NEW4), accompanied by a significant overestimation
cbcilt=SKO=ö=NUT
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of K_xx.

Figure 15.55Distribution of conductivity K_xx estimated by
PEST with Tikhonov and Singular Value Decomposition reg-
ularization techniques for case D (with observation error). 

The option  Select by Expression in the
Selection toolbar provides a direct means to iden-

tify areas with a specific parameter deviation. Use the
Expression Editor (Figure 15.56) to display areas with
a parameter deviation higher than 30% (Figure 15.57).
Again it can be seen that the second group of observa-
tion points located at the northeast corner dominates
the parameter estimates.
Figure 15.56Selection of areas with parameter deviation
higher than 30%. Notice the absolute operator applied to ele-
mental distribution ED.2 named error.

Figure 15.57Distribution of error parameter for case D with
Tikhonov and Singular Value Decomposition regularization
techniques (with observation error). Notice area selected with
an absolute deviation higher than 30%.
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Save the changes in FEFLOW 6.2 to
fpest_fri_1d.fem. 

Open the last project case fest_fri_E.fps in FePEST
and execute as described in the previous section.
Observe the final match between simulated values and
observed values in the Simulated vs. Observed
panel (Figure 15.58). Exact numbers can be visualized
faster using the Tooltip option (activated via right-click
on the chart), and placing the mouse cursor over a data
point in the chart.

Figure 15.58Simulated versus observed values in FePEST
project fest_fri_E.fps.

The final misfit can be reviewed in the
Residuals panel (Figure 15.59), which also con-

tains information on the weighted residuals.
Figure 15.59Residuals panels shows the final misfit between
FEFLOW simulated values and measured values.

Next, the sensitivity distribution will be computed.
Using the JROW2VEC PEST utility, FePEST extracts
information from the Jacobian Matrix to compute the
sensitivity distribution. In the Estimation menu, open
the Sensitivities dialog (Figure 15.60) and check

Select / deselect all to consider all the observa-
tions. Click OK to initiate the calculation. Select

Interpolate from pilot points as Assignment
method. 

Click Export to save the results to
pilot_point_sensitivities.dat.

Open the Estimation results dialog via menu Esti-
mation > Show results. Export the results for
FEFLOW as fepest_fri_1e.fem.

Open FEFLOW and load fepest_fri_1e.fem. Dou-
ble-click on K_xx under Material Properties > Fluid
Flow > Conductivity in the Data panel to plot esti-
mated conductivity (Figure 15.60). This time the distri-
bution of conductivity K_xx appears more realistic and
estimated values are closer to those measured in the
field. 
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Figure 15.60Distribution of conductivity K_xx estimated by
PEST with Tikhonov and Singular Value Decomposition reg-
ularization techniques for case E (without observation error).

As before, create a new Elemental Expression dis-
tribution named error in User Data and compute the
parameter deviation (Figure 15.53). The distribution is
displayed in Figure 15.61.
Figure 15.61Distribution of error parameter for case E with
Tikhonov and Singular Value Decomposition regularization
techniques (without observation error).

To plot in FEFLOW the sensitivity distribution
computed in FePEST, follow these steps:

• Click Add Nodal Distribution under User

Data in the Data panel and name the new
entry “sensitivity”.

•  In the Maps panel, right-click on ASCII

Table Files and select Add Map(s) to Folder
ASCII Table Files. Choose the file
pilot_point_sensitivities.dat. Right-click on this



NRKU=cÉmbpq=qìíçêá~ä
new file and select Link to Parameter(s). In
the Parameter association dialog, create a link
between HEA-9 and User Data > sensitivity.
Leave the default settings (Regionalization
method Inverse distance, Neighbors 4 and Expo-

nent 2). Click OK to confirm the changes. 
• Activate the link with a double-click on HEA-9 ->

sensitivity. Select Slice 1 in the Spatial Units

panel and select all nodes with a click on

Select All. Reduce the Snap distance to 0

m in the Snap-Distance toolbar and click

Assign.

The sensitivity distribution for observation HEA-9,
corresponding to observation point named GWM9, is
plotted in Figure 15.62. The distribution of sensitivity
from the Jacobian Matrix reveals that K_xx values
from pilot points placed on the southern border (around
observation points GWM13, GWM6 and GWM4)
highly influence the values for observation HEA-9. 

The negative sensitivity values reflect the tendency
of a decreasing Hydraulic Head in HEA-9 with
increasing K_xx in these pilot points.
Figure 15.62Distribution of sensitivity for observation point
GWM9.

Save the changes to the FEFLOW file
fepest_fri_1e.fem.
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NSKN fåíêçÇìÅíáçå

FEFLOW covers a broad range of functionality for
porous-media flow and transport simulation, accessible
via a comprehensive user interface.

Nevertheless there are cases in which extended user
control over the internal processes in the software is
desired and useful. Typical examples include data
import from user-defined sources, coupled simulations
with other software, extended interdependencies
between parameters, specific physical processes, and
user-specific output formats. 

Many of these cases can be accommodated by the
FEFLOW plug-in concept and its open programming
interface controlled by the FEFLOW Interface Man-
ager (IFM).

While the use of available plug-ins does not require
any programming skills, the IFM also provides support
for coding of own plug-ins by advanced modelers with
some programming experience. 
NSKO mäìÖJáåë=Ñçê=rëÉêë

Plug-ins for FEFLOW typically come as a set of
three files: 

• a *.dll (Windows) or *.so (Linux) file
• a *.html file with a description
• a *.txt file with a copyright statement
For the plug-in functionality, only the first file is

important. Plug-ins are automatically registered to
FEFLOW when they are located in the modules32 (32-
bit version of FEFLOW) or modules64 (64-bit version)
folder in the FEFLOW installation directory. 

The Plug-ins panel is used to manage the plug-ins.
Additional plug-ins in other than the above described
locations can be registered, and any registered plug-in
can be added to the current model. There is no limita-
tion in the number of plug-ins in a model. Their execu-
tion order is based on the list order in the Plug-ins
panel. 

Some of the plug-ins have functionality that is
invoked by clicking the Edit button in the panel or by
choosing Activate from the context menu of the plug-
in. Plug-ins with their own user interface typically
bring up the interface when hitting the Edit button. 

Plug-ins also have the ability to store their own data
NS
mäìÖJáåë=~åÇ=fåíÉêÑ~ÅÉ=j~å~ÖÉê=fcj=====================================
Extending FEFLOW’s functionality by using and programming plug-ins
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into the *.fem file. Thus data input to the plug-in can be
saved with the model file. 

When deactivating a plug-in the panel, it is no lon-
ger executed, but its data are kept. In contrast, remov-
ing the plug-in from the current model also removes its
data from the FEFLOW model. 

NSKP qÉÅÜåçäçÖó

Plug-ins are compiled into Dynamic Link Libraries
(DLL) on Windows operating systems, and into
Dynamic Shared Objects (DSO) on Linux. With these,
it is possible to extend the capabilities of FEFLOW
without modifying its source code. The Interface Man-
ager (IFM) uses a technique based on jump-tables that
are provided in source code, which supersedes the use
of object code or libraries. The jump tables are inter-
nally implemented by FEFLOW, so that plug-ins have
no external references to FEFLOW’s code or data. The
plug-ins are thus largely shielded from changes within
FEFLOW. In particular, they are not bound to a specific
version of FEFLOW, making plug-in management
independent from FEFLOW. 

The set of API functions provided by the IFM
ensures read and write access to nearly all parameters
and settings in FEFLOW, along with functionality to
influence the course of simulation runs.

NSKQ fcj=Ñçê=mêçÖê~ããÉêë

The backbone of the programming interface are the
above-mentioned API functions together with call-
backs, the possible entry points for plug-in code. Each
of the callback functions is called at a specific point of
FEFLOW’s internal code sequence. For example, the
PreTimeStep callback function is called immediately
before a new time step of the simulation is started. 
For each callback to be implemented by the plug-in,

a separate C/C++ function stub can be automatically
generated. While C and C++ are the ’native’ languages
for coding FEFLOW plug-ins, code in other program-
ming languages can also be included via mixed-lan-
guage programming.

On Windows systems, Microsoft Visual Studio is
often used for plug-in development, either as the com-
mercial or as the free Express edition. To be able to
develop plug-ins, the IFM Development Kit has to be
installed as part of the FEFLOW installation. With this
software development kit (SDK), a wizard for Micro-
soft Visual Studio is installed. This wizard provides a
graphically supported, efficient way to generate the
frame code for a new FEFLOW plug-in project, includ-
ing all required project and solution settings. The pro-
grammer ’only’ has to fill in the user-specific code and
compile the plug-in. Even the registration of the plug-
in to FEFLOW is done automatically during the compi-
lation process.

NSKR qìíçêá~ä
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To show the capabilities of plug-ins in FEFLOW,
we attach and use the Check Mesh Properties plug-in,
which is part of the FEFLOW installation. The plug-in
calculates the occurring minimum and maximum angle
of each finite element of a 2D mesh to check the mesh
quality.

Start a new FEFLOW document and create an arbi-
trary supermesh polygon using the Add Polygons
tool. When the polygon is finished, click Generate
Mesh to generate a finite-element mesh.
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Open the Plug-ins panel via View > Panels.
In the list of available plug-ins, right click on Check
Mesh Properties and choose Attach from the con-
text menu. The plug-in will now appear in the list of
attached plug-ins.

When the Check Mesh Properties plug-in is
attached, it creates two reference distributions Mesh-
Properties:MaxAngle and MeshProperties:MinAngle
in the Data panel and two additional charts are dis-
played.

Double-click on one of these reference distributions
to visualize the angles in the active view.

Whenever the mesh is changed (e.g., when applying
Smooth Mesh in the Mesh-Geometry tool-

bar), the values in the reference distribution are
updated.

If a mesh contains a large number of elements, the
computation time for the updating process may become
unacceptably long. In this case, the plug-in can be tem-
porarily disabled by removing its checkmark in the

Plug-ins panel.

NSKRKO mêçÖê~ããáåÖ=mäìÖJáåë

The widely used Microsoft Visual Studio develop-
ment environment has been found suitable for the
development of plug-ins. The basic version, Visual Stu-
dio Express, is available free of charge (http://
www.microsoft.com/express/).

The following example is based on Microsoft
Visual Studio 2010 Standard/Professional Edition. The
approach differs slightly from other versions of Micro-
soft Visual Studio and the free Microsoft Visual Studio
2010 Express Edition.

Before starting the plug-in development, the follow-
ing items have to be installed:
• Microsoft Visual Studio Standard/Professional or
Microsoft Visual Studio Express Edition with C++
support 

• FEFLOW IFM SDK (the respective package in
the FEFLOW setup has to be selected)

NSKRKOKN pí~êíáåÖ=íÜÉ=fcj=táò~êÇ

To start with a new plug-in, open Visual Studio
2010 and choose New > Project from the File menu.

In the tree on the left side of the dialog, click on
FEFLOW 6.2 Projects. Next, click on the FEFLOW
6.2 IFM Plug-in template. Remove the Create direc-
tory for solution check mark at the bottom of the win-
dow. After entering the name (HelloWorld) and the
target location for the new plug-in, click OK to pro-
ceed.

s
~
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íá
áå

íÜ
áå

Figure 16.1 Choosing an IFM plug-in template.
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On the Welcome page, click Next.
The following Plug-in Name page asks for a plug-

in ID (which is its unique identifier), its display name
(the name to be shown in FEFLOW) and the plug-in
version number.

By default, Plug-In ID and Display Name are set
according to the project name given before. We accept
the default. The value of the Register Proc field should
not be modified.

Clicking Next leads to the Callback Selection page.
Place the mouse cursor over a callback to get detailed
information in a tooltip window. Activate the callback
OnEditDocument. 

Click on Finish to start the generation of the plug-in
frame code and of the Visual Studio files.

Figure 16.2 Plug-in Name page.
NSKRKOKP fãéäÉãÉåíáåÖ=íÜÉ=cìåÅíáçå~äáíó

With a double-click, open the primary source code
file HelloWorld.cpp from the tree in the Solution
Explorer panel.

Scroll down to 
// Callbacks
void CHelloWorld::OnEditDocument...
 

and replace the lines

Figure 16.3 Callback Selection page.
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/*

* TODO: Add your own code here...

*/

by the command
IfmInfo(pDoc,”Hello World!”);

according to Figure 16.4.

NSKRKOKQ `çãéáäáåÖ=~åÇ=aÉÄìÖÖáåÖ

Build the plug-in by pressing <F7> and then start
debugging with <F5>. Visual Studio starts FEFLOW as
a child process in debugging mode. FEFLOW automat-
ically lists the plug-in the Plug-ins panel.

Load an arbitrary FEFLOW model, attach the plug-
in as described in Chapter 16.5.1, and click Edit
plug-in properties in the Plug-ins panel. The mes-
sage “Hello World” appears in the Log panel.

Figure 16.4 Example code.
=`çãéáäáåÖ=êÉäÉ~ëÉ=~åÇ=ñSQ=îÉêëáçåë
By default, a debug dynamic link library is com-

piled, which allows debugging (e.g., using breakpoints
in the plug-in code), but has reduced performance.

To build a more efficient release version, change the
Configuration as shown in Figure 16.6. In case that
FEFLOW is still open, make sure to close it in order to
return to Visual Studio.

In the same way the platform can be changed to
x64, providing the means to build plug-ins suitable for
the 64-bit version of FEFLOW (Figure 16.7). 

Figure 16.5 Log window message “Hello World!”.

Figure 16.6 Changing the configuration.

Figure 16.7 Changing the platform.
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